Contents

1. Copyright Notice ........................................................................................................................................... 6
   1.1 Third party license information .................................................................................................................. 7

2. About Dynamic Content Advanced .............................................................................................................. 18

3. Dynamic Content ............................................................................................................................................ 19
   3.1 Welcome to the Dynamic Content User Guide .......................................................................................... 19
      3.1.1 Copyright Notice .................................................................................................................................. 19
   3.2 Getting Started .......................................................................................................................................... 31
   3.3 Dynamic Content Basics .......................................................................................................................... 34
      3.3.1 Introducing Dynamic Content ........................................................................................................ 34
      3.3.2 Step 1: Create an Adobe Illustrator Template ..................................................................................... 37
      3.3.3 Step 2: Link the XML file to the Illustrator document ......................................................................... 38
      3.3.4 Step 3: Work with Changes in XML Content .................................................................................... 43
      3.3.5 Creating Design Variants (Line Extensions) ........................................................................................ 44
      3.3.6 Relink text elements to different languages .................................................................................... 46
   3.4 Viewing XML Content in Dynamic Content ............................................................................................ 48
      3.4.1 The Dynamic Content Palette ........................................................................................................ 48
      3.4.2 Viewing XML Information ................................................................................................................ 61
      3.4.3 Filter Options for the XML Tree ........................................................................................................ 63
      3.4.4 Manipulating the XML Tree ............................................................................................................. 67
   3.5 Managing Changes to the XML Content .................................................................................................... 69
      3.5.1 How Dynamic Content Deals with Changes ..................................................................................... 69
      3.5.2 Approving Changes in the External XML File .................................................................................... 70
      3.5.3 Applying Text Edits in Illustrator to the XML File ............................................................................ 71
      3.5.4 Creating New XML Files in Illustrator ............................................................................................... 71
   3.6 Editing Dynamic Objects ............................................................................................................................ 73
      3.6.1 What is a Dynamic Object? ................................................................................................................. 74
      3.6.2 Which Standard Illustrator Edits Are Allowed? ................................................................................ 74
      3.6.3 Inserting Additional XML Elements in a Dynamic Object .................................................................. 75
      3.6.4 Formatting Multiple Elements in a Single Dynamic Object .................................................................. 76
      3.6.5 Fit Text Frame to Contents / Fit Contents to Text Frame ..................................................................... 77
      3.6.6 Editing the Text of an XML Element .................................................................................................. 79
      3.6.7 Making minor layout edits .................................................................................................................. 81
      3.6.8 Releasing a Dynamic Object to regular text ..................................................................................... 82
      3.6.9 Exchanging Dynamic Content Documents ....................................................................................... 82
   3.7 Styling your Dynamic Objects .................................................................................................................. 83
      3.7.1 Two Approaches to Text Styling ........................................................................................................ 83
      3.7.2 Solving Text Overflow Problems ..................................................................................................... 96
   3.8 Dynamic Content Preferences .................................................................................................................. 96
### 4. Dynamic Art

4.1 Copyright Notice

4.1.1 Third party license information

4.2 About the Dynamic Art plug-in

4.3 Why Use Dynamic Art?

4.4 The Dynamic Art Palette

4.5 Dynamic Art on the Canvas

4.6 Working with Dynamic Art

4.6.1 Create a Dynamic Art Object

4.6.2 Viewing and Navigating to Dynamic Art

4.6.3 Fill Type Objects with Dummy Text

4.6.4 Edit and Delete Dynamic Art Objects

4.6.5 Define Advanced Properties for Type Art

4.7 Export XML Template

4.8 Dynamic Art Preferences

### 5. Dynamic Barcodes

5.1 Copyright Notice

5.1.1 Third party license information

5.2 What is a barcode

5.3 Getting Started with Dynamic Barcodes

5.4 Using Dynamic Barcodes in Unlicensed Mode

5.5 Dynamic Barcodes Basics

5.5.1 Creating a Barcode

5.5.2 Editing a Barcode

5.5.3 Setting Barcode Parameters to Default

5.5.4 Barcode Placeholders

5.6 Dynamic Barcodes Advanced

5.6.1 Choosing a Font Standard
6. Dynamic Marks ................................................................. 217
   6.1 Copyright Notice ......................................................... 217
      6.1.1 Third party license information .............................. 218
   6.2 Getting started ......................................................... 229
      6.2.1 Creating a first Mark Set ...................................... 229
   6.3 The Dynamic Marks palette ....................................... 230
      6.3.1 Adding a Standard Mark ...................................... 231
      6.3.2 Adding objects as Mark ........................................ 231
      6.3.3 Updating Dynamic Marks ...................................... 232
   6.4 Dynamic Mark Properties ........................................... 232
      6.4.1 Position ............................................................... 233
      6.4.2 Color ................................................................ 235
      6.4.3 Specific Mark Properties ...................................... 237
      6.4.4 Changing the Symbol of a Standard Mark ............... 258
   6.5 Mark Sets ................................................................. 258
      6.5.1 Load Mark Set ....................................................... 258
      6.5.2 Save Mark Set ....................................................... 259
      6.5.3 Delete Mark Set ..................................................... 260
      6.5.4 Manage Mark Sets ................................................ 260
      6.5.5 Export Mark Sets .................................................. 261
      6.5.6 Dynamic Marks Preferences ................................. 262
      6.5.7 Esko Mark Sets ..................................................... 262
   6.6 Dynamic Marks Layer ................................................ 264
   6.7 Dynamic Panels in Dynamic Marks .............................. 265
   6.8 Tips and tricks .......................................................... 266

7. Dynamic Tables .............................................................. 267
   7.1 Copyright Notice ........................................................ 267
      7.1.1 Third party license information .............................. 268
   7.2 Introduction to Dynamic Tables ................................... 279
   7.3 Adding a table to a document ..................................... 279
Contents

7.3.1 Table Types........................................................................................................................... 281
7.4 Adding and removing table content............................................................................................ 282
7.5 Changing existing table content................................................................................................... 283
7.6 Saving a table................................................................................................................................ 283
7.7 Table Recognition and Extraction............................................................................................... 284
7.8 Advanced topics............................................................................................................................ 286
  7.8.1 Adding a custom table definition............................................................................................... 286
  7.8.2 Table layout reference............................................................................................................... 287

8. CHILI Plug-in........................................................................................................................................... 295
  8.1 Introduction.................................................................................................................................... 295
    8.1.1 About CHILI Publisher and CHILI plugin............................................................................ 295
    8.1.2 The general concept.............................................................................................................. 295
    8.1.3 The CHILI Package............................................................................................................... 296
  8.2 Bar codes....................................................................................................................................... 296
    8.2.1 Export bar codes as images linked with CHILI variables....................................................... 297
    8.2.2 Export bar codes dynamically.................................................................................................. 297
  8.3 Export to CHILI............................................................................................................................... 299
    8.3.1 Preparing the Artwork template for CHILI export................................................................. 299
    8.3.2 Preflight and Export to CHILI............................................................................................... 300
    8.3.3 Export to CHILI using WebCenter Connector....................................................................... 301
    8.3.4 Export to CHILI Package....................................................................................................... 301
    8.3.5 Export to CHILI options.......................................................................................................... 302
    8.3.6 Layer Options.......................................................................................................................... 303
    8.3.7 Variables Review...................................................................................................................... 304
  8.4 Link a CHILI document.................................................................................................................. 305
    8.4.1 Link the CHILI document from WebCenter Connector......................................................... 305
    8.4.2 Link the XML from a CHILI package....................................................................................... 306
  8.5 Known Limitations.......................................................................................................................... 306
  8.6 Preferences..................................................................................................................................... 308
    8.6.1 General Preferences............................................................................................................... 308
    8.6.2 File Export Preferences.......................................................................................................... 309
    8.6.3 Advanced Preferences............................................................................................................. 311
    8.6.4 Webcenter Connection Preferences......................................................................................... 312
1. Copyright Notice

© Copyright 2018 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2015. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.
JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.
Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark
Office.


Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:
Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com

### 1.1 Third party license information

This product includes Botan.

```
Copyright (C) 1999-2009 Jack Lloyd
  2001 Peter J Jones
  2004-2007 Justin Karneges
  2005 Matthew Gregan
  2005-2006 Matt Johnston
  2006 Luca Piccarreta
  2007 Yves Jerschow
  2007-2008 FlexSecure GmbH
  2007-2008 Technische Universitat Darmstadt
  2007-2008 Falko Strenzke
  2007-2008 Martin Doering
  2007 Manuel Hartl
  2007 Christoph Ludwig
  2007 Patrick Sona
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

1. Redistributions of source code must retain the above copyright
   notice, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
   notice, this list of conditions, and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S) OR CONTRIBUTOR(S) BE
```
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes ICC Profiles.

Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm ColourKit Profiler Suite (www.colourprofiling.com)

This product includes ICC Profiles.

Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org

This product includes ICC Profiles.

Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org

This product includes ICC Profiles.

Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and SWOP(R) are all registered trademarks of IDEAlliance(C).

This product includes curl.

Copyright (c) 1996 - 2015, Daniel Stenberg, <daniel@haxx.se>. All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
OF THIS SOFTWARE.

-------------------------------------------------------------------------------
This product includes FCollada.

Copyright 2006 Feeling Software. All rights reserved.

Copyright 2005-2006 Feeling Software and
Copyright 2005-2006 Autodesk Media Entertainment.

Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is fur-
nished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

-------------------------------------------------------------------------------
This product includes FreeType.

Portions of this software are copyright (C) 2014 The FreeType
Project (www.freetype.org) licensed under the Freetype License.
All rights reserved.

-------------------------------------------------------------------------------
This product includes gSOAP.

EXHIBIT B.

Part of the software embedded in this product is gSOAP software.
Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen, Genivia
inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

-------------------------------------------------------------------------------
This product includes ICU.

Copyright (c) 1995-2014 International Business Machines Corporation and others
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal in the
Software without restriction, including without limitation the rights to use,
copy, modify, merge, publish, distribute, and/or sell copies of the Software, and
to permit persons to whom the Software is furnished to do so, provided that the
above copyright notice(s) and this permission notice appear in all copies of the
Software and that both the above copyright notice(s) and this permission notice
appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes ilmbase.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes iODBC.

Copyright (C) 1995-2006, OpenLink Software Inc and Ke Jin. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of OpenLink Software Inc. nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL OPENLINK OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes IP*Works!.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF MERCHANTABILITY AND FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSH.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF MERCHANTABILITY AND FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE,
ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

------------------------------------------------------------

This product includes JBIG2Lib.

Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.

------------------------------------------------------------

This product includes JPEGLib.

This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding. All Rights Reserved.

This software is based in part on the work of the Independent JPEG Group.

------------------------------------------------------------

This product includes Little CMS.

Little CMS
Copyright (c) 1998-2011 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

This product includes leptonica.
- Copyright (C) 2001-2016 Leptonica. All rights reserved.
- Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
  1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
  2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
- THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL ANY CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes libpng.
Copyright (c) 2000-2002 Glenn Randers-Pehrson

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all warranties, expressed or implied, including, without limitation, the warranties of merchantability and of fitness for any purpose. The Contributing Authors and Group 42, Inc. assume no liability for direct, indirect, incidental, special, exemplary, or consequential damages, which may result from the use of the PNG Reference Library, even if advised of the possibility of such damage. There is no warranty against interference with your enjoyment of the library or against infringement. There is no warranty that our efforts or the library will fulfill any of your particular purposes or needs. This library is provided with all faults, and the entire risk of satisfactory quality, performance, accuracy, and effort is with the user.

This product includes libxml2.
Copyright (C) 1998-2012 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

---------------------------------------------------------------------------------------------------------------------
This product includes openexr.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---------------------------------------------------------------------------------------------------------------------
This product includes OpenJPEG.

Copyright (c) 2002-2012, Communications and Remote Sensing Laboratory, Universite catholique de Louvain (UCL), Belgium
Copyright (c) 2002-2012, Professor Benoit Macq
Copyright (c) 2003-2012, Antonin Descampe
Copyright (c) 2003-2009, Francois-Olivier Devaux
Copyright (c) 2005, Herve Drolon, Freeimage Team
Copyright (c) 2002-2003, Yannick Verschueren
Copyright (c) 2001-2003, David Janssens
Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
Copyright (c) 2012, CS Systemes d'Information, France
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 'AS IS' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenSSL.

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS!" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenSSL.

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment:

   "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)"

   The word 'cryptographic' can be left out if the routines from the library
4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an acknowledgement:

"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product and use of this product is under license from Markzware under U.S. Patent No. 5,963,641.

------------------------------------------------------------
This product includes Qt.

The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).

------------------------------------------------------------
This product includes Qt.

The Qt Toolkit is Copyright (C) 2014 Digia Plc and/or its subsidiary(-ies).

------------------------------------------------------------
This product includes QtMigration.

Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Digia Plc and its Subsidiary(-ies) nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."

------------------------------------------------------------
This product includes tesseract.

Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0

------------------------------------------------------------
This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

--------------------------------- This product includes XercesC. NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this case for the Apache Xerces distribution. This product includes software developed by The Apache Software Foundation (http://www.apache.org/). Portions of this software were originally based on the following: - software copyright (c) 1999, IBM Corporation., http://www.ibm.com.---------------------------------

This product includes XMP Toolkit. Copyright (c) 1999 - 2010, Adobe Systems Incorporated All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Adobe Systems Incorporated, nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

--------------------------------- This product includes zlib. Copyright (C) 1995-2004 Jean-loup Gailly and Mark Adler This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software.---------------------------------
2. About Dynamic Content Advanced

The ‘Dynamic Content Advanced for Illustrator’ bundle offers a full set of Dynamic Content functionality.

It combines the following plug-ins:

- *Dynamic Content* on page 19
- *Dynamic Art* on page 106
- *Dynamic Barcodes* on page 127
- *Dynamic Marks* on page 217
- *Dynamic Tables* on page 267
- *CHILI Plug-in* on page 295
3. Dynamic Content

3.1 Welcome to the Dynamic Content User Guide

Welcome to the Esko Dynamic Content user documentation. This User Guide will provide you with all the knowledge and skills you need to integrate the Dynamic Content plug-in into your daily workflow.

3.1.1 Copyright Notice

© Copyright 2018 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2015. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.
This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

 Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

 JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.

 The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

 Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.

 Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.


 Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered trademarks of Global Vision Inc.

 Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights Reserved.

 All other product names are trademarks or registered trademarks of their respective owners.

 Correspondence regarding this publication should be forwarded to:

 Esko Software BVBA
 Kortrijksesteenweg 1095
 B – 9051 Gent
 info.eur@esko.com

 Third party license information

 This product includes Botan.

 Copyright (C) 1999-2009 Jack Lloyd
 2001 Peter J Jones
 2004-2007 Justin Karneges
 2005 Matthew Gregan
 2005-2006 Matt Johnston
 2006 Luca Piccarreta
 2007 Yves Jerschow
 2007-2008 FlexSecure GmbH
 2007-2008 Technische Universitat Darmstadt
 2007-2008 Falko Strenzke
 2007-2008 Martin Doering
 2007 Manuel Hartl
 2007 Christoph Ludwig
 2007 Patrick Sona

 All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S) OR CONTRIBUTOR(S) BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes ICC Profiles.

Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm ColourKit Profiler Suite (www.colourprofiling.com)

This product includes ICC Profiles.

Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org

This product includes ICC Profiles.

Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org

This product includes ICC Profiles.

Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and SWOP(R) are all registered trademarks of IDEAlliance(C).

This product includes curl.

Copyright (c) 1996 - 2015, Daniel Stenberg, <daniel@haxx.se>. All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

This product includes LibTIFF.
Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

------------------------------------------------------------
This product includes FCollada.

Copyright 2006 Feeling Software. All rights reserved.

Copyright 2005-2006 Feeling Software and
Copyright 2005-2006 Autodesk Media Entertainment.

Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

------------------------------------------------------------
This product includes FreeType.

Portions of this software are copyright (C) 2014 The FreeType Project (www.freetype.org) licensed under the Freetype License.

All rights reserved.

------------------------------------------------------------
This product includes gSOAP.

EXHIBIT B.

Part of the software embedded in this product is gSOAP software.

Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
Otherwise) arising in any way out of the use of this software, even if advised of the possibility of such damage.

This product includes ICU.

Copyright (c) 1995-2014 International Business Machines Corporation and others. All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation.

The SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes ilmbase.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes iODBC.

Copyright (C) 1995-2006, OpenLink Software Inc and Ke Jin. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. Neither the name of OpenLink Software Inc. nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL OPEMLINK OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes IP*Works!.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSH.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS
EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES

OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSL.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES

OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes JBIG2Lib.

Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.
This product includes JPEGLib. This software is in copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding. All Rights Reserved.

This software is based in part on the work of the Independent JPEG Group.

------------------------------------------------------------

This product includes Little CMS.

Little CMS
Copyright (c) 1998-2011 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

------------------------------------------------------------

This product includes leptonica.

- Copyright (C) 2001-2016 Leptonica. All rights reserved.
- Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
- 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
- 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
- THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL ANY CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes libpng.

Copyright (c) 2000-2002 Glenn Randers-Pehrson

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all warranties, expressed or implied, including, without limitation, the warranties of merchantability and of fitness for any purpose. The Contributing Authors and Group 42, Inc. assume no liability for direct, indirect, incidental, special, exemplary, or consequential damages, which may result from the use of the PNG Reference Library, even if advised of the possibility of such damage. There is no warranty against interference with your enjoyment of the library or against infringement. There is no warranty that our efforts or the library will fulfill any of your particular purposes or needs. This library is provided with all faults, and the entire risk of satisfactory quality, performance, accuracy, and effort is with
the user.

This product includes libxml2.

Copyright (C) 1998-2012 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

This product includes openexr.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenJPEG.

Copyright (c) 2002-2012, Communications and Remote Sensing Laboratory, Universite catholique de Louvain (UCL), Belgium
Copyright (c) 2002-2012, Professor Benoit Macq
Copyright (c) 2003-2012, Antonin Descampe
Copyright (c) 2003-2009, Francois-Olivier Devaux
Copyright (c) 2005, Herve Orclon, FreeImage Team
Copyright (c) 2002-2003, Yannick Verschuuren
Copyright (c) 2001-2003, David Janssens
Copyright (c) 2011-2012, Centre National d’Etudes Spatiales (CNES), France
Copyright (c) 2012, CS Systemes d'Information, France
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes OpenSSL.

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment:
   "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:
   "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes OpenSSL.
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:
1. Redistributions of source code must retain the copyright
   notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
   notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software
   must display the following acknowledgement:
   "This product includes cryptographic software written by
   Eric Young (eay@cryptsoft.com)"
   The word 'cryptographic' can be left out if the routines from the library
   being used are not cryptographic related :-).
4. If you include any Windows specific code (or a derivative thereof) from
   the apps directory (application code) you must include an acknowledgement:
   "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

This product and use of this product is under license from Markzware
under U.S. Patent No. 5,963,641.

This product includes Qt.
The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).

The Qt Toolkit is Copyright (C) 2014 Digia Plc and/or its subsidiary(-ies).

This product includes QtMigration.
Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:
* Redistributions of source code must retain the above copyright
  notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright
  notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the
distribution.
* Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
  of its contributors may be used to endorse or promote products derived
  from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE 
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes tesseract.

Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0

This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and 
its documentation for any purpose is hereby granted without fee, provided 
that (i) the above copyright notices and this permission notice appear in 
all copies of the software and related documentation, and (ii) the names of 
Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written 
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, 
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR 
ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, 
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, 
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF 
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE 
OF THIS SOFTWARE.

This product includes XercesC.

NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this 
case for the Apache Xerces distribution.

This product includes software developed by 
The Apache Software Foundation (http://www.apache.org/).

Portions of this software were originally based on the following: 

This product includes XMP Toolkit.

Copyright (c) 1999 - 2010, Adobe Systems Incorporated 
All rights reserved.

Redistribution and use in source and binary forms, with or 
without modification, are permitted provided that the following 
conditions are met:

* Redistributions of source code must retain the above copyright notice, 
  this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, 
  this list of conditions and the following disclaimer in the documentation 
  and/or other materials provided with the distribution.
* Neither the name of Adobe Systems Incorporated, nor the names of its 
  contributors may be used to endorse or promote products derived from this 
  software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
3.2 Getting Started

To introduce you to the concept of Dynamic Content, follow the five simple steps below to create dynamic links between an Adobe Illustrator document and a very basic, non-IPC simple XML file.

1. In the Sample Files folder on the installation disk image you will find an Illustrator file called: Esko Connect More.ai. Open the sample file with Adobe Illustrator and:
   a) note the two text objects that are present in the design: Link Statement1 here and Link Statement2 here.
b) choose Windows > Esko > Dynamic Content > Dynamic Content.

The Dynamic Content palette appears.

2. Generate a dynamic link with an XML file:
   a) click the Add XML file... button.
   b) browse for the GettingStarted.xml file included on the Sample Files folder on the installation disk image.

3. Link the text objects with the XML elements:
   a) select the text box containing Link with Statement1.
   b) in the Dynamic Content palette, expand GettingStarted.xml and the body entry, and select the entry Statement1.
c) Click the Make Dynamic Object button.

d) Repeat for Statement 2.

4. Change the text style using the normal Illustrator text tools:

After linking an XML element to a text object, its contents are protected from accidental changes, but you can still select text with the text tool and change its style (e.g. assign another typeface or text color).

5. Change the XML file.

To experience the dynamic behavior of the link that you established between the Illustrator text object and the XML file, go ahead and:

a) open the GettingStarted.xml file in a text editor of your choice (e.g. TextEdit on Mac OS, or Notepad on Windows).

b) change the content of the first text statement. For example, change Connect to Esko into Connect with Esko. If you have not changed your preferences from the default, the plug-in will detect your changes to the linked XML file, and it will ask you to update the artwork.
3.3 Dynamic Content Basics

In this section, you will learn the basic concepts of the Dynamic Content plug-in, and experience a simple, typical workflow that guides you through your first steps in Dynamic Content.

3.3.1 Introducing Dynamic Content

Esko's Dynamic Content for Adobe® Illustrator® brings the power of XML-based automation to Adobe® Illustrator® CS5, CS5.1, CS6 and CS7 on Mac and Windows.

Why Dynamic Content?

Esko Dynamic Content allows packaging designers to add externally maintained content elements such as legal copy or nutritional information to a packaging design. This solves an increasingly common problem in the designer’s day to day work: human error in copied content.

The ever growing number of stock keeping units that are brought onto the market by brand owners has resulted in an explosive growth in the volume of artwork that needs to be created for all the packaging of each unit. At the same time, the designs themselves become more and more complex in their competition for the consumer's attention.

Many designs share pieces of content. Some content is mandatory, required by regulatory instances such as the FDA, EMEA, or national bodies. Other content simply recurs on different variants of a shared design.

The end result is the same: an increasing number of human interactions, often of the “copy-paste” type, that at the same time increases the risk of errors slipping into the design. Errors in artwork are wasteful, generating rework, delays in product launches and sometimes even requiring product recalls.
Benefits of Using Dynamic Content

The Dynamic Content plug-in helps automate the insertion and updating of externally maintained content into a design. This prevents a number of common problems, and it saves valuable production time by eliminating repetitive manual tasks.

Some typical problems prevented by a Dynamic Content workflow:

- Typing errors;
- Wrong versions of copy text or barcodes are used in the final design;
- Cut-and-paste errors (e.g. when copy text is provided in a Microsoft Word document or PDF, and the designer has to manually copy this into the Illustrator document);
- Text overflows;
- Shared elements on design variants are not synchronised.

Because Dynamic Content allows you to keep this mandatory or shared content separated from the Illustrator document, it also eliminates repetitive and time consuming updates: simply modify the external XML file to update the text, barcodes, and nutrition tables on the design. Review cycles have never been this easy.

A Typical Workflow in Dynamic Content

A typical Dynamic Content-based design workflow includes an exchange of information between brand owners and designers. Often, the content to be used in a design will change
multiple times during the design and production process, and it is in these cases that Dynamic Content will prove its worth.

A sample workflow for the use of Dynamic Content could be the following:

<table>
<thead>
<tr>
<th>Stage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The brand owner’s marketing department draws up the text that needs to appear on the packaging design. The text is entered into a PDF form or a content management system, which can export an XML file.</td>
</tr>
<tr>
<td>2</td>
<td>The brand owner sends the PDF form or XML file containing the text to the designer.</td>
</tr>
<tr>
<td>3</td>
<td>The designer produces a packaging design in Adobe Illustrator and links the text elements from the XML file to text objects in the Illustrator template. In the GS1 workflow, the designer can generate the &quot;Response&quot; XML and send it back to the brand owner. This Response message tells the brand owner what items were used in the artwork and how many times.</td>
</tr>
<tr>
<td>4</td>
<td>Later, the brand owner makes changes to the text, produces a new XML file and sends this to the designer.</td>
</tr>
<tr>
<td>5</td>
<td>The designer replaces the original XML file on his disk with the new version. Dynamic Content automatically detects the changes, and immediately alerts the designer. It clearly shows exactly what has changed, and where.</td>
</tr>
<tr>
<td>6</td>
<td>Based on the alerts displayed in Dynamic Content, the designer can very quickly accept automatically updated text, or make any required formatting changes. There is no need for copying, pasting, or any other manual and error-prone operations, and Dynamic Content alerts the designer to problems such as text overflow.</td>
</tr>
<tr>
<td>7</td>
<td>Thanks to Dynamic Content, stages 4 - 6 can occur repeatedly without losing time or introducing errors.</td>
</tr>
</tbody>
</table>

**XML Basics**

XML stands for Extensible Markup Language, and it is a markup language similar to HTML. However, where HTML describes the layout of a web page, XML markup describes the contents and the structure of a document.

Below is an example of a basic XML document:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<body>
<p>This is a very cool product!</p>
</body>
```

XML documents are often used to exchange data or textual content.

In the context of the Dynamic Content plug-in, XML is a useful format because:

- it separates content- the text itself- from layout and presentation, which will be defined by Illustrator text objects.
- it describes and contains the structure of the text that must be used on a design.
For more information on the XML format, please refer to the Appendix “An Introduction to XML”.

### 3.3.2 Step 1: Create an Adobe Illustrator Template

Before you can start linking XML-sourced content into your work, you need to prepare a design in Adobe Illustrator.

We will refer to the Illustrator design as the "template", which will later hold the placeholder text objects in which you will later insert text from an XML file.

Dynamic Content allows you to use your complete Illustrator toolset as usual:

1. Create a design in Adobe Illustrator.
2. Create Text objects using the Illustrator tools, including:
   - the Type Tool
   - the Area Type Tool
   - the Type on a Path Tool
   - the Vertical Type Tool
   - the Vertical Area Type Tool
   - the Vertical Type on a Path Tool
   - Threaded text

   **Note:**
   Dynamic Content also supports Right-To-Left text in Middle-Eastern languages.

3. Create nutrition tables using the Esko Dynamic Tables plug-in, if required for the design.
4. Create barcodes using the Esko Dynamic Barcodes plug-in, if required for the design.
5. Add the text objects, tables, barcodes, Illustrator symbols, and external images to the Dynamic Art palette. If you do, it will be much easier for the person linking the XML content to find linkable objects. Proceed as follows:
   a) Choose **Window > Esko > Dynamic Art** to display the Dynamic Art palette.
   b) Select all the Dynamic Art objects you created in the previous steps, and click **New Dynamic Art** on the Dynamic Art palette.
Dynamic Content Advanced

Dynamic Art automatically fills any empty text objects with Lorem ipsum text.

**Note:**

Dynamic Content will apply the last style in the Illustrator text object to any text that is linked from the XML file. For objects that contain different styles or formats, only the last style will be retained.

If this is a multilingual product and you will be using variable locale mapping (initially configured in the Properties dialog for a text object on the Dynamic Art palette; see the Dynamic Art User Guide for more information), set the locale variables before adding the XML content file.

Map Locale Variables (only for IPC XML standard)

If you are using locale variables to define the language of the text objects’ content, define the variables before adding the XML content file.

1. On the Dynamic Content palette’s fly-out menu, choose **Variable Locale Mapping**.
2. In the Locale Variable Mapping dialog box, click in the Language column next to the first variable you defined and choose the desired language from the list. Do the same thing in the Country column and click OK. Repeat for the other variables.

When you auto link, Dynamic Content compares the locale of an XML element to the value of the locale variable of a text object, and if they match, it fills the text object with content from the XML element.

### 3.3.3 Step 2: Link the XML file to the Illustrator document

Once your basic design or template is complete, you have to link the XML file with your source text to the Illustrator template. You can do this automatically or manually.

**Automatic** linking is possible if there is only one corresponding entry in the XML file for each type of dynamic object in the Illustrator document. You must link **manually** if there are more
entries for each type of dynamic objects in the XML file than there are placeholders in the Illustrator document.

Automatic linking

To automatically link the dynamic items in the Illustrator document to the elements defined in the XML file, do the following:

1. Choose **Window > Esko > Dynamic Content**. The Dynamic Content palette appears.
2. Choose **Add XML...** from the fly-out menu of the Dynamic Content palette. The Open XML File dialog box appears.
3. Browse to the XML file you want to link to the design.
4. Select the XML file and click **Open**. The XML file is now linked to the Illustrator document, and the XML file appears in the Dynamic Content palette.
5. If the data in the XML file and the number and type of dynamic objects match, Illustrator will ask if you want to link all the dynamic items. Click OK to start the auto link process.

6. Click **OK** again to start the auto link.

7. Illustrator will auto link as many items as it can. A status dialog may appear if some items could not be linked. Click **OK** to dismiss it.
After the auto link completes, review the status in the Dynamic Art palette. Items successfully linked will have an XML label next to them. You will have to manually link those items that did not automatically link.

**Resuming automatic linking**

If you canceled an auto link, you can resume it by doing the following:

1. Select the text items to auto link to the XML file you have already added to the Illustrator document.
2. In the Dynamic Art palette's menu, click **Auto Link**.

3. Illustrator will ask you to confirm the auto link. Click **OK** to continue.

4. Illustrator will auto link as many items as it can. A status dialog may appear if some items could not be linked. Click **OK** to dismiss it.

After the auto link completes, review the status in the Dynamic Art palette. Items successfully linked will have an XML label next to them. You will have to manually link those items that did not automatically link.

**Manual linking**

To manually link the data in the XML file to the dynamic object placeholders, do the following:

1. Choose **Window > Esko > Dynamic Content**.
   The **Dynamic Content palette** appears.
2. Choose **Add XML...** from the fly-out menu of the Dynamic Content palette.
   The **Open XML File** dialog box appears.
3. Browse to the XML file you want to link to the design.
4. Select the XML file and click Open.
   The XML file is now linked to the Illustrator document, and the XML file appears in the Dynamic Content palette.

Link XML Elements to Illustrator Objects
In this step, you link the XML elements from the source file to the individual Illustrator text objects, barcodes and nutrition tables in the design.

Before you can execute this task, you must have linked an XML file to the Illustrator design. This means that at least one XML file must show up in the Dynamic Content palette.

1. In the Dynamic Art palette, select the object you want to link to XML content: either click on the far right of the object's entry in the palette, or click Select and zoom to object.

   Depending on the type of XML file you linked to the Illustrator document, you can work either in Smart View or Advanced View. For GS1 and IPC XML files, the default is Smart View. Other XML flavors can only use the Advanced View. The steps below assume you are using the Smart View on an IPC XML file.

   Depending on the type of object you selected in the Dynamic Art palette, the Dynamic Content palette now displays only those elements from the XML file that can be linked to your selected object.

2. In the Dynamic Content palette, click on the Make Dynamic Object icon corresponding to the XML element that contains the text you want to replace in the Illustrator template.

   Alternatively, you can use the keyboard shortcut Shift+Alt+9 on Windows or Shift+Command+9 on Mac OS to attach the element to the Illustrator object.

   The object on the Illustrator canvas is now a dynamic object - its text contents are dynamically retrieved from the linked XML file. This is indicated in the Dynamic Content palette by the status icon.

   ![Dynamic Content Palette](image)

Linking XML Elements to Illustrator Objects in the Advanced View
In this step, you link the XML elements from the source file to the individual Illustrator text objects, barcodes and nutrition tables in the design.
Before you can execute this task, you must have linked an XML file to the Illustrator design. This means that at least one XML file must show up in the Dynamic Content palette.

Depending on the type of XML file you linked to the Illustrator document, you can work either in Smart View or Advanced View. For GS1 and IPC XML files, the default is Smart View. Other XML flavors can only use the Advanced View.

The steps below assume you are using the Advanced View.

1. In the Dynamic Art palette, select the object you want to link to XML content: either click on the far right of the object entry in the palette, or click Select and zoom to object.

2. In the Dynamic Content palette, select the XML element that contains the text you want to replace in the Illustrator template.

3. Select the corresponding object in your Illustrator design.

   **Note:** If you added the dummy objects to the Dynamic Art palette, the fastest way to work is to select the Dynamic Art object in the list in the Dynamic Art palette, and then click Select and zoom to object.

4. Click Make Dynamic Object in the Dynamic Content palette.
   Alternatively, you can use the keyboard shortcut Shift+Alt+9 on Windows or Shift +Command+9 on Mac OS to attach the element to the Illustrator object.

The Illustrator objects have been replaced with a Dynamic Object. Also, the status icon appears in the XML tree indicating that the element has been attached to an object in the Illustrator document.
### 3.3.4 Step 3: Work with Changes in XML Content

Once the XML file has been linked to the Illustrator document, Dynamic Content will automatically notify you of any changes that are made to the contents of the XML file in external applications.

When changes in the XML file are detected, the **XML Changed** dialog box appears, and you will be given two options. You can either:

- Update the Illustrator document now; or
- Cancel the update, in which case you will have to deal with the changed content later. The XML Not Up to Date 🚨 status icon then appears next to the XML file in the XML Tree until you resolve the version difference.

**Note:** Following the instructions below, you will make manual changes to the XML content. In a real-world production scenario, the changes will of course be induced by the brand owner, for example by sending you a new version of the XML file.

1. Open the XML file you used earlier in a text or XML editor and change the text of the XML element you attached to Illustrator text.

2. Save the XML file. Make sure that you overwrite the file that you linked to the Illustrator design.

3. Open the Illustrator design, or switch back to Illustrator if you still have it open. The **XML Changed** dialog box appears.

4. Click **Update Now**.
   
   The Dynamic Objects in the Illustrator document are updated to reflect the changes in the XML file. The linked elements in which a change was detected are marked with a Check Alert ⚠️.
5. Select the XML element in the tree that was changed and click **Zoom and Select Art** in the Dynamic Content palette. The corresponding Dynamic Object on the Illustrator artboard is now selected, the view centers on the object and Illustrator zooms into it.

6. Check whether the changes in content have caused any design problems such as text overflow or faulty text styling (highlighted by a special Check Alert), or other issues and correct them if necessary.

7. Click **Clear Check Alert** to remove the Check Alert from the selected element, indicating that you have checked this update and that the design is once more error-free.

### 3.3.5 Creating Design Variants (Line Extensions)

A typical use case for the Dynamic Content plug-in in the packaging industry is creating variants of a design, sometimes called "line extensions".

For example, based on an original packaging design, you can create variants for different language groups, or for different sizes. To create a design variant:

1. Create the base design by linking XML elements to the Illustrator objects using Dynamic Content.
2. Make a copy of the XML file you used in the original design and make any required changes in this copy.
   For example, you could change the text of the element containing the package quantity (e.g. for a box of diapers, change the CopyElement "Quantity" from 36 to 72).
3. Re-link the new XML file, which has the same structure but different contents, to the Illustrator design.
4. Save the Illustrator file as a new design variant file.
**Tip:** You can copy and paste dynamic objects between different Illustrator files as long as you make sure that the same XML file is linked to them. After copying an object, you can use the Relink XML feature to link the copied content to the variant XML file.

### XML Linking Strategies for Design Variants

There are three main linking strategies that you can use for working with design variants or line extensions: one XML file per stock keeping unit (SKU), multiple XML files for each SKU, and a single XML file for multiple SKUs.

#### Overview

<table>
<thead>
<tr>
<th>Strategy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One-to-one</td>
<td>Each design variant is linked to an external XML file that contains all the information. This is the least complex way to handle design variants, but it requires the brand owner to provide common data in each of the XML files (repetitions of the same data in different XML files).</td>
</tr>
<tr>
<td>One-to-many</td>
<td>At least two XML files are linked to every design variant: one file unique to that variant, and one file that contains all common elements. While</td>
</tr>
</tbody>
</table>
### 3.3.6 Relink text elements to different languages

If you have a multilingual XML file, you can relink linked GS1 or IPC Copy elements to different languages contained in the XML content file.

To relink linked GS1 or IPC Copy elements, do the following:

1. Select one or more elements to relink.
2. On the fly-out menu of the Dynamic Content palette, choose **Relink Selected Dynamic Objects**.
3. In the **Relink Selected Dynamic Objects** dialog, select **Target Language** and choose the new language setting from the drop-down list. Only those languages available in the XML content file appear in the list.

4. Click **OK** to relink the elements.

   The elements change to the language you specified.
3.4 Viewing XML Content in Dynamic Content

In this section you will learn how to interpret all the information displayed in the Dynamic Content palette, including how to manipulate an XML tree structure, what each of the icons and alerts means, and what the functions are of the buttons on the palette.

3.4.1 The Dynamic Content Palette

The main work area of Dynamic Content is the Dynamic Content palette. The palette contains information about the XML files that have been linked to the current Illustrator document. The Dynamic Content palette can operate in two view modes: Smart View and Advanced View. Much like any other Illustrator palette, Dynamic Content also has a fly-out menu.

Smart View

The Smart View of the Dynamic Content palette provides a simple-to-use view on the linked XML files. It hides much of the underlying XML and its complexity, and is ideal for quickly linking XML elements to placeholder objects.

Note: Smart View only works on GS1 and IPC XML files. When you add an IPC XML file to a document, Smart View is automatically enabled.

Components of the Smart View:

- A. The Find box, which works much like Spotlight on the Mac - simply type in (part of) a word to filter the list of elements “as you type”. Only the available XML files are searched and only matching elements are displayed. The Find function is case-insensitive. Click the Reset Search button to remove the filter.
Dynamic Content Advanced

- **B.** The **Element List**, which displays the XML elements that can be linked to your current selection in the Illustrator document. If you have a text object selected, only CopyElements will be listed, but if you select a barcode created with Dynamic Barcodes, only the BarCode elements in the GS1 or IPC XML will be listed.

- **C.** The **View** buttons, which allow you to switch between Smart View and Advanced View.

**Advanced View**

The **Advanced View** of the Dynamic Content palette consists of two panes, surrounded by a top and bottom row of buttons. In the Advanced View, you can make full use of the advanced features of Dynamic Content, and work with any type of XML.

**Two panes**

For ease of reference, the top pane is called the **XML Tree** and displays the structure of the XML file. The **Preview** pane at the bottom can be hidden if desired, and resized to fit more or fewer XML content.

![Advanced View](image)

**Components of the palette**

- **A.** The **Find** box, which works much like Spotlight on the Mac - simply type in (part of) a word to filter the list of elements "as you type". In Advanced View, this searches case-insensitively in every element in all available XML files. All the elements are displayed; use the **Next** and **Previous** buttons to jump between matching elements. Click the **Reset Search** button to remove the filter.

- **B.** The top toolbar, which offers quick access to the **Reflow Text**, **Synchronize**, **Add XML** and **Add Filter** commands.

- **C.** The Filter toolbar, which allows you to filter the content displayed in the XML Tree pane.

- **D.** The **XML Tree**, which displays the content found in the linked XML file(s).

- **E.** The **Preview** pane, which displays the text content of the selected element in the XML Tree.
Dynamic Content Advanced

• **F.** The bottom toolbar, which offers quick access to the Clear Check Alert, Select and Zoom to Dynamic Object, Insert Element in Dynamic Object and Make Dynamic Object commands.
• **G.** The View buttons, which allow you to switch between Smart View and Advanced View.

**Understanding the XML Tree**

The XML tree pane contains a view on the internal structure of the linked XML file(s). Every node in the file (including elements and attributes) is visualized in the XML tree as an entry that can be expanded or collapsed.

**Which nodes are displayed?**

The XML tree displays:

- the XML file(s) linked to the Illustrator design, as the root node(s) in the XML tree;
- the XML elements in each XML file, as expandable entries under the root node (XML file);
- any XML attributes for every XML element, preceded by a "bullet" symbol. Attributes can be hidden from the XML Tree to simplify the view by choosing Hide Attributes from the fly-out menu.

![XML Tree Diagram]

**Note:**
The structure displayed in the XML tree can be simplified by applying one or more filters. See Filter options for the XML tree for more information.

**Icons in the XML Tree**

The XML tree displays different types of objects: one or more linked XML files, as well as the XML elements, XML attributes, and XML text elements that these files contain. Each of these objects is represented by an entry in the tree structure, and each type of object has its own icon.

**Table: XML tree icons**

The following table lists all the icons displayed in the XML tree structure view of the Dynamic Content palette.
## Element Status Icons

The elements in the XML tree can be marked with one or more status icons, that show whether the content has been changed inside Dynamic Content, or externally in the XML file. The icons are displayed on the right side of the elements themselves, and in two columns: primary and secondary icons.

### Table: Primary status icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>XML file; not changed in Dynamic Content / changed in Dynamic Content</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Read-only XML file; not changed in Dynamic Content / changed in Dynamic Content</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>XML node element containing text inside; placed (linked) / not placed</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>XML node element directly containing text; placed (linked) / not placed</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>XML node element, which contains no text inside</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>XML attribute</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>XML text element (has no icon)</td>
</tr>
</tbody>
</table>

### Note:

When at least one XML element in the file is marked with this status icon, the icon also appears next to the XML file name in the Dynamic Content palette.
Note:
When at least one XML element in the file is marked with this status icon, the icon also appears next to the XML file name in the Dynamic Content palette.

The element has a complex status, combining two types of changes:
• The contents of this XML element have been changed in the source XML file.
• The contents of this element have been changed in the Dynamic Content plug-in. This status icon disappears when you save or close the XML file.

The element has a complex status, combining two types of changes:
• The contents of this XML element have been changed in the source XML file to such an extent that some text styling or additional formatting that was applied by the user (e.g. color, size, font, soft returns, hyphens or spaces) could not be retained.
• The contents of this element have been changed in the Dynamic Content plug-in. This status icon disappears when you save or close the XML file.

Table: Secondary status icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>The XML file was changed externally and has not yet been synchronized with the document.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>The XML element itself is not linked, but at least one of its child elements is. Click to select all objects linked to children.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>The XML element is linked to a Dynamic Object. Click to select linked object, Alt+Click to select and zoom.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>The XML element is linked to a Dynamic Object and the attached text object has text overflow. Click to select linked object, Alt+Click to select and zoom.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>The XML element is linked to a Dynamic Object and the object is selected. The background color corresponds to the selection color of the corresponding layer. Alt+Click to zoom.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>The same as above and the object has text overflow. Alt+Click to zoom.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>The XML element is linked / not linked and has at least one child which is linked and selected.</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon" /></td>
<td>The same as above and the object has text overflow.</td>
</tr>
</tbody>
</table>
**Indication of the number of occurrences**

In a GS1 XML file, elements can contain the element "expectedNumberOfOccurrences", which indicates how many times a particular unique element (identified by the Copy Element Type, Locale ID and Instance ID) should occur in the artwork.

The Advanced View gives an indication of the number of occurrences. It will show the difference between the expected number of occurrences and the actual amount, or a check if these numbers are the same. If the **Show nominal values for the number of occurrences** option is enabled in the Dynamic Content Preferences, the actual number is shown instead. See *Dynamic Content Preferences* on page 96.

Next to the number, a color code is used as well:

- If the actual number is lower than the expected number, the number is shown in red.
- If the actual number is the same as the expected number, the number is shown in green.
- If the actual number is higher than the expected number, the number is shown in orange.
The Preview Pane

At the bottom of the Dynamic Content palette is the Preview pane. The Preview pane displays the content of the element that is selected in the XML Tree, including the text of all its child elements.
Technically speaking, the Preview pane shows the concatenation of all text in the sub tree rooted at the XML element that is currently selected.

The text that is displayed can be used for standard copy and paste purposes, but this pane is not designed for editing.

Its function is mainly to help the user to link the appropriate XML elements to text objects in the Illustrator design.

**Note:**
To hide or display the Preview pane, choose **Hide/Show Preview** in the fly-out menu.
Drag the border between the XML Tree and the Preview pane up or down to resize the Preview pane.

**The Fly-out Menu**
The Dynamic Content palette has a fly-out menu which offers access to a variety of commands. The commands you will use most often are also directly accessible from the palette buttons to speed up your daily work.

**Accessing the fly-out menu**
To open the fly-out menu, click the expand icon in the upper right hand corner of the Dynamic Content palette.

**Fly-out Menu Command Reference**
This topic lists all the commands on Dynamic Content's fly-out menu, along with a brief description of their functions.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add XML</td>
<td>Adds a new XML file in the Dynamic Content palette.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>You can add multiple XML files to a single Illustrator document to combine elements from all different XML files in a single design.</td>
</tr>
<tr>
<td><strong>Add XML from WebCenter...</strong></td>
<td>If the Webcenter Connector plug-in is available, this option will open its dialog to browse for the XML content within WebCenter projects. If the CHILI Plug-in is available, it will allow to browse for CHILI Publisher related files on WebCenter. The selected file is added, and works as any other linked XML.</td>
</tr>
<tr>
<td><strong>Relink XML...</strong></td>
<td>Replaces an existing XML file link by a new one. <strong>Note:</strong> This operation cannot be undone.</td>
</tr>
<tr>
<td><strong>Relink XML from WebCenter</strong></td>
<td>If the WebCenter Connector plug-in is available, this command, similar to <strong>Relink XML</strong>, replaces the selected XML file, but browses WebCenter projects instead of local files. In addition, if the CHILI Plug-in is available, it allows to browse for CHILI Publisher-related files on WebCenter.</td>
</tr>
<tr>
<td><strong>Remove XML</strong></td>
<td>Removes the selected XML file from the Dynamic Content palette. Dynamic Objects that refer to XML elements in a file that is removed will be converted to regular Illustrator text objects. <strong>Note:</strong> This operation cannot be undone.</td>
</tr>
<tr>
<td><strong>XML Source &gt; New XML...</strong></td>
<td>Creates a new XML file according to the GS1 or IPC XML schema. The XML file's format depends on the settings in the Preferences. See <em>Dynamic Content Preferences</em> on page 96</td>
</tr>
<tr>
<td><strong>XML Source &gt; New Element...</strong></td>
<td>Appends the text of the selected Illustrator text object(s) to the current XML file as an XML element in the GS1 or IPC format, according to the settings in the Preferences.</td>
</tr>
<tr>
<td><strong>XML Source &gt; Edit Element...</strong></td>
<td>Opens a basic XML editor in which you can edit the contents of the selected XML element. The editor displays all the text inside the selected XML elements: all child elements in the tree structure are included and editable.</td>
</tr>
</tbody>
</table>
## Dynamic Content Advanced

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>XML Source &gt; Save XML As...</strong></td>
<td>Saves the current XML to a new file according to the GS1 or IPC XML schema. The XML file's format depends on the settings in the Preferences. See <a href="#">Dynamic Content Preferences</a> on page 96</td>
</tr>
<tr>
<td><strong>XML Source &gt; Revert XML</strong></td>
<td>Replaces the contents of the selected XML file in Dynamic Content by the current version on disk, i.e. this clears all changes made inside Dynamic Content.</td>
</tr>
</tbody>
</table>
| **Export Artwork Response...** | This works only with GS1 or IPC XML files. Exports the selected XML file as a report file that can be used for electronic verification of the linked state of the content by the content creator. The exported XML file has the same structure and content as the original GS1 or IPC XML file and will add, in the case of the IPC standard, a "LinkedState" attribute to each CopyElement, Barcode and NutritionFacts element that occurs in the IPC-XML file. The value of the attribute will be set as follows: "LinkedToArtwork": Indicates that the CopyElement, Barcode or NutritionFacts element is linked to a text, barcode or table object in the artwork. "NotLinkedToArtwork": Indicates that the CopyElement, Barcode or NutritionFacts element is not linked to any text, barcode or table object in the artwork. In the case of GS1 file will export the "BMS Artwork Content Response" XML file. The file is based on the GS1 BMS standard (see [http://www.gs1.org/gsmp/kc/ecom/xml/](http://www.gs1.org/gsmp/kc/ecom/xml/)). The file indicates e.g. : 
* by the `changedByRecipient` tag by the linked element can show whether the content of the element was changed inside the Dynamic Content plug-in
* the `actualNumberOfOccurrences` element informs about the number of really placed instances of the same content (the intended number is indicated by the `expectedNumberOfOccurrences` element of the source file) |
<p>| <strong>Variable Locale Mapping...</strong> | Allows editing the mapping of Locale variables, set in the artwork template previously by the Dynamic Art plug-in. Here is possible to map the Locale variables to the actual locales valid for the current document and remove existing mapping. This is only applicable for IPC XML standard. |
| <strong>Synchronize XML</strong> | Synchronizes all the external XML files with the corresponding content used in Dynamic Content. Note that the synchronization works in both directions: import modifications |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make Dynamic</td>
<td>Replaces the contents in the selected Illustrator object with the contents of the selected XML element, creating a Dynamic Object.</td>
</tr>
<tr>
<td>Release</td>
<td>Converts the selected Dynamic Object(s) into a regular Illustrator text object(s). Note that this permanently removes the link to the XML content.</td>
</tr>
<tr>
<td>Release and Convert</td>
<td>Converts the selected Dynamic Object(s) into a Dynamic Art placeholder. The original Dynamic Content link information is transformed to Dynamic Art link information. Note that this permanently removes the link to the XML content.</td>
</tr>
<tr>
<td>Relink Selected Dynamic Objects</td>
<td>Relink Selected Dynamic Objects operates on all selected dynamic objects that are already linked to XML file A and will attempt to re-link all of these objects to selected XML file B. Select both the linked objects to re-link (in the Illustrator document window) and the target XML file to re-link these objects to (in the Dynamic Content palette). For each of the selected objects, the function will attempt to find the corresponding element to re-link to in the target XML file. In case an appropriate new XML element can be found for each of the selected objects, then they will all be re-linked to the new XML file. This function may be useful when creating line-extensions or design variants based on content provided in different XML files. Objects that are linked to XML elements in the content file for the first variant (e.g. strawberry.xml) can then be re-linked to the content file for another variant (e.g. banana.xml). Relink Selected Dynamic Objects also allows you to change the language of a linked dynamic object if you are working with a multilingual GS1 or IPC XML content file. See Relink text elements to different languages on page 46 for more information.</td>
</tr>
<tr>
<td>Format Dynamic Text</td>
<td>Displays the Dynamic Object Properties dialog box, which allows you to fine-tune how multiple elements in a single Dynamic Object are formatted.</td>
</tr>
<tr>
<td>Style Mapping...</td>
<td>Opens the Style Mapping dialog box, in which you can assign named character and or paragraph styles to selected XML elements. It also allows you to specify which XML tags should</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Dynamic Text &gt; Insert at Start</td>
<td>Inserts the contents of the selected XML element at the top of the Dynamic Object in the Illustrator design.</td>
</tr>
<tr>
<td>Dynamic Text &gt; Insert at Cursor Position</td>
<td>Inserts the contents of the selected XML element at the place of the text cursor within the Dynamic Object in the Illustrator design. If the cursor is located inside the word, the content is inserted in the closest space to avoid splitting words.</td>
</tr>
<tr>
<td>Dynamic Text &gt; Insert at End</td>
<td>Appends the contents of the selected XML element at the end of the Dynamic Object in the Illustrator design.</td>
</tr>
<tr>
<td>Split Text</td>
<td>Splits the contents of a XML element into multiple text objects. Click inside the initial linked text object at the desired split position and then click Split Text. The result will be two text objects linked to the same XML element but each will contain only part of the element. If the XML changes, Dynamic Content will try to maintain the split at its original position, but if the content is significantly different, you may need to merge the text elements and split them again.</td>
</tr>
<tr>
<td>Merge Text</td>
<td>Merges previously-split dynamic text items back together. Click inside one of them and click Merge Text on the Dynamic Content palette's fly-out menu.</td>
</tr>
<tr>
<td>Locate &gt; Locate Element</td>
<td>Locates the XML element associated with the selected Dynamic Object in the Dynamic Content palette. If the XML tree structure was collapsed, it is now expanded in order to reveal the associated XML element.</td>
</tr>
<tr>
<td>Locate &gt; Select Object</td>
<td>Selects the Dynamic Object(s) on the Illustrator artboard that are attached to the selected XML element.</td>
</tr>
<tr>
<td>Locate &gt; Find in XML...</td>
<td>Displays the Find dialog box, in which you can search the text content of the linked XML file.</td>
</tr>
<tr>
<td>Clear &quot;Check&quot; Alert</td>
<td>Removes the Check Alert from the current element. When the contents of the external XML file change, the changes are indicated in Dynamic Content by Check Alerts.</td>
</tr>
<tr>
<td>Clear All &quot;Check&quot; Alerts</td>
<td>Removes the Check Alerts for all XML elements in the XML file.</td>
</tr>
<tr>
<td>Display Options &gt; Highlight Dynamic Objects</td>
<td>Highlights all Dynamic Objects in the Illustrator document.</td>
</tr>
<tr>
<td>Display Options &gt; Hide/Show Attributes</td>
<td>Displays or hides the XML attributes of the elements in the Dynamic Content palette.</td>
</tr>
<tr>
<td>Display Options &gt; Hide/Show Preview</td>
<td>Displays or hides the Preview pane in the Dynamic Content palette.</td>
</tr>
</tbody>
</table>
The Toolbars: Button Reference

The buttons on the Dynamic Content toolbars (in Advanced View) allow you to quickly execute the most common operations in a Dynamic Content workflow. This section details each of the buttons on the two toolbars and their functions.

Top toolbar

Table: Buttons on the top toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add XML File" /></td>
<td><strong>Add XML File.</strong> Adds a new XML file in the Dynamic Content palette.</td>
</tr>
</tbody>
</table>
| ![Reflow Text](image) | **Reflow Text** Enables the Reflow Text mode, which allows you to transform (scale, rotate, etc.) the Dynamic Object without deforming the text.  

**Caution:**  
Take care when using this mode. It should be turned off as soon as you finish transforming the Dynamic Object with Illustrator's tools. While this mode is enabled, a number of essential Dynamic Content features will not work on this object. |
| ![Synchronize](image) | **Synchronize** Synchronizes all the external XML files with the corresponding content used in Dynamic Content. Note that the synchronization works in both directions: import modifications to external XML files and export changes done using "Edit Element" in Dynamic Content back to the external XML files. In case there would be conflicts, the user will be prompted to choose the behavior. |
| ![Find](image) | **Find** In Advanced View, enables you to find a piece of text in the XML file. For example, typing “chocolate” will list all copylelements that have “chocolate” in the XML text in all available XML files. In Smart View, it searches only the content currently available in the Smart View window of the palette. |
| ![Add Filter](image) | **Add Filter** Adds a new view filter to the Dynamic Content palette. |
| ![Remove Filter](image) | **Remove Filter** Removes the corresponding filter from the Dynamic Content palette. |
**Dynamic Content Advanced**

### Bottom toolbar

**Table: Buttons on the bottom toolbar**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Clear Check Alert](image) | **Clear Check Alert.** Depending on the current selection, this button:  
  - Removes the Check Alert from the current element. When the contents of the external XML file change, the changes are indicated in Dynamic Content by Check Alerts.  
  - Removes the Check Alerts for all XML elements in the XML file. |
| ![Select and Zoom to Dynamic Object](image) | **Select and Zoom to Dynamic Object.** This button:  
  - Selects the Dynamic Object(s) on the Illustrator artboard that are attached to the selected XML element.  
  - Zooms to the selected Dynamic Objects on the artboard. |
| ![Insert Element in Dynamic Object](image) | **Insert Element in Dynamic Object.** Inserts the contents of the selected element in the XML tree into the selected Dynamic Object on the artboard. The content of the current element is appended at the end of the Dynamic Object.  
  **Tip:**  
  To insert an element at the top of a Dynamic Object, use the **Insert at Start** command in the fly-out menu or **Alt+Click** this button. |
| ![Replace Contents](image) | Replaces the contents in the selected Illustrator object with the contents of the selected XML element, creating a Dynamic Object.  
  **Note:**  
  If an Illustrator text object contains multiple styles (fonts, text sizes, ...) Dynamic Content will only retain the formatting of the last style found in the text object. |

### 3.4.2 Viewing XML Information

You can use the **XML Info...** fly-out menu command to view essential characteristics of the selected XML file in the XML tree.

- The XML Information dialog box displays the file **Size, Location** on disk, **Created** and **Modified** date, and similar basic information about the XML file.
- In addition, it also lists the current **Content Status**, which informs you about the relationship between the text in the XML file and the linked text in your Illustrator design.
- The XML info shows whether the XML file is taken as a file conforming to any of the supported standards (GS1 or IPC). This can be important for other productivity enhancers of the Dynamic Content plug-in, e.g. for Automatic Linking.
- You also can set the highlight color by clicking **Select Color**.
• You can use the XML Information dialog box to make the XML file read-only on disk.

• Finally, you can use the Select Color button to change the color used to highlight elements from this particular XML file (both in the XML Tree and on the Illustrator canvas).

2. Do one of the following:
   • choose XML Info... from the fly-out menu of the Dynamic Content palette.
   • double-click the XML file node in the XML tree.

The XML Information dialog box appears.
3.4.3 Filter Options for the XML Tree

The Add Filter button on the Dynamic Content palette allows you to filter the list of elements that are displayed in the XML tree. You can choose to use a standard, built-in filter, or create your own filter based on an element name, an attribute name, or an attribute value.

Example: combining multiple filters

The following example of a filter shows only those elements that have been updated in the source XML file. In addition, it does this in a simplified view based on the IPC schema.
Tip:
This filter can function as a "to-do" list of elements that need to be checked as a result of an update of one or more external XML files.

Applying a Filter to the XML Tree

You can create a filter to display only those elements in the linked XML files(s) that are of interest to you. Dynamic Content's filter option also allows you to simplify what is displayed in the XML tree based on a combination of multiple filters.

Multiple filters work in a cumulative manner, using an “AND” logic.

Note:
When combining filters, keep in mind the cumulative effect. For example, applying a filter based on the Element Name “CopyContent” and then adding another Element Name filter “CopyElement” will display an empty palette (because there can be no elements that have both the names “CopyContent” and “CopyElement” at the same time).

1. Create a character style in Adobe Illustrator and map it to text objects, then select one or more text objects.

2. On the top toolbar of the Dynamic Content palette, click 👉 Add Filter. The filter options appear on the palette, just below the top toolbar.

3. Select a filter type from the Filter Type list. For detailed descriptions of the filter types, see Filter Options in Detail.

4. Do one of the following:
   • If you selected the Element Name or Attribute Name filter type, choose an Element or Attribute Name from the Filter list.
   • If you selected the Attribute Value Contains filter type, enter one or more attribute values in the Filter box.

   The XML tree is filtered according to your criteria.

5. If necessary, proceed by adding or removing additional filters. You can:
   • click 👉 Add Filter to add another filter.
   • click 👎 Remove Filter to remove a filter.
   • switch each filter on or off by (de)selecting the check box preceding it.

Filter Options in Detail
A number of filter types can be activated and combined. This topic describes the details of each filter type.
<table>
<thead>
<tr>
<th>The filter type...</th>
<th>Applies the following filter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simplified View on XML Schema</td>
<td>Filters the XML tree based on the standard GS1 or IPC XML format. This will display only the <code>CopyElement</code> elements that contain the actual text that will be used in your design.</td>
</tr>
<tr>
<td>Element Name</td>
<td>Filters the XML tree to display only elements matching the name you select from the Filter details list.</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>Filters the XML tree to display only elements with attributes matching the attribute name you select from the Filter details list.</td>
</tr>
<tr>
<td>Attribute Value Contains</td>
<td>Filters the XML tree to display only elements that have an attribute whose value matches the text you enter in the Filter details box. Multiple keywords can be entered using the following format: &quot;keyword1&quot;,&quot;keyword2&quot;,&quot;keyword3&quot; Example: Entering &quot;en-us&quot;,&quot;en-uk&quot; will display only those elements that have at least one attribute with a value containing the strings &quot;en-us&quot; or &quot;en-uk&quot;.</td>
</tr>
<tr>
<td>Used Elements</td>
<td>Filters the XML tree to display only elements that have been linked to Illustrator text objects.</td>
</tr>
<tr>
<td>Unused Elements</td>
<td>Filters the XML tree to display only elements that have not yet been linked to Illustrator text objects.</td>
</tr>
<tr>
<td>Elements with Updated Text</td>
<td>Filters the XML tree to display only elements that have been modified in the source XML file. Tip: This filter can function as a &quot;to-do&quot; list of elements that need to be checked as a result of an update of one or more external XML files.</td>
</tr>
<tr>
<td>Elements with Text Overflow</td>
<td>Filters the XML tree to display only elements that have been modified in the source XML file to such an extent that it has caused text overflow in the Illustrator design.</td>
</tr>
<tr>
<td>Elements with Text</td>
<td>Removes any element that does not contain any text element in its sub-tree. This filter hides any elements in the XML file purely for structural reasons which do not contain any text appearing in the artwork.</td>
</tr>
<tr>
<td>The filter type...</td>
<td>Applies the following filter...</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Not Synchronized Elements</td>
<td>Filters the XML tree to display only those linked barcode / image / table elements which couldn't be regenerated due to a data error, for example an incorrect check digit in the barcode code.</td>
</tr>
<tr>
<td>GS1 Instance ID</td>
<td>Filters the XML tree to display only elements with the GS1 instanceSequence matching the value you select from the Filter detail list. The list contains only instanceIDs present in the GS1 XML files(s) actually loaded. Use in combination with 'Simplified View On GS1-XML Schema' filter only.</td>
</tr>
<tr>
<td>GS1 Locale</td>
<td>Filters the XML tree to display only elements with the GS1 localeSequence matching the value you select from the Filter detail list. The list contains only locales present in the GS1 XML files(s) actually loaded. The localeSequence numbers are translated using the Artwork Content Locale mapping present in the GS1 XML file(s). Use in combination with 'Simplified View On GS1-XML Schema' filter only.</td>
</tr>
<tr>
<td>GS1 Element Type</td>
<td>Filters the XML tree to display only elements of the type you select from the Filter detail list. The possible values are <strong>Copy Element</strong> for text content, <strong>Data Carrier</strong> used usually for barcodes, <strong>Graphic Element</strong> for images and symbols and <strong>Structured Copy Element</strong> used usually for Nutrition tables. Use in combination with 'Simplified View On GS1-XML Schema' filter only.</td>
</tr>
<tr>
<td>GS1 Approved</td>
<td>Filters the XML tree to display only elements with the GS1 Approved status matching the value you selected from the Filter detail list. The values are True and False. Use in combination with 'Simplified View On GS1-XML Schema' filter only.</td>
</tr>
<tr>
<td>GS1 For Placement Only</td>
<td>Filters the XML tree to display only elements with the GS1 forPlacementOnly status matching the value you selected from the Filter detail list. The values are True and False. Use in combination with 'Simplified View On GS1-XML Schema' filter only.</td>
</tr>
<tr>
<td>GS1 Element With Notes</td>
<td>Filters the XML tree to display only elements with any content in the 'Notes' tag. Use in combination with 'Simplified View On GS1-XML Schema' filter only.</td>
</tr>
</tbody>
</table>
### Dynamic Content Advanced

<table>
<thead>
<tr>
<th>The filter type...</th>
<th>Applies the following filter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>GS1 Element Type Code Contains</td>
<td>Filters the XML tree to display only elements with the GS1 <code>&lt;structuredCopyElementTypeCode&gt;</code> tag matching the value you enter to the filter's detail. Example: If you enter &quot;brand&quot;, the list will contain 'BRAND_NAME' and 'SUB_BRAND_NAME' elements only. Use in combination with 'Simplified View On GS1-XML Schema' filter only.</td>
</tr>
</tbody>
</table>

#### 3.4.4 Manipulating the XML Tree

Once you have linked an XML file into the Dynamic Content palette of your Illustrator document, you can use the XML tree in the palette to navigate and even edit the contents of the XML file.

Proceed as follows to view and manipulate the XML tree.

1. In the Dynamic Content palette, click the arrow preceding the topmost XML element. This is the root element in your file. The XML tree expands one level down the hierarchy, and the elements in your XML file become visible.

2. Click the **Add filter** button.

   The Filter list appears.

3. Select an option from the **Filter** list.

   For example, you can select the Simplified View on XML Schema / IPC-XML filter type to view only the text contents of an IPC XML file.

   The list of XML elements in the palette is filtered to match your criteria.
4. Click the **Find** button to open the Find dialog box.
5. Enter a search term in the **Find** dialog box and click Next.

The first XML element matching your search term is selected in the XML tree. The Find dialog box shows how many more occurrences of the search term were found in the linked XML file(s).

Also, note that the text of the selected element is now displayed in the Preview pane of the Dynamic Content palette.
You have performed some basic operations on the XML tree that will help you speed up your work in Dynamic Content: navigating the tree structure, filtering the list of elements, and searching for text in the XML files are all very common operations.

### 3.5 Managing Changes to the XML Content

One of the main reasons for using Dynamic Content is that it allows you to deal with changes in textual content of your designs more efficiently and more quickly. This section examines how you manage changes to the XML content of your designs using Dynamic Content.

The changes in your design can be of two types:
- the external XML file can change, for example if the brand owner sends you a new version of the copy content and you want to update your design accordingly; or
- you can manually edit the copy content in Illustrator, and apply those changes to the external XML file.

In short, changes can be applied in both directions: XML to Illustrator, or Illustrator to XML.

#### 3.5.1 How Dynamic Content Deals with Changes

As soon as the content of the linked XML file(s) is changed, Dynamic Content will warn you of these changes. If you did not have the Illustrator design open at the time of the changes, you will be notified the next time you open the file. This behavior is governed by the **Always Mark and Update Changed Dynamic Objects Without Asking** option in the Preferences dialog.

**Changes in the XML file**

When changes in the XML file are detected, the **XML Changed** dialog box appears, and you will be given two options. You can either:
- Update the Illustrator document now; or
- Cancel the update, in which case you will have to deal with the changed content later. The **XML Not Up to Date** status icon then appears next to the XML file in the XML Tree until you resolve the version difference.

![XML Changed dialog box](image.png)
If you do click Update Now, the text inside any Dynamic Objects is updated with the new XML content. Every element that experiences these changes is marked with a ⚠️ Check Alert in the XML tree.

Changes inside Dynamic Content

You can also make changes to the XML content inside Illustrator by using the Edit Element command on the Dynamic Content fly-out menu. Any changes you make in Illustrator using Dynamic Content are not automatically applied to the source XML document. Instead, they are marked in the XML tree with the 🆕 status icon so you have the chance to review these changes before applying them to the linked XML file using the ⏳ Synchronize command.

3.5.2 Approving Changes in the External XML File

To approve changed content, you have to review the Dynamic Objects that have undergone content changes.

1. Open the Illustrator file for which one or more of the linked XML files have been modified externally.
   
   Once the Illustrator document opens, the XML Changed dialog box appears.

2. Click Update Now to apply the changes to the Illustrator document.

   Any Dynamic Objects that are linked to XML elements that have been changed in the XML file are automatically updated to match the new XML content.

   Every XML element that has been modified is marked with a ⚠️ Check Alert in the XML tree.

   Note:
   
   Elements that have been modified to such an extent that one or more Dynamic Objects have lost formatting are marked with a different ⚠️ Check Alert. These elements will require your special attention to solve formatting issues in your final design.

3. Review each of the Check Alerts:
   
a) Select an element with a Check Alert in the XML tree;

   b) Click the 🌌 Select and Zoom to Dynamic Object button on the bottom toolbar of the Dynamic Content palette.
   
   The Dynamic Objects that have been modified are now visible and selected on the Illustrator artboard.

   c) Make any changes to the Dynamic Objects that are needed as a result of the updated text.

   d) Click the ⏳ Clear Check Alert button on the bottom toolbar of the Dynamic Content palette to remove the Check Alert from this element, then proceed to the next element until there are no more Check Alerts in the XML tree.
3.5.3 Applying Text Edits in Illustrator to the XML File

If you have edited the text of one or more XML elements using the Edit Element command on the Dynamic Content fly-out menu, you will have to decide whether or not you want to apply those changes to the external XML file.

1. Open the Illustrator file that contains text edits that have not yet been applied to the XML file.

2. Review each of the text edits by selecting the elements that are marked by a Check Alert, and then clicking the Select and Zoom to Dynamic Object button on the bottom toolbar.

3. Make any required changes to the design or to the text.

4. Click the Synchronize button on the top toolbar to apply the text edits to the XML file.

3.5.4 Creating New XML Files in Illustrator

Dynamic Content allows you to create new XML files with the GS1 or IPC XML schema directly from within Illustrator, based on the text you may already have in your designs. Typically, you will use this feature to convert existing, legacy designs into XML-driven, Dynamic Content designs.

New XML

Use the New XML... command on the Dynamic Content fly-out menu to create a new (empty) XML file.

1. Choose New XML... from the fly-out menu.

   - When using IPC standard, the New XML dialog box appears. Fill in all the fields. The metadata section of your XML file will be filled in based on the information you supplied.
Dynamic Content Advanced

When using GS1 standard, the GS1 file is created with default values in its header, without asking the user.

You can set the IPC or GS1 standard in the Preferences. See *Dynamic Content Preferences* on page 96.

2. Click OK.
   A new XML file based on the standard IPC or GS1 schema is created.

Add Illustrator Text to the XML

Use the New Element command on the Dynamic Content fly-out menu to add text content from selected Illustrator text objects to the linked IPC XML file. This also converts the selected Illustrator objects into Dynamic Objects.

The Illustrator document must be linked to an IPC-based XML file.

1. Select one or more Illustrator text objects.
2. Choose New Element from the fly-out menu.
   The New Element dialog box appears.
3. When using the IPC XML standard:

   a) Choose a CopyElement type from the Element Type and Element Subtype lists.
   b) If necessary, select the language (locale) of the element content from the Locale lists.
   c) Enter the identification code of the design (e.g. POA1) in the Artwork ID box.
d) If you want to map the text styles in the selected Illustrator text object to XML tags inside the CopyElement, enable the Map Text Styles to Tags option. Dynamic Content will attempt to preserve the formatting of the original text by inserting additional XML tags, which are automatically mapped to the text styles that were applied to the Illustrator text object.

4. When using the GS1 XML standard:

![New Element dialog box]

a) Choose an Element Type Category and an Element Type.

b) Define the Instance Sequence. This allows to identify different elements of the same Type.

c) Define the Locale Sequence. The POA header defines a number for each language. The Locale Sequence in each element refers to that mapping.

5. Click OK.

The new content is added to the internal representation of the XML file. When using the Synchronise function, the new content is written to the external XML file.

3.6 Editing Dynamic Objects

This section examines the editing features in Dynamic Content.

The following editing operations are available in Dynamic Content:

- You can edit the text of an XML element directly inside Illustrator. Also, you can transform the Illustrator text boxes that are the basis of the Dynamic Objects.
- You can insert a specified set of special characters (such as spaces, hyphens or tabs) in a Dynamic Object to improve the text layout.
- You can insert text from additional XML elements in an existing Dynamic Object, either by appending it at the end or by inserting it at the start of the existing text content.
- Fit Text Frame to Contents (Auto-grow) or Fit Contents to Text Frame (copy-fitting). See Fit Text Frame to Contents / Fit Contents to Text Frame on page 77.
• You can edit the properties of dynamic barcodes and nutrition tables using the Dynamic Tables and Dynamic Barcodes plug-ins.

3.6.1 What is a Dynamic Object?

A Dynamic Object is an Illustrator text object that has been linked to an XML element using the Dynamic Content plug-in.

Dynamic Content encapsulates the original text object in the Dynamic Object, and in the process it prevents a number of changes from being made: you can no longer use the standard Illustrator Text tools to modify the contents of a Dynamic Object.

3.6.2 Which Standard Illustrator Edits Are Allowed?

A Dynamic Object is protected from text edits using the Illustrator Text tools. However, you can still modify the text of a Dynamic Object to a certain extent.

The following edits remain possible:

• You can move, rotate or scale the Dynamic Object using the standard Illustrator transform tools.

• You can change the formatting (e.g. the font family or alignment properties) of the text by applying text styles in Illustrator. To do this, use the controls on the Type palette in Illustrator.

• You can change the color of the text.

Note:

When you scale a Dynamic Object, its text content is scaled as well. To allow the text box to “reflow” as per the standard Illustrator behavior, click the Reflow Text button on the top toolbar before making any changes.

Example: font changes to a Dynamic Object

In the following example, a Dynamic Object was selected and the font used for the text was changed using the Type palette in Illustrator. Note that changes like this may cause text overflow problems.
3.6.3 Inserting Additional XML Elements in a Dynamic Object

Once a Dynamic Object has been created, you can add additional content (from other XML elements) to this same object. New content can be added either to the end of the content (Insert at End) or, if needed, before the beginning of the existing content (Insert at Start).

**Note:**
This feature applies to a single Dynamic Object. You can therefore have a Dynamic Object that is linked to XML Element A, and another Dynamic Object in the same design that is linked to both XML Element A and Element B.

1. Select a Dynamic Object on the Illustrator artboard.
2. In the XML tree, select the XML element that you want to add to the Dynamic Object.
3. Do one of the following:
   - To **append** the text of the new XML element at the end of the Dynamic Object, click the ![Insert Element in Dynamic Object](image) button on the bottom toolbar of the Dynamic Content palette. Alternately, use **Insert at End** on the Dynamic Content fly-out toolbar.
   - To **insert** the text of the new XML element in between two XML elements linked to the single Dynamic Object, place the Type Tool cursor between the two linked elements, and use the **Insert at Cursor Position** option on the Dynamic Content fly-out toolbar.
   - To **insert** the text of the new XML element at the start of the Dynamic Object, **Alt** +Click the ![Insert Element in Dynamic Object](image) button on the bottom toolbar of the Dynamic Content palette. Alternately, use **Insert at Start** from the Dynamic Content fly-out menu.

The new XML content is added to the Dynamic Object.
**Tip:**
You can define how the different XML elements should be combined in the Dynamic Objects by using the **Format Dynamic Text** command in the fly-out menu.

### 3.6.4 Formatting Multiple Elements in a Single Dynamic Object

In the Format Dynamic Text dialog box, you can view information on the XML elements linked to the selected Dynamic Object, and you can define exactly how these XML elements should be combined in the object.

**Tip:**
You can also use the Format Dynamic Text command to insert a text prefix before the XML element content (e.g. to add "Ingredients: " before the ingredients list), even without adding multiple elements to a single Dynamic Object. You can also add a suffix in the same way.

1. Select a Dynamic Object on the Illustrator artboard.
2. Choose **Format Dynamic Text** on the Dynamic Content fly-out menu.

   The Format Dynamic Text dialog box appears.
3. Make any needed changes to the formatting of the elements in the Dynamic Object:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Insert text or special characters before</strong> one or more elements</td>
<td>Select the element(s) in the list and type the desired prefix in the <strong>Prefix</strong> field.</td>
</tr>
<tr>
<td><strong>Insert text or special characters after</strong> one or more elements</td>
<td>Select the element(s) in the list and type the desired prefix in the <strong>Suffix</strong> field.</td>
</tr>
<tr>
<td><strong>Treat all elements as part of the same block of text, without paragraphs</strong></td>
<td>Deselect the <strong>Preserve Paragraphs</strong> option.</td>
</tr>
<tr>
<td><strong>Change the order in which the elements appear in the Dynamic Object,</strong></td>
<td>Select the element(s) you want to move, and click the <strong>Move Up</strong> or <strong>Move Down</strong> buttons.</td>
</tr>
<tr>
<td><strong>Remove blank spaces in the elements,</strong></td>
<td>Enable the <strong>Remove Leading, Trailing and Duplicate Spaces</strong> option. This removes any undesirable whitespace characters from the XML before the text is displayed in the Dynamic Object. Additional whitespace characters are sometimes added by XML editors in an effort to make the XML more legible for human readers.</td>
</tr>
</tbody>
</table>

4. Click **OK**.

### 3.6.5 Fit Text Frame to Contents / Fit Contents to Text Frame

In the **Format Dynamic Text** dialog, you can view information on the XML elements linked to the selected Dynamic Object, and set automatic modification of the Dynamic Object size or the text size within the Dynamic Object.
The **Fit Text Frame to Contents** (Auto-grow) and **Fit Contents to Text Frame** (Copy-fitting) options allow setting the options for future use in Dynamic Content. They can only be set if **Assign multiple XML Attributes** is enabled. You can choose to fit the text frame to the contents, or fit the contents to the text frame. Combining the two is not possible.

### Fit Text Frame to Contents

![Fit Text Frame to Contents](image)

If you use **Fit Text Frame to Contents**, the text box will grow to fit the actual text content, coming from the XML source. The text box size will be adapted every time the XML source changes.

This option is useful when you're not sure what amount of text will come from the XML, and you want to avoid text overflow.

- The **Direction** defines in what direction the text box can grow: down, up, to the left or to the right.
Dynamic Content Advanced

- Using **Minimum Height** and **Maximum Height** (or width, depending on the direction) you can define the minimum and maximum size for the text box.

  **Note:** This option is only available for Area Text objects, so not for Text on Point or Text on Path.

  **Fit Contents to Text Frame**

  ![Check box for Fit contents to text frame]

  If you use **Fit Contents to Text Frame**, the font size will change to fit the text frame.

  This option is useful when the space for the text is limited, and font size changes are allowed by the design rules.

  - The **Minimum Text Size** and **Maximum Text Size** define the minimum and maximum font size to be used.

  **Note:** This option is only available for Area Text objects and Text on Path, so not for Text on Point.

### 3.6.6 Editing the Text of an XML Element

You can edit the text of a Dynamic Object by using the Edit Element command on the fly-out menu. This will change the contents of the linked XML file itself. Of course, Dynamic Content marks these changes so you can review them before they are applied to the external XML file.

The Edit Element dialog box displays the text of the selected XML element. The XML tags from the linked XML file are displayed as square brackets [ ]. This makes it easier to focus on editing the text without worrying about XML structure and syntax.

**Note:**

The square brackets ([ ]) in the Edit Element dialog box represent XML opening and closing tags. To type a square bracket in the text of your design, use the following codes: &left; for “[” or &right; for “]”.

1. Select the XML element for which you want to edit the text content in the XML Tree.
2. Choose **Edit Element**... in the fly-out menu of the Dynamic Content palette.

   The **Edit Element** dialog box appears.

3. Make changes to the text where needed.
4. Click OK to apply the changes to your design.

The new text is used in any Dynamic Objects linked to the XML element you edited, and the XML element itself marked with a ✂ Check Alert icon in the XML Tree.

However, the new text is not yet saved in the linked XML file. To save your edits:
• Click the Synchronize button on the top toolbar. This will save your edits into the currently linked XML file.

• Alternatively, choose Save XML As... from the fly-out menu to save the new content into a new XML file.

The Edit Element Dialog Box in Detail

The Edit Element dialog box displays all the text of the selected XML element and its children. The XML tags from the linked XML file are replaced by square brackets [ ]. This makes it easier to focus on editing the text without worrying about XML syntax.

The option Show elements as story formats the content in the editing area in a more user-friendly manner. If you disable this option, every element starts on a new line in the editing area.

Note:
The square brackets ([ ]) in the Edit Element dialog box represent XML opening and closing tags. To type a square bracket in the text of your design, use the following codes: &left; for “[” or &right; for “]”.

The square brackets “[ ]” cannot be deleted, because they represent the structure of the XML tree.
3.6.7 Making minor layout edits

The text of a Dynamic Object is protected from direct editing using the Illustrator Type tools (Type tool, Area Type Tool, ...). However, you can use the Type tools to make minor layout edits in a very strictly defined number of cases.

Text in a Dynamic Object cannot be edited using the Type tools because this would go against the basic workflow principle of Dynamic Content: to make sure that your design remains synchronized with the external content and only displays text sourced from the linked XML file(s).

If you do try to edit a Dynamic Object, you will find that you can only insert a limited number of layout characters (i.e. tab, line break, ...) and that all other edits will be blocked.

![Figure 1: The Illustrator Type tools can only be used to insert layout characters](image)

- You can insert the following special characters:

<table>
<thead>
<tr>
<th>This character...</th>
<th>Can be inserted...</th>
</tr>
</thead>
</table>
| a whitespace character | • after an existing whitespace character in the XML content;  
• after a manually added hyphen. |
| a hyphen ( - ) character | • inside an existing word in the XML content;  
• after a manually added whitespace character. |
| a tab character | • after any whitespace character (existing or manually added);  
• after a manually added hyphen character, if that is not already followed by a manually added whitespace. |
| a new paragraph (return) and a line break (shift+return) character | • after any whitespace character (existing or manually added); |
### 3.6.8 Releasing a Dynamic Object to regular text

You can easily convert a Dynamic Object back into a regular Illustrator text object. To do this, either use the **Release** or the **Release and Convert** command on the fly-out menu of the Dynamic Content palette. **Release** completely removes the XML link information from the text, while **Release and Convert** converts the text to a Dynamic Art placeholder, maintaining the link information.

Designers who do not have access to the Dynamic Content plug-in can choose to convert the Dynamic Objects (which retain their special, protected status even when opened on a workstation without Dynamic Content) back into regular text objects using the Illustrator command **Object > Expand**. This allows them to work on the design and make changes where needed, but it also breaks the Dynamic Content workflow.

**Note:**

When you release a Dynamic Object using one of the two available methods, the link to the XML element(s) is permanently broken. Releasing a Dynamic Object using **Release and Convert** only keeps the link information for future use as a Dynamic Art template.

- To release a Dynamic Object, select it on the Illustrator artboard and:
  - Choose **Release** from the Dynamic Content fly-out menu; or
  - Choose **Release and Convert** from the Dynamic Content fly-out menu; or
  - Choose **Object > Expand** from the Illustrator menubar.

### 3.6.9 Exchanging Dynamic Content Documents

If you have to send an Illustrator document that contains linked objects that were created by the Dynamic Content plug-in to someone who does not have the plug-in, you have two options.

- You can release the Dynamic Objects back to normal Illustrator objects before sending the document to the recipient. Select all the linked objects and then choose the Release command on the fly-out menu. The document no longer contains any Dynamic Objects and all links to the XML file(s) have been removed.
- You can send the Illustrator document to the recipient without removing the Dynamic Objects.
If the recipient... | Then (s)he ...
---|---
does not need to edit the text in the Dynamic Objects | can work with the Illustrator document without noticing any difference with a regular Illustrator document.
needs to edit the text of a Dynamic Object | has to use the **Expand** command on the Object menu in Illustrator.

**Note:** Take care when using the **Expand** command in Illustrator. If you apply the command to other objects in your design (e.g. blends, text, ...) it can cause unexpected changes in your design. For this reason, it is often advisable to release the Dynamic Objects before sending it to any recipients who do not have access to the Dynamic Content plug-in.

### 3.7 Styling your Dynamic Objects

There are two approaches to styling the Dynamic Objects in your design: manual styling and automated styling (Style Mapping). In this section you will learn how to apply both these methods, how to solve common problems such as text overflow, and more.

#### 3.7.1 Two Approaches to Text Styling

The two approaches for styling your Dynamic Objects each have their specific use cases. Obviously, the automated method will save you time in certain situations, but it can only be used efficiently if your source XML file contains presentation-related information. This section further explores the differences, and explains exactly how to apply both the manual and automated styling methods.

**What Is Manual Styling?**

The easiest - but not always the most efficient - approach to styling the text in your Dynamic Objects is to use the Character and Paragraph palettes in Illustrator.

In other words, applying the manual method - sometimes called the “template-based” styling approach - means that you must select every Dynamic Object in the design and apply the appropriate style formats manually.

Alternatively, of course, you can set up your design with properly styled “dummy text” boxes even before you create Dynamic Objects. In this case, the Dynamic Content plug-in will apply the last style found in the Illustrator object to the text in the new Dynamic Object.
When a Dynamic Object contains multiple styles, Dynamic Content will attempt to preserve these styles whenever the content is updated. In some cases, when there are major changes to the content of a Dynamic Content, this will prove impossible. To alert you to this possible loss of formatting, a special \(^\text{⚠️}\) Check Alert will appear in the XML Tree for the affected elements.

**Note:**
For more information, please refer to the Adobe Illustrator Help in the Type chapter.

**What Is Style Mapping?**
Style Mapping allows you to automate the formatting of your Dynamic Objects to a very high degree. You apply Style Mapping by linking XML elements to named styles in Illustrator.

**Mapping Elements to Styles**
Using the Style Mapping dialog box, you define the relationship between the XML elements in the linked XML file(s) and named Character and Paragraph Styles in your Illustrator design. Once this relationship has been defined, every Dynamic Object that incorporates a specific XML element will automatically be formatted with the corresponding Paragraph and/or Character Styles.

**Style Hierarchy**
Styles in Adobe Illustrator apply to text objects in a specific order. This is of particular importance when defining Style Mappings, as you will be setting up both Paragraph Styles (e.g. for a 'p' tag in the XML file) as well as Character Styles (e.g. for a 'bold' tag in the XML file).

Style types have a built-in hierarchy, with the last level overruling all the preceding information:

1. First, the named **Paragraph Style** is applied.
2. Any **Character Styles** applied to a specific section in a paragraph overrule the formatting of the Paragraph Style.
3. Finally, local **overrides** overrule the Character Style. An override occurs when you manually change a property (i.e. change the font size) in the Character palette without updating the Character Style itself.

**An Example of Style Mapping**
In the following example, we will use some HTML content from a web page that we saved in XML format, link it to our design in Illustrator, and then apply Style Mapping to automatically recreate the styling from the original web page.
Step One: Preparing the Files

First, we save the snippet of HTML (actually it is XHTML, a special flavor of HTML that conforms to the XML standard) as an XML file, so we can link to our design using Dynamic Content.

Then, we prepare some named styles in our Illustrator design: the Paragraph Styles ProdListPara and ProdListHeader, and the Character Style ProdName.

As you can see, the Illustrator text box already contains some dummy text that enables us to test these styles.
Step Two: Linking the XML File

In this second stage, we link the XML file to the Illustrator using the Add XML File command. Then we convert the text object into a Dynamic Object by linking it to the `<body>` element.

The result: we lose all of our carefully applied styling. A warning message informs us that not all the style information could be retained during the conversion. Not all is lost, however, as we will restore the styling using Style Mapping.
Step Three: Setting Up Style Mapping

In this third and final step, we use Style Mapping... command on the fly-out menu to define the relationships between the predefined Styles on the one hand, and the XML elements on the other.

In this example, we link the `<p>` tag (which is the basic xhtml paragraph) to the ProcListPara Paragraph Style in Illustrator. The `<strong>` tag is also defined as a paragraph, this time using the ProcListHeader style, creating a nice title for the product list.

Finally, we link the `<a>` element to the ProcStyle Character Style, adding some color to the design.

Tip:

If you just need to emphasize certain elements within the document by formatting them in bold, italic or underlined text, you can use the Character Styling options Bold, Italic or Underline.
Once we apply the Style Mapping to our design, the Dynamic Object is automatically formatted correctly. As you can see, in text-heavy designs, this can be a huge timesaver.
Applying Style Mapping

To apply Style Mapping to your document, you need to first define the named Character and Paragraph Styles that you will be using, and then set up the relationships between these styles and the XML elements using the Style Mapping command in Dynamic Content.

For more information on Character and Paragraph Styles in Illustrator, please consult the Illustrator Help in the Type section.

Creating a Basic Style Mapping Rule

In this task, you will set up a basic Style Mapping rule.

1. Choose **Style Mapping**... in the fly-out menu.

   The Style Mapping dialog box appears.

   ![Style Mapping Dialog Box](image)

2. Select the element in the Element List that you want to associate with an Illustrator named style.

   Click the **Show All** button if you want the Element List to display all elements in the linked XML files. Otherwise, only the elements currently in use will be listed.

3. Enable the **Preview** option to immediately see the results of any mappings you make on the artboard.

4. Do one of the following:

   **If you want to...** | **Then...**
   --- | ---
   map the element to a Paragraph Style | • Enable the Paragraph option; and  
   | • Select a Paragraph Style from the Paragraph Styles list.
If you want to... Then...

Note:
You can also select a Character Style for the element. In this case, the formatting of the Character Style will be added to the Paragraph Style (overruling it in case of conflicts).

map the element to a Character Style

• Disable the Paragraph option;
• Select a Character Style from the Character Styles list.

5. Repeat step 4 for each of the elements you wish to map.
6. Do you want to save the Style Mapping you just defined?
   • If you do, proceed to step 7.
   • If you do not, proceed to step 8.
7. Click the Save... button and save the Style Mapping settings on your computer or network.
   The Style Mappings are saved in a special XML format.
8. Click OK to apply the Style Mapping.

Creating a Location-Based Rule
In this task, you will set up a Style Mapping rule that only apply to elements at a specific location in the XML tree structure.

1. Choose Style Mapping... in the fly-out menu.
   The Style Mapping dialog box appears.
2. Click Add... to create a new rule or Modify... to refine an existing rule.
   The Add or Modify dialog box appears.
3. Select the element you want to format with a style from the Element Tag Name list.
4. Select the parent element of the element you want to affect from the Child Element of list.
   In the example below the Style Mapping rule will apply only to span elements that are found within a p element.
5. Select a Style from the **Paragraph Style** and/or **Character Style** lists.

6. Click **OK** to save the Style Mapping rule.

The selected style is applied to all the instances of the elements that match your selection.

**Creating an Attribute-Based Rule**

In this task, you will set up a refined Style Mapping rule that only applies to elements that have a specific attribute value.

**Tip:** Use the [Any Element] option in the Element Tag Name list to create a rule that applies to any element in the design that has a specific attribute or attribute value. For example, you could apply a red italic style to all elements that have the attribute value pair `status="to_be_reviewed"`.

1. Choose **Style Mapping...** in the fly-out menu.

   The Style Mapping dialog box appears.

2. Click **Add...** to create a new rule or **Modify...** to refine an existing rule.

   The **Add** or **Modify** dialog box appears.

3. Select the element you want to format with a style from the **Element Tag Name** list.

4. Select the parent element of the element you want to affect from the **Child Element of** list.

   In the example below the Style Mapping rule will apply only to `<span>` elements that are found within a `<p>` element.
5. Click the + (Add Attribute) button underneath the attributes list.  

**Note:** You can only click the Add Attribute button if the XML element you selected in the preceding steps has one or more attributes.

A new row is added to the attribute list.

6. Double-click in the Attribute column and select the attribute on which you want to base this rule from the list.

7. Do one of the following:
   
   • If you want the Style Mapping to affect only elements that have a specific value for the attribute you selected, choose either Is or Contains from the Is/Contains list and enter a value in the Value column.
   
   • If you want the Style Mapping to affect all elements on which the attribute you selected is found, regardless of the attribute value, proceed with the next step.

In the example below, only `<span>` elements that have a `class` attribute with the value "style1" will be affected by the Style Mapping rule.
8. Select a Style from the **Paragraph Style** and/or **Character Style** lists.
9. Click **OK** to save the Style Mapping rule.

**Mapping an Element to a Character Style or exact font**

In this task you will map an element or attribute to a **character style** in Illustrator, such as bold, italic or underlined text, using the Style Mapping feature in Dynamic Content.

If you map an element or attribute to a character style, Dynamic Content will automatically select the appropriate variant of the font used for the dynamic object. For example, mapping to a “bold” character style will instruct Dynamic Content to switch to the Bold, Semibold or Black variant of the font in use.

**Note:**

You can enable or disable the use of Semibold and Black variants in the Dynamic Content Preferences dialog.

1. Choose **Style Mapping...** in the fly-out menu.
   
The Style Mapping dialog box appears.
2. Click **Add...** to create a new rule or **Modify...** to refine an existing rule.
   
The **Add** or **Modify** dialog box appears.
3. Create an element- or attribute-based style mapping rule:
   
   - For an element-based rule, select the **Element Tag Name** and if necessary, further refine by selecting the parent element from the **Child Element of** list.
   - For an attribute-based rule, add an attribute by clicking the **Add** button, select the matching method from the **Is/Contains** list, and type the **Value**.
4. Select to use an exact font, or select the type of character styling you want to apply to the matching elements:
   • Enable **Use Typeface** and select the exact font to use in the dropdown. Note that selecting an exact font can't be combined with the character styling options.
   • Enable one or more of the **Bold**, **Italic** and **Underline** options; or
   • Select a predefined **Character Style** from the list.

5. Click **OK** to save the Style Mapping rule.

The presence of a character styling rule is indicated in the Style Mapping dialog with an asterisk.

![Style Mapping Dialog](image)

**Example**

This example maps an element `<b>` that also has the attribute `style="bold"` to the Bold character style.
When applying that style mapping rule, the following code:

```xml
<root>
  <p>This is a <b style="bold">bold</b> word inside a sentence.</p>
</root>
```

Would be rendered as:

```
This is a bold word inside a sentence.
```

### Automatic Mapping of tab and line break tags

If the XML data use the standard HTML formatting tags `<tab/>` (for tabulator) or `<br/>` (for line break), it’s possible to automatically map these tags to the appropriate formatting in Illustrator.

- Set the **Use `<br/>` element as line break** option to use all `<br/>` tags as a line break
- Set the **Use `<tab/>` element as tabulator** option to use all `<tab/>` tags as a tab in Illustrator.

### Automatic Style Mapping from CHILI documents

In the CHILI editor, users can apply formatting like underscore, strikethrough, font type on the edited text.

The CHILI documents will then contain attributes, reflecting the user defined formatting.

While loading the CHILI document, the CHILI plug-in automatically adds new mappings to the Style Mapping of Dynamic Content, in order to apply the formatting defined in the CHILI document.
You can freely modify or remove the mappings after loading the CHILI document, as it behaves like normal mappings being set manually.

### 3.7.2 Solving Text Overflow Problems

Text overflow occurs when a text object in Illustrator contains more text than can be displayed. Dynamic Objects are especially sensitive to text overflow: their contents can be updated regularly - and all too often without any consideration for the effects the changed content can have for a design.

Luckily, Dynamic Content immediately alerts you to text overflow problems by displaying a special [Check Alert](#) for every element in which the problem occurs.

1. After updating the contents of an XML file, click Add Filter.
2. In the Filter Type list, select Elements with Text Overflow. Only elements with text overflow are displayed in the XML Tree.
3. Alt+Click on the Check Alert icon next to the XML element you want to fix. The view in Illustrator zooms to the Dynamic Object(s) linked to the element. If the element is linked to multiple Dynamic Objects, you have to select the object with text overflow manually before proceeding.
4. Do one of the following:
   - Click the [Reflow Text](#) button and scale the Dynamic Object to allow for the additional text.
   - Use the Illustrator Type tools to reduce the font size of the text in the Dynamic Object.
5. Repeat steps 3 - 4 for each of the elements with text overflow, until the filtered XML Tree does not display any more elements.

### 3.8 Dynamic Content Preferences

The Dynamic Content Preferences allow you to determine some XML processing settings.

The Dynamic Content Preferences dialog box
3.8.1 XML Standard

The XML Standard option determines the default behavior related to the XML standards. If the GS1 standard is selected (default), the new XML files and XML elements created by the Dynamic Content plug-in and the XML file created by the Export Artwork Response command conform with the GS1 schema. The IPC option changes this behavior to let these files conform with the IPC XML schema.

3.8.2 Default Formatting of Dynamic Objects

The Remove Leading, Trailing and Duplicate Spaces from Linked XML option determines how Dynamic Content treats whitespace in linked XML elements.

If you enable the Remove Leading, Trailing and Duplicate Spaces from Linked XML option, Dynamic Content will remove any whitespace characters preceding or following the text inside an XML element that is linked to a Dynamic Object.

Note:
The space stripping function removes all leading, trailing spaces, except those directly preceding and following a nested XML element. Otherwise, text in nested elements would be rendered “glued” onto the preceding and following text.
Example
Consider the following XML snippet:

```xml
<root>
  <p>This text has leading and trailing spaces.</p>
</root>
```

If the **Remove Leading, Trailing and Duplicate Spaces from Linked XML** option is enabled, this text in any linked Dynamic Objects will be stripped of the extra whitespaces. However, a single space will be retained before and after the contents of the `<b>` element (“leading and trailing”). The result:

This text has leading and trailing spaces.

If all spaces surrounding the nested `<b>` element were also stripped, the element would read:

This text has leading and trailing spaces.

### 3.8.3 Style Mapping Preferences

The following Style Mapping Preferences can be set in the **Dynamic Content Preferences** dialog:

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Allow “semibold” typefaces to be used for automated bolding</strong></td>
<td>Allows Dynamic Content to select the Semibold variant of the current typeface, if it is available, when applying character style mapping. For example, if this option is enabled, text in the Minion Pro Regular typeface will be emboldened using Minion Pro Semibold. If this option is not set, Minion Pro Bold will be used.</td>
</tr>
<tr>
<td><strong>Allow “black” typefaces to be used for automated bolding</strong></td>
<td>Allows Dynamic Content to select the Black variant of the current typeface, if it is available, when applying character style mapping. For example, if this option is set, text in the Minion Pro Bold typeface will be emboldened using Minion Pro Black. If this option is not set, the Minion Pro Bold will stay untouched.</td>
</tr>
</tbody>
</table>
Note:
If both these options are disabled, Dynamic Content will only search for Bold variants of typefaces when applying character style mapping.

3.8.4 Updating and Relinking

The **Use Exact Matching when Updating and Re-linking XML Files** option determines how Dynamic Content links a specific XML element to a Dynamic Object in the Illustrator document. By default, this option is disabled.

**Smart or Exact Matching?**

Dynamic Content stores the link between an XML element in the source XML file and the Dynamic Object in the Illustrator design in an “absolute” path. This absolute path contains the complete XML tree structure leading up to the XML element in question. This includes all attribute values of all the elements at a higher level.

By default, Dynamic Content does not use Exact Matching to link an XML element to a Dynamic Object when you update or replace an XML file. Instead, it uses a “smart” matching algorithm to determine the most likely candidate for linking. This algorithm takes into account all of the information in the absolute path, but uses a weighting scheme that allows for small changes in the XML file without breaking all the links to the Dynamic Objects.

If the **Use Exact Matching when Updating and Re-linking XML Files** option is enabled, Dynamic Content will instead require an exact match to the XML element’s path. In this case, if any XML elements in the external file have changed position or received new attribute values, the links to the Dynamic Objects will be lost. Usually, this is not the desired behavior.

**Example**

Consider the following basic XML tree:

```xml
<CopyElement CopyElementType="Usage">
  <body>
    <p lang="de">Automat 40° 60° 90°</p>
    <p lang="ru">Автоматическая 40° 60° 90°</p>
  </body>
</CopyElement>
```

If you link the final `<p>` element (`<p style="put_style_here">Автоматическая 40° 60° 90°</p>`) to a Dynamic Object, an absolute path to this element is stored. This path includes a reference to the position of the `<p>` element relative to its parent, as well as the value for the `lang` attribute ("ru").

We complete the XML content by adding an additional language:

```xml
<CopyElement CopyElementType="Usage">
  <body>
    <p lang="de">Automat 40° 60° 90°</p>
    <p lang="en-us">Washer 40° 60° 90°</p>
    <p lang="ru">Автоматическая 40° 60° 90°</p>
  </body>
</CopyElement>
```

If we update our Illustrator design:
• with Exact Matching enabled: the last `<p>` element's link to the Dynamic Object will be broken, because the position of this element relative to its parent has changed from being the second child to third child.

• with the default behavior (Exact Matching is disabled): the last `<p>` element's link to the Dynamic Object will be retained. Even though the position of the `<p>` element has changed, the fact that its attribute value still matches the original path will result in a weighted, smart match.

---

**Always Match IPC Locales when Updating and Re-linking XML Files**

When using the IPC standard, and not using Exact Matching when Updating and Re-linking XML Files, you can choose this option.

The option is applied when re-linking the XML file. Example: A text object is linked to the Copy element identified by the CopyElement_Type="MarketingClaim", ID="XY" and Locale="en-US" attributes. The new XML file may or may not contain an element with the same identification; Dynamic Content tries to find and match the element from the new XML file and link it instead the old one - potentially followed by the content update.

If this option is set, the elements match if Copy Element Type, ID and also Locale attributes are the same in the old and the new XML file.

If this option is not set, the Locale attribute is not taken into account. It allows re-linking files with the language variants - e.g. the new XML file can contain the translation to German language and if the element is identified by CopyElement_Type="MarketingClaim", ID="XY" and Locale="de-DE", the re-link will pass and the original English content will be replaced by the German one.

---

**Always Update and Mark Changed Dynamic Objects Without Asking**

The Always Mark and Update Changed Dynamic Objects Without Asking option controls how Illustrator responds to differences between dynamic objects and their corresponding XML elements.

If this option is checked, Illustrator checks for consistency between dynamic objects and XML elements when it opens a file.

If there are changes, Illustrator changes the dynamic objects and marks them as being changed.

If this option is not checked (the default), Illustrator prompts you for action.

---

**3.8.5 WebCenter Integration**

As the options in this section are related to the WebCenter connection, they are only available if the WebCenter Connector plug-in is available.

The Automatically Check for New Document Version Every X Minutes option sets the timer how often the WebCenter service will be asked to check if a new version of the XML file is available.
If Download the Full Package for Linked CHILI Documents is enabled, the WebCenterConnector will always download the full CHILI packaged file with all its resources, instead of extracting only the XML from the document.

3.8.6 Other

The Always Save Links to IPC XML Files in Document XMP Using Absolute Paths option controls whether Illustrator saves absolute or relative paths to XML files in the document's XMP data.

An example of an absolute path would be file://networkstorage1/current/2496/XMLfile.xml. An absolute path contains the complete machine and folder structure for the file location.

An example of a relative path would be file:../../XMLfile.xml. A relative path contains a pointer to the XML file location based on the location in which the Illustrator document was last saved. If the Illustrator document containing this XMP data were opened on another computer with different drive mapping, the proper XML file would not be found.

The Allow linking MasterCopy data option allows linking GS1 elements with Locale ID, which is defined as a "Master Copy". If the option is disabled, the Master Copy elements cannot be linked. The Master Copy Locale ID value defines the particular Locale ID that identifies the Master Copy content elements. By default this is set to 0, so all GS1 XML elements with Locale ID 0 are taken as a Master Copy element.

The Show nominal values for the number of occurrences (GS1 only) option changes the way the number of occurrences is displayed in the Advanced view. See Indication of the number of occurrences on page 53. If the option is enabled, the Advanced View displays how many times the link is actually used within the artwork. If disabled, the difference between the actual and the expected number of occurrences is shown.

3.9 Appendix: Introduction to XML

This Appendix gives a very brief overview of the basic concepts and terminology of the eXtensible Markup Language (XML) standard.

3.9.1 What is XML

XML is a text-based markup language that is fast becoming the standard for data interchange. As with HTML, you identify data using tags (identifiers enclosed in angle brackets, like this: <...>). Collectively, the tags are known as “markup”.

But unlike HTML, XML tags identify the data, rather than specifying how to display it. Where an HTML tag says something like "display this data in bold font" ( <b>... </b> ), an XML tag
acts like a field name in your program. It puts a label on a piece of data that identifies it (for example: `<message>`...`</message>`).

### 3.9.2 Semantic Markup

Since identifying the data gives you some sense of what *means* (how to interpret it, what you should do with it), XML is sometimes described as a mechanism for specifying the *semantics* (meaning) of the data.

In the same way that you define the field names for a data structure, you are free to use any XML tags that make sense for a given application. Naturally, though, for multiple applications to use the same XML data, they have to agree on the tag names they intend to use.

Here is an example of some XML data you might use for a messaging application:

```xml
<message>
  <to>you@yourAddress.com</to>
  <from>me@myAddress.com</from>
  <subject>XML is really cool</subject>
  <text>How many ways is XML cool? Let me count the ways...</text>
</message>
```

The tags in this example identify the message as a whole, the destination and sender addresses, the subject, and the text of the message. As in HTML, the `<to>` tag has a matching end tag: `</to>` . The data between the tag and and its matching end tag defines an element of the XML data. Note, too, that the content of the `<to>` tag is entirely contained within the scope of the `<message>`..`</message>` tag. It is this ability for one tag to contain others that gives XML its ability to represent hierarchical data structures.

### 3.9.3 Tags and Attributes

Tags can also contain attributes - additional information that is included as part of the tag itself, within the tag's angle brackets.

The following example shows an email message structure that uses attributes for the "to", "from", and "subject" fields:

```xml
<message to="you@yourAddress.com" from="me@myAddress.com" subject="XML Is Really Cool">
  <text>How many ways is XML cool? Let me count the ways...</text>
</message>
```

Since you could design a data structure like `<message>` equally well using either attributes or tags, it can take a considerable amount of thought to figure out which design is best for your purposes.

### 3.9.4 What is IPC XML

IPC XML is a flavor of XML that was designed with the specific purpose of content interchange between brand owners and their suppliers.
It is an open format that **borrows concepts from the JDF specification** made by the CIP4 organization. The IPC XML schema was designed by the Intelligent Packaging Consortium, an informal workgroup consisting of brand owners, retailers, software vendors, consultants and packaging designers.

Dynamic Content can work with various flavors of XML (XHTML, PIM, SPL, ...). The plug-in does not place any restrictions on the XML formats you can use as long as the XML files you add to the palette are well-formed. However, because the IPC XML schema is designed specifically for use in packaging, **Dynamic Content** has a number of features that make **working with IPC-based XML files** easier.

### 3.9.5 The IPC XML Schema

The root of an IPC XML file is called `<CopyContent>`. It contains 3 sections: `<RevisionHistory>`, `<Project>` information and a `<Copy>` section which contains a number of `<CopyElement>` elements that contain the actual textual contents.

#### Understanding a sample file

The following XML file clearly shows the three sections in an IPC XML file. All the content is enclosed in the root `<CopyContent>` tag. Following that, you see:

- The `<RevisionHistory>` element, showing that this document is now at version 1.1, after a revision by Mr. Jerry Morris.
- The `<Project>` element informs us that the project is called Diapers Test, and is meant for the USA region. The project encompasses 5 Pieces of Art (POAs): there will be five Illustrator documents that use information from this XML file.
- The `<Copy>` element lists that text content, including CopyElements for the Brand Name (Pampers), Package Count (ranging from 30 to 50 diapers), and a Generic element that shows how you can add any other textual content to the IPC XML.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<CopyContent xmlns="http://www.esko.com/IPCSchema_1_0" Version="1.0" AgentName="PG ACT" AgentVersion="1.0">
  <RevisionHistory RevisionNumber="1.1">
    <Revision Type="Original" Author="Jerry Morris" RevisionNumber="1.0" TimeStamp="2007-01-31T12:00:00+01:00" />
    <Revision Type="Change" Author="Jerry Morris" RevisionNumber="1.1" TimeStamp="2007-01-31T13:00:00+01:00" />
  </RevisionHistory>
  <Project ProjectName="Diapers Test" ProjectID="P1" Region="USA">
    <POAs>
      <POA ID="P1_40" Name="Pampers 40 diapers for US" Locales="en-US es-US"/>
      <POA ID="P1_50" Name="Pampers 50 diapers for US" Locales="en-US es-US"/>
      <POA ID="P1_50_ES" Name="Pampers 50 diapers for US, Spanish only" Locales="es-US"/>
    </POAs>
  </Project>
  <Copy>
    <CopyElement ID="CP001" CopyElementType="Brand Name" SourceRef="NamesDict" CopySourceRef="21321" POAs="Common">
      <body>Pampers</body>
    </CopyElement>
    <CopyElement ID="CP002" CopyElementType="Package Count" Locale="en-US" Panels="Front Back" POAs="P1_30">
      <body>Contains 30 diapers</body>
    </CopyElement>
  </Copy>
</CopyContent>
```
3.9.6 What is GS1 XML

GS1 is an international non-profit association with member organisations in over 100 countries. GS1 is dedicated to the design and implementation of global standards and solutions to improve the efficiency and visibility of supply and demand chains globally and across sectors. The GS1 system of standards is the most widely used supply chain standards system in the world.

For more information on GS1 eCom, see [http://www.gs1.org/gsmp/kc/ecom](http://www.gs1.org/gsmp/kc/ecom)

For more information on the BMS XML standard, see [http://www.gs1.org/gsmp/kc/ecom/xml/](http://www.gs1.org/gsmp/kc/ecom/xml/)

3.10 Glossary

This Glossary gives you an overview of some basic concepts and terminology used in this manual, and what they mean in the specific context of the Dynamic Content plug-in.

**Dynamic Object**

An Illustrator text object that has been linked to an XML element from an external file by the Dynamic Content plug-in. Dynamic Objects have a number of special characteristics, which makes them behave differently than normal Illustrator text.

**IPC**

The Intelligent Packaging Consortium (IPC) is an informal workgroup consisting of brand owners, retailers, software vendors, consultants and packaging designers. The IPC workgroup designed the IPC XML Schema, a standard document structure for exchanging data between brand owners and their suppliers.
Node
A node is an item in an XML document's tree structure. Node is a generic term - this means nodes can have different types: XML element nodes, XML attribute nodes, text nodes, ...

XML Attribute
A qualifier on an XML tag that provides additional information. For example, in the tag `<slide title="My Slide">`, title is an attribute, and My Slide is its value.

XML Element
A unit of XML data, delimited by tags. An XML element can enclose other elements. For example, in the XML structure:

```xml
<slideshow>
  <slide>..</slide>
  <slide>..</slide>
</slideshow>
```

the `<slideshow>` element contains two `<slide>` elements.

XML File
A file with contents in the form of XML markup. XML markup is similar to HTML in that it also uses tags enclosed by angled brackets (example: `<element>`), but it describes the structure of the data instead of how it should be presented or rendered in a web browser.

XML Schema
A method for specifying the structure to which an XML document needs to adhere. For example, the IPC XML schema specifies that documents should contain a root element `<CopyContent>`, followed by the child elements `<RevisionHistory>`, `<Project>`, `<Copy>` in this exact order.
4. Dynamic Art

4.1 Copyright Notice

© Copyright 2018 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2015. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

 Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

 Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

 Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

 Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

 Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

 Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

 This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

 Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.


Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com

### 4.1.1 Third party license information

This product includes Botan.

Copyright (C) 1999-2009 Jack Lloyd
2001 Peter J Jones
2004-2007 Justin Karneges
2005 Matthew Gregan
2005-2006 Matt Johnston
2006 Luca Piccarreta
2007 Yves Jerschow
2007-2008 FlexSecure GmbH
2007-2008 Technische Universität Darmstadt
2007-2008 Falko Strenzke
2007-2008 Martin Doering
2007 Manuel Hartl
2007 Christoph Ludwig
2007 Patrick Sona
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions, and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S) OR CONTRIBUTOR(S) BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes ICC Profiles.

Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
ColourKit Profiler Suite (www.colourprofiling.com)

------------------------------------------------------------
This product includes ICC Profiles.

Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org

------------------------------------------------------------
This product includes ICC Profiles.

Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org

------------------------------------------------------------
This product includes ICC Profiles.

Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and
SWOP(R) are all registered trademarks of IDEAlliance(C).

------------------------------------------------------------
This product includes curl.

Copyright (c) 1996 - 2015, Daniel Stenberg, <daniel@haxx.se>.
All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose
with or without fee is hereby granted, provided that the above copyright
notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not
be used in advertising or otherwise to promote the sale, use or other dealings
in this Software without prior written authorization of the copyright holder.

------------------------------------------------------------
This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and
its documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of
Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

------------------------------------------------------------
This product includes FCollada.

Copyright 2006 Feeling Software. All rights reserved.
Copyright 2005-2006 Feeling Software and
Copyright 2005-2006 Autodesk Media Entertainment.
Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

------------------------------------------------------------
This product includes FreeType.

Portions of this software are copyright (C) 2014 The FreeType Project (www.freetype.org) licensed under the Freetype License.
All rights reserved.

------------------------------------------------------------
This product includes gSOAP.

EXHIBIT B.

Part of the software embedded in this product is gSOAP software.

Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes ICU.

Copyright (c) 1995-2014 International Business Machines Corporation and others
All rights reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal in the
Software without restriction, including without limitation the rights to use,
copy, modify, merge, publish, distribute, and/or sell copies of the Software, and
to permit persons to whom the Software is furnished to do so, provided that the
above copyright notice(s) and this permission notice appear in all copies of the
Software and that both the above copyright notice(s) and this permission notice
appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes ilmbase.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm
Entertainment Company Ltd. Portions contributed and copyright held by
others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with
the distribution.

* Neither the name of Industrial Light & Magic nor the names of
any other contributors to this software may be used to endorse or
promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes iODBC.

Copyright (C) 1995-2006, OpenLink Software Inc and Ke Jin.
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
3. Neither the name of OpenLink Software Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL OPLENK OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes IP*Works!.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES; SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSH.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.
LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE.
/N SOFTWARE’S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIABILITY IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSL.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE (“HIGH RISK ACTIVITIES”). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE’S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIABILITY IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes JBIG2Lib.

Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.

This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
All Rights Reserved.

This software is based in part on the work of the Independent JPEG Group.

This product includes Little CMS.
Little CMS
Copyright (c) 1998-2011 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

------------------------------------------------------------
This product includes leptonica.

- Copyright (C) 2001-2016 Leptonica. All rights reserved.
- Redistribution and use in source and binary forms, with or without
- modification, are permitted provided that the following conditions
- are met:
- 1. Redistributions of source code must retain the above copyright
- notice, this list of conditions and the following disclaimer.
- 2. Redistributions in binary form must reproduce the above
- copyright notice, this list of conditions and the following
- disclaimed in the documentation and/or other materials
- provided with the distribution.
- THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
- `AS IS' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
- LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
- A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL ANY
- CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
- EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
- PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
- PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
- OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
- NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
- SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes libpng.

Copyright (c) 2000-2002 Glenn Randers-Pehrson

The PNG Reference Library is supplied "AS IS". The Contributing Authors
and Group 42, Inc. disclaim all warranties, expressed or implied,
including, without limitation, the warranties of merchantability and of
fitness for any purpose. The Contributing Authors and Group 42, Inc.
assume no liability for direct, indirect, incidental, special, exemplary,
or consequential damages, which may result from the use of the PNG
Reference Library, even if advised of the possibility of such damage.
There is no warranty against interference with your enjoyment of the
library or against infringement. There is no warranty that our
efforts or the library will fulfill any of your particular purposes
or needs. This library is provided with all faults, and the entire
risk of satisfactory quality, performance, accuracy, and effort is with
the user.

------------------------------------------------------------
This product includes libxml2.

Copyright (C) 1998-2012 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is fur-
nished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

------------------------------------------------------------

This product includes openexr.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm
Entertainment Company Ltd. Portions contributed and copyright held by
others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above
  copyright notice, this list of conditions and the following
  disclaimer.

* Redistributions in binary form must reproduce the above
  copyright notice, this list of conditions and the following
  disclaimer in the documentation and/or other materials provided
  with the distribution.

* Neither the name of Industrial Light & Magic nor the names of
  any other contributors to this software may be used to endorse or
  promote products derived from this software without specific prior
  written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes OpenJPEG.

Copyright (c) 2002-2012, Communications and Remote Sensing Laboratory, Universite
catholique de Louvain (UCL), Belgium
Copyright (c) 2002-2012, Professor Benoit Macq
Copyright (c) 2003-2012, Antonio Descampe
Copyright (c) 2003-2009, Francois-Olivier Devaux
Copyright (c) 2005, Herve Drolon, FreeImage Team
Copyright (c) 2002-2003, Yannick Verschueren
Copyright (c) 2001-2003, David Janssens
Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
Copyright (c) 2012, CS Systemes d'Information, France
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:
1. Redistributions of source code must retain the above copyright
   notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
   notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS `AS IS'
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes OpenSSL.

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in
the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this
software must display the following acknowledgment:
"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
endorse or promote products derived from this software without
prior written permission. For written permission, please contact
openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
nor may "OpenSSL" appear in their names without prior written
permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
acknowledgment:
"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT `AS IS' AND ANY
EXRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes OpenSSL.

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
3. If advertising materials mentioning features or use of this software
must display the following acknowledgement:
"This product includes cryptographic software written by
Eric Young (eay@cryptsoft.com)"
The word 'cryptographic' can be left out if the routines from the library
being used are not cryptographic related :-).
4. If you include any Windows specific code (or a derivative thereof) from
the app directory (application code) you must include an acknowledge:
"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

------------------------------------------------------------
This product and use of this product is under license from Markzware
under U.S. Patent No. 5,963,641.

------------------------------------------------------------
This product includes Qt.
The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).

------------------------------------------------------------
The Qt Toolkit is Copyright (C) 2014 Digia Plc and/or its subsidiary(-ies).

------------------------------------------------------------
This product includes QtMigration.
Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:
* Redistributions of source code must retain the above copyright
  notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright
  notice, this list of conditions and the following disclaimer in
  the documentation and/or other materials provided with the
  distribution.
* Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
  of its contributors may be used to endorse or promote products derived
  from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes tesseract.
Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0
This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes XercesC.

NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this case for the Apache Xerces distribution.

This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).

Portions of this software were originally based on the following:

This product includes XMP Toolkit.

Copyright (c) 1999 - 2010, Adobe Systems Incorporated
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Adobe Systems Incorporated, nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes zlib.

Copyright (C) 1995-2004 Jean-loup Gailly and Mark Adler
4.2 About the Dynamic Art plug-in

What is “dynamic art”?

The Dynamic Art plug-in allows you to quickly tag the placeholder type objects, table objects and barcodes that you created in your Illustrator design as “Dynamic Art” objects.

Any object that will receive its final textual content at a later stage in the design process, based on the content in an XML file, can be turned into a Dynamic Art object. Empty text objects added to the Dynamic Art palette are automatically filled with dummy text; you cannot have an empty dynamic text object. If you create a text object in Illustrator with your own text, than that text is added to the Dynamic Art palette as soon as you convert it to a dynamic object.

All Dynamic Art objects you create in an Adobe Illustrator document are listed in the Dynamic Art palette.

Dynamic Art objects are saved in the Illustrator document. This allows one designer to define Dynamic Art objects, then pass the file on to other designers. These people can then use the same Dynamic Art objects to link in the final content.

4.3 Why Use Dynamic Art?

Dynamic Art is used in a Dynamic Content workflow. Dynamic Content is an Esko plug-in for Adobe Illustrator that allows you to link content from an external XML file to objects (type, tables, barcodes, Illustrator symbols, and external images) in the Illustrator document.

The suggested workflow for using Dynamic Art in combination with Dynamic Content is the following:
### Dynamic Content Advanced

<table>
<thead>
<tr>
<th>Phase</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1     | The designer creates a design in Adobe Illustrator. In the design, dummy or “placeholder” objects are placed where dynamic content will be linked later on in the production process. These objects can be:  
  • type objects created with the Illustrator Type tools;  
  • barcodes created with the Esko Dynamic Barcodes plug-in;  
  • nutritional and other tables created with the Esko Dynamic Tables plug-in;  
  • Illustrator symbols;  
  • External images. |
| 2     | Once the design is finalized, the designer selects all the placeholder objects and adds them to the Dynamic Art palette. |
| 3     | Later in the production process, the brand owner supplies the approved textual content for the design, in the form of an XML file. |
| 4     | Using the Esko Dynamic Content plug-in, the designer adds the XML content file to the Illustrator document and Auto Links the content if possible, or links them manually to the corresponding content from the XML file.  
  The file is now ready for final approval and for the next steps in the production process. |

### 4.4 The Dynamic Art Palette

The Dynamic Art palette can be opened by choosing Window > Esko > Dynamic Art.

1. Filter buttons: from left to right, these are Show All Dynamic Art, Show Barcode Art, Show Table Art, Show Type Art, Show Image Art, Show Symbol Art and Coding Info.
2. Dynamic Art list.
3. **Select and zoom to object** button.
4. **New Dynamic Art** button.
5. **Delete Dynamic Art** button.
6. **Link indicator** indicates how the placeholder is linked. The color of the symbol represents the color of the XML file used in Dynamic Content.
   - XML without a circle: a single link placeholder, already linked to an XML element in Dynamic Content.
   - XML with a filled circle: all links in the multi-link Dynamic Art placeholders were applied using Autolink
   - XML with a half-filled circle: some links in the multi-link Dynamic Art placeholders were applied using Autolink, others were not found in the XML, so they become orphans
   - CHILI: the placeholder is linked to a CHILI Package.

**Tip:** You can drag and drop items within the palette in **Show All Dynamic Art** view, to keep them in a logical order (not connected to the order in the Layer palette). When exported to and opened in CHILI, the text placeholders will be shown in the order set in the Dynamic Art palette.

### 4.5 Dynamic Art on the Canvas

By default, Dynamic Art highlights the Dynamic Art objects on the Illustrator canvas that you have added to the Dynamic Art palette. The highlight takes the form of a colored box around the object, with a heading that represents the type of object, and that provides further information such as intended content locale and instance.

### 4.6 Working with Dynamic Art

#### 4.6.1 Create a Dynamic Art Object

1. If it is not yet visible, choose **Window > Esko > Dynamic Art** to display the Dynamic Art palette.
2. On the Illustrator canvas, select the object you want to add as a Dynamic Art object.
3. Click the **New Dynamic Art** button at the bottom of the palette.
   
   The object is converted into a Dynamic Art object: it is listed in the **Dynamic Art** palette, and it is highlighted on the canvas.

#### 4.6.2 Viewing and Navigating to Dynamic Art

Dynamic Art provides more than just a list of Dynamic Art objects. You can:
Dynamic Content Advanced

- Select a specific Dynamic Art object in the document by clicking to the right of its entry in the Dynamic Art palette, similar to how you select an Illustrator layer in the Layers palette.
- Select a specific Dynamic Art object in the Dynamic Art palette and zoom to it by clicking the Select and zoom to object button at the bottom of the Dynamic Art palette.
- Filter the list of placeholder objects in the Dynamic Art palette by clicking the appropriate filter button at the top of the palette:
  - Show Barcode Art
  - Show Table Art
  - Show Type Art
  - Show Image Art
  - Show Symbol Art
  - Show Coding Info

### 4.6.3 Fill Type Objects with Dummy Text

To fill an existing Dynamic Art type object with Lorem Ipsum text, select the object in the Dynamic Art palette and choose Fill with Dummy Text from the fly-out menu. New empty type objects automatically get filled with Lorem Ipsum text when you make them Dynamic Art objects.

### 4.6.4 Edit and Delete Dynamic Art Objects

- To rename a Dynamic Art object, select it and do one of the following:
  - double-click its entry in the Dynamic Art palette. Type a new name and click OK.
  - choose Properties from the fly-out menu. Type a new name and click OK.

  **Note:** This only changes the name of the object in the Dynamic Art palette. It does not affect the text content of the object in the Illustrator document or the label name of the highlight canvas.

- To delete a Dynamic Art object, select the object in the Dynamic Art palette and either:
  - choose Delete from the fly-out menu; or
  - click the Delete button at the bottom of the palette.

  **Note:** This only deletes the Dynamic Art object. The original type, barcode or table object on the Illustrator canvas is not removed.

### 4.6.5 Define Advanced Properties for Type Art

For type objects that have been added to the Dynamic Art palette, you can provide some additional properties.

To change the advanced properties:
1. Double-click the type object in the Dynamic Art palette, or select the entry and choose Properties from the fly-out menu.

2. Set the Attributes. The parameters are divided in four groups:
   - 1. XML Attributes. See XML Parameters on page 122.
   - 2. Chili Publisher parameters. For more information on the CHILI settings, we refer to the Chili documentation. These are only available if the Chili Publisher option is enabled in the Preferences. See Dynamic Art Preferences on page 126.
   - 3. Videojet Marking. See Videojet Marking on page 125. These are only available if the Videojet Marking option is enabled in the Preferences. See Dynamic Art Preferences on page 126.
   - If Assign multiple XML attributes is enabled, define the Fit Text Frame to Contents (Auto-grow) and Fit Contents to Text Frame (Copy-fitting) options. See Fit Text Frame to Contents / Fit Contents to Text Frame on page 77

3. Click OK

**XML Parameters**

If you set these properties, Dynamic Content will filter the list of available elements to only show the matching elements, further simplifying the task of the person linking the Dynamic Art objects to the XML content.

Dynamic Art will also provide the Auto link feature, allowing the automatic filling of Dynamic Art placeholders with matching GS1 or IPC XML content.

**Note:** In the Preferences, you can choose between the GS1 standard or the IPC standard. Depending on this choice, the dialog will look differently.

1. Define the GS1 or IPC XML Content Type from a file that should be linked to this type object
2. Define the language for use in multilingual GS1 or IPC files
   - For the IPC XML standard workflow, define the locale (for example "en-us" for US English) of the object or the Locale Variable. See also Use Locale Variables for Type Elements (IPC XML standard only) on page 125
   - For the GS1 XML standard, define the Language Index. Language Index represents the GS1 localeSequence tag, whose mapping is defined in the header of the GS1 XML.
3. For the GS1 XML standard, define the **Instance ID**, which is used for differentiating multiple objects of the same content type.

For example, the GS1 XML file can hold the content of the "MARKETING_CLAIM" type in the short and in the long variant, one for the front package panel, the second for the side panel, and these elements then have the same content type (Marketing claim) defined but different Instance ID (GS1 tag instanceSequence). This unique identification is crucial for further Automatic linking in **Dynamic Content** and is one of the main advantages of the GS1 XML standard.

**Assign multiple XML Attributes**

If you enable **Assign multiple XML attributes**, the dialog will show a list of all XML Attributes

- Add a link by clicking the + button.
- Remove a link by clicking the - button.
- Change the order of the links by clicking the arrow buttons
- Select a Link in the list to change its settings underneath.

The settings depend on the selected Standard: GS1 or IPC. See **XML Parameters** on page 122. You can also define:

- the **Prefix** and **Suffix** for every link
- if paragraphs should be preserved in the XML
- to add a space in between links
- if you want to remove whitespaces from the XML
- the **Fit Text Frame to Contents** (Auto-grow) and **Fit Contents to Text Frame** (Copy-fitting) options. See **Fit Text Frame to Contents / Fit Contents to Text Frame** on page 77

**Fit Text Frame to Contents / Fit Contents to Text Frame**

In the **Format Dynamic Text** dialog, you can view information on the XML elements linked to the selected Dynamic Object, and set automatic modification of the Dynamic Object size or the text size within the Dynamic Object.
The Fit Text Frame to Contents (Auto-grow) and Fit Contents to Text Frame (Copy-fitting) options allow setting the options for future use in Dynamic Content. They can only be set if Assign multiple XML Attributes is enabled. You can choose to fit the text frame to the contents, or fit the contents to the text frame. Combining the two is not possible.

**Fit Text Frame to Contents**

If you use Fit Text Frame to Contents, the text box will grow to fit the actual text content, coming from the XML source. The text box size will be adapted every time the XML source changes.

This option is useful when you’re not sure what amount of text will come from the XML, and you want to avoid text overflow.

- The **Direction** defines in what direction the text box can grow: down, up, to the left or to the right.
• Using **Minimum Height** and **Maximum Height** (or width, depending on the direction) you can define the minimum and maximum size for the text box.

**Note:** This option is only available for Area Text objects, so not for Text on Point or Text on Path.

### Fit Contents to Text Frame

If you use **Fit Contents to Text Frame**, the font size will change to fit the text frame.

This option is useful when the space for the text is limited, and font size changes are allowed by the design rules.

• The **Minimum Text Size** and **Maximum Text Size** define the minimum and maximum font size to be used.

**Note:** This option is only available for Area Text objects and Text on Path, so not for Text on Point.

### Use Locale Variables for Type Elements (IPC XML standard only)

If you are creating multi-region products, instead of assigning a specific locale to text objects, you can assign locale variables. This way, when you link an multilingual XML content file in Dynamic Content, the proper language is applied to the text objects.

1. In the Dynamic Art palette, select the type objects to assign a locale variable to and choose **Properties** from the fly-out menu.

2. In the **Dynamic Art Options** dialog box, check **Assign a specific type of content to this art** and choose the appropriate types for the data in the XML content file. Also, check the **Assign a language to this art** checkbox, and then choose **A language variable**. Enter a variable name (such as \text{L1}) in the appropriate field. Click **OK**.

3. Repeat steps 1 and 2 for objects that will be in other languages, using variables \text{L2} and \text{L3} (for example).

4. You can now use Dynamic Content to map the locale variables, add the XML content file, and Auto Link so that the type objects are filled automatically with the correct text. See the **Dynamic Content User Guide** for more information.

### Videojet Marking

Using **Videojet Marking** you can export Dynamic Art placeholders to a specific ZPL (Zebra label printer) format. All Dynamic Art objects can be tagged to become either **Static**, **Dynamic Text** or **Dynamic Date** when exporting the ZPL file.

To create the ZPL file, choose **Videojet Export** in the fly-out menu. All non-text Dynamic Art placeholders will be exported as PNG images besides the ZPL file.
4.7 Export XML Template

The Export XML Template can be found in the Dynamic Art Panel.

This feature collects user-defined parameters of Dynamic Art text objects as Locale, CopyContent type or Locale Variable.

Then the XML file is exported, in the format specified by the XML standard (GS1 or IPC) set in the Preferences. In the XML file, each Dynamic Art text object will be represented by the proper content elements according to the selected XML standard schema.

This XML Template file can be easily used as a template for future filling by the real content.

4.8 Dynamic Art Preferences

You can open the Dynamic Art Preferences by choosing Illustrator > Preferences > Esko > Dynamic Art Preferences

You can choose if you want to see the CHILI Publisher or Videojet Marking options in the Dynamic Art Options palette. See Define Advanced Properties for Type Art on page 121

The XML Standard option determines the default behavior related to the XML standards. If the GS1 standard is selected (default option), the Dynamic Art Options dialog allows entering the GS1 XML specific parameters and the Export XML Template exports an XML file valid against the GS1 XML schema. The IPC option changes the behavior to let these options and files conform with the IPC XML schema. See Define Advanced Properties for Type Art on page 121
5. Dynamic Barcodes

5.1 Copyright Notice

© Copyright 2018 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2015. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.


Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:
Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com

5.1.1 Third party license information

This product includes Botan.

Copyright (C) 1999–2009 Jack Lloyd
2001 Peter J Jones
2004–2007 Justin Karneges
2005 Matthew Gregan
2005–2006 Matt Johnston
2006 Luca Piccarreta
2007 Yves Jerschow
2007–2008 FlexSecure GmbH
2007–2008 Technische Universität Darmstadt
2007–2008 Falko Strenzke
2007–2008 Martin Doering
2007 Manuel Hartl
2007 Christoph Ludwig
2007 Patrick Sona
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions, and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S) OR CONTRIBUTOR(S) BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes ICC Profiles.

Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
ColourKit Profiler Suite (www.colourprofiling.com)

------------------------------------------------------------
This product includes ICC Profiles.

Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org

------------------------------------------------------------
This product includes ICC Profiles.

Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org

------------------------------------------------------------
This product includes ICC Profiles.

Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and
SWOP(R) are all registered trademarks of IDEAlliance(C).

------------------------------------------------------------
This product includes curl.

Copyright (c) 1996 - 2015, Daniel Stenberg, <daniel@haxx.se>.  
All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose
with or without fee is hereby granted, provided that the above copyright
notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not
be used in advertising or otherwise to promote the sale, use or other dealings
in this Software without prior written authorization of the copyright holder.

------------------------------------------------------------
This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and
its documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of
Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

------------------------------------------------------------
This product includes FCollada.

Copyright 2006 Feeling Software. All rights reserved.
Copyright 2005-2006 Feeling Software and
Copyright 2005-2006 Autodesk Media Entertainment.

Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

------------------------------------------------------------
This product includes FreeType.

Portions of this software are copyright (C) 2014 The FreeType Project (www.freetype.org) licensed under the Freetype License.
All rights reserved.

------------------------------------------------------------
This product includes gSOAP.

EXHIBIT B.

Part of the software embedded in this product is gSOAP software.

Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes ICU.

Copyright (c) 1995-2014 International Business Machines Corporation and others
All rights reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes ilmbase.
Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes iODBC.
Copyright (C) 1995-2006, OpenLink Software Inc and Ke Jin.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of OpenLink Software Inc. nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS...
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL OPENLINK OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INCOME) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

This product includes IP*Works!.
Copyright (c) 2013 /n software inc. - All rights reserved.
DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE
SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING
THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN
TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE
ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED
BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS
EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS
WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE
LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR
INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS
REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES,
AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE
SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE
COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL
DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM
ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE
LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL
BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE.
/N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY
DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE,
OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE,
ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE,
PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL
DAMAGES
OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES,
HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR
INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE,
ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE
POSSIBILITY OF SUCH DAMAGES SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF
LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSH.
Copyright (c) 2013 /n software inc. - All rights reserved.
DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE
SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING
THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN
TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE
ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED
BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS
EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS
WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE
LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR
INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS
REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES,
AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE
SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE
COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL
DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM
ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.
LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE.

/N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIABILITY IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSL.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIABILITY IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes JBIG2Lib.

Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.

This product includes JPEGLib.

This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
All Rights Reserved.

This software is based in part on the work of the Independent JPEG Group.

This product includes Little CMS.
Little CMS
Copyright (c) 1998-2011 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

------------------------------------------------------------
This product includes leptonica.
- Copyright (C) 2001-2016 Leptonica. All rights reserved.
- Redistribution and use in source and binary forms, with or without
  modification, are permitted provided that the following conditions
  are met:
  1. Redistributions of source code must retain the above copyright
     notice, this list of conditions and the following disclaimer.
  2. Redistributions in binary form must reproduce the above
     copyright notice, this list of conditions and the following
     disclaimer in the documentation and/or other materials
     provided with the distribution.
- THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
  ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
  LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
  A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL ANY
  CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
  EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
  PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
  PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
  OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
  NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
  SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes libpng.
Copyright (c) 2000-2002 Glenn Randers-Pehrson

The PNG Reference Library is supplied "AS IS". The Contributing Authors
and Group 42, Inc. disclaim all warranties, expressed or implied,
including, without limitation, the warranties of merchantability and of
fitness for any purpose. The Contributing Authors and Group 42, Inc.
assume no liability for direct, indirect, incidental, special, exemplary,
or consequential damages, which may result from the use of the PNG
Reference Library, even if advised of the possibility of such damage.
There is no warranty against interference with your enjoyment of the
library or against infringement. There is no warranty that our
efforts or the library will fulfill any of your particular purposes
or needs. This library is provided with all faults, and the entire
risk of satisfactory quality, performance, accuracy, and effort is with
the user.

------------------------------------------------------------
This product includes libxml2.
Copyright (c) 1998-2012 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is fur-
nished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

------------------------------------------------------------

This product includes OpenEXR.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm
Entertainment Company Ltd. Portions contributed and copyright held by
others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above
  copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above
  copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with
  the distribution.

* Neither the name of Industrial Light & Magic nor the names of
  any other contributors to this software may be used to endorse or
  promote products derived from this software without specific prior
  written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes OpenJPEG.

Copyright (c) 2002-2012, Communications and Remote Sensing Laboratory, Universite
catholique de Louvain (UCL), Belgium
Copyright (c) 2002-2012, Professor Benoit Macq
Copyright (c) 2003-2012, Antonio Descampe
Copyright (c) 2003-2009, Francois-Olivier Devaux
Copyright (c) 2005, Herve Drolon, FreeImage Team
Copyright (c) 2002-2003, Yannick Verschueren
Copyright (c) 2001-2003, David Janssens
Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
Copyright (c) 2012, CS Systemes d'Information, France
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:
1. Redistributions of source code must retain the above copyright
   notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
   notice, this list of conditions and the following disclaimer in the
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 'AS IS' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenSSL.

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)")

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:
"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)")

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT AS IS' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenSSL.

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
3. All other materials mentioning features or use of this software
must display the following acknowledgement:
"This product includes software written by Eric Young (eay@cryptsoft.com)"
The word 'cryptographic' can be left out if the routines from the library
being used are not cryptographic related :-).
4. If you include any Windows specific code (or a derivative thereof) from
the apps directory (application code) you must include an acknowledgement:
"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

This product and use of this product is under license from Markzware
under U.S. Patent No. 5,963,641.

This product includes Qt.
The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).

This product includes QtMigration.

Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:
* Redistributions of source code must retain the above copyright
  notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright
  notice, this list of conditions and the following disclaimer in
  the documentation and/or other materials provided with the
  distribution.
* Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
  of its contributors may be used to endorse or promote products derived
  from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes tesseract.

Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0
This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes XercesC.

NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this case for the Apache Xerces distribution.

This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).

Portions of this software were originally based on the following:

This product includes XMP Toolkit.

Copyright (c) 1999 - 2010, Adobe Systems Incorporated
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Adobe Systems Incorporated, nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes zlib.

Copyright (C) 1995-2004 Jean-loup Gailly and Mark Adler
5.2 What is a barcode?

A barcode is a machine-readable representation of information in a visual format on a surface. Barcodes can be read by optical scanners, allowing quick and easy identification of all kind of goods.

Originally barcodes stored data in the widths and spacings of printed parallel lines, but today they also come in patterns of dots, concentric circles, and hidden in images.

The information contained in a barcode varies from numbers to complete ASCII texts. The drive to encode ever more information in combination with the space requirements of simple barcodes led to the development of matrix barcodes or 2D barcode, which do not consist of bars but rather a grid of square cells.

Barcodes are just the visible part of often quite large systems frequently referred to as automated identification systems. These systems are increasingly proving to be some of the most cost-effective management tools, since they enable organizations to keep track of their goods and stocks in all kinds of situations in a fast, accurate and efficient way.

With the Dynamic Barcodes plug-in, you can add a dynamic barcode to your document without leaving your application. Dynamic means that your barcode settings can be changed later on, even after you saved, closed and reopened your document.

5.3 Getting Started with Dynamic Barcodes

To introduce you to Dynamic Barcodes, here is how to make your first barcode in four simple steps.

1. Create a CMYK Illustrator document and go to Windows > Esko > Dynamic Barcodes. This opens the Dynamic Barcodes dialog.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no stroke.

3. Enter the barcode parameters (Barcode Type, numeric Code...) in the Dynamic Barcodes dialog.
   For example, for an EAN 13 barcode, select **EAN 13** as Barcode Type and enter a 13 digit Code.

4. Click the Create button and Dynamic Barcodes will generate the barcode in your document.
5.4 Using Dynamic Barcodes in Unlicensed Mode

If you don't have a license for the Dynamic Barcodes plug-in, you still use it in unlicensed mode to perform limited operations. You can:

• Open documents containing barcodes created by Dynamic Barcodes without warning messages.

• Create barcode placeholders (with no data in them) in your design.
  See Creating a Barcode Placeholder Quickly on page 146.

You can also use the regular Illustrator functions to:

• change the barcode's position in your document,

• rotate it by multiples of 90 degrees (using **Object > Transform > Rotate**),

  **Tip:** You can rotate several barcodes at once.

• change its fill color (it is not possible to apply a stroke),

  **Attention:**
  Choose a fill color that is:
  • a process or a spot color (other colors might generate trapping problems),
  • not too light (or the barcode might be difficult to scan).

• copy and paste it.

• delete it.

5.5 Dynamic Barcodes Basics

5.5.1 Creating a Barcode

1. Create a CMYK Illustrator document and go to **Windows > Esko > Dynamic Barcodes**.
   You can also use the **Command + Option + 4** shortcut on Mac, or the **CTRL + Alt + 4** shortcut on PC.
   This opens the **Dynamic Barcodes** dialog.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no stroke.

Dynamic Barcodes creates bars by generating rectangular objects and assigning the current fill style to them.

---

**Attention:**
Choose a fill color that is:
- a process or a spot color (other colors might generate trapping problems),
- not too light (or the barcode might be difficult to scan).

3. In the Dynamic Barcodes dialog, select your Barcode Type.
4. Enter a Rotation angle for your barcode, or use one of the rotation buttons. Choose the Orientation of your barcode using one of the buttons or by entering an angle.
5. Enter the barcode's data in the Code field. For most barcodes, you can choose to also show this data as a (human-readable) number.
Attention: Make sure the barcode data you enter is valid for the barcode type you chose. If it isn't, a warning / error will pop up.

Note: If you enter a wrong check digit, Dynamic Barcodes can fix it automatically for you.

6. To fill in other parameters specific to the barcode type you chose, open the Additional parameters section and see Barcode Types on page 162.
7. Click the **Create** button.

- If you have the boostX plug-in installed, Dynamic Barcodes generates your barcode at the intersection of the boostX crosshair.
- If you don’t have the boostX plug-in installed, Dynamic Barcodes generates your barcode in the center of the view.
5.5.2 Editing a Barcode

With Dynamic Barcodes, you can also edit existing barcodes.

1. Open the **Dynamic Barcodes**.
2. Select the barcode to edit in your Illustrator document.
3. Change its parameters as you wish in the **Dynamic Barcodes** dialog.

**Note:**

If you change the **Barcode Type** and the previous **Code** is not valid for this barcode type, Dynamic Barcodes will reset it to the (first) default code for this barcode type.

This is the default code used for placeholder barcodes; you can see it in the preset barcodes dialog (see *Previewing and Creating a Barcode Placeholder* on page 148).

You can then either:

- enter your own valid code,
- use this default code to create a placeholder barcode (see *Creating a Barcode Placeholder Quickly* on page 146).

4. Click the **Apply** button to apply your changes to the barcode.

5.5.3 Setting Barcode Parameters to Default

To reset all the parameters of the selected barcode to default, click the palette menu in the top right corner of the **Dynamic Barcodes** dialog then click **Set Default Parameters**.
5.5.4 Barcode Placeholders

If you don’t have the exact data to encode in your barcode yet, you can already create a barcode placeholder in your design.

This placeholder will have the correct symbol type for the barcode type you choose, but will only contain “empty” or “default” data (for example 0000000000000 for EAN 13).

Creating a Barcode Placeholder Quickly

1. Open the Dynamic Barcodes dialog from Windows > Esko > Dynamic Barcodes.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no stroke.
Attention:
Choose a fill color that is:
• a process or a spot color (other colors might generate trapping problems),
• not too light (or the barcode might be difficult to scan).

3. In the Dynamic Barcodes dialog, select your Barcode Type.
   The Code field is automatically filled out with a null / default value that has the correct number of digits for your Barcode Type (for example 0000000000000 for EAN 13).

4. Click the Create button to create your barcode placeholder.
Previewing and Creating a Barcode Placeholder

You can use Dynamic Barcodes to preview different barcode types before creating your barcode placeholder.

1. Open the **Dynamic Barcodes** dialog from **Window > Esko > Dynamic Barcodes**.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no stroke.

![Color Palette](image)

**Attention:**

Choose a fill color that is:

- a process or a spot color (other colors might generate trapping problems),
- not too light (or the barcode might be difficult to scan).

3. In the **Dynamic Barcodes** dialog, click the Pre-set barcodes icon.

This opens the **Select Barcode** dialog.
4. Select your **Barcode Type** on the right to see a **Preview** of it on the left.

**Note:** This shows previews of barcode placeholders. Your actual barcode (with data and specific parameters affecting its size) may look slightly different. For more information on barcode parameters, see **Barcode Types** on page 162.

5. If your barcode data can have several possible lengths (for example EAN 13 can have 13, 15 or 18 digits), choose the length you want to preview in **Code Preset**.

6. If your barcode can have a **Composite Component** (some GS1 barcodes), you can choose to preview it with or without that component.

7. Click **OK** to use the preview parameters (**Barcode Type, Code Preset** and **Composite Component** as applicable) in the **Dynamic Barcodes** dialog and close the **Select Barcode** dialog.

8. In the **Dynamic Barcodes** dialog, click the **Create** button to create your barcode placeholder.
5.6 Dynamic Barcodes Advanced

5.6.1 Choosing a Font Standard

You can choose between two font standards for the human-readable characters of your barcodes.

1. Go to Illustrator > Preferences > Esko > Dynamic Barcodes Preferences... to open the Dynamic Barcodes Preferences dialog.

2. Choose either OCR-B Standard or OCR-B Bitstream and click OK.

<table>
<thead>
<tr>
<th>OCR-B Standard</th>
<th>OCR-B Bitstream</th>
</tr>
</thead>
<tbody>
<tr>
<td>fonts are rounder and typically used in the Western market.</td>
<td>fonts are typically used in the Asian market.</td>
</tr>
</tbody>
</table>
5.6.2 Using Dynamic Content with Dynamic Barcodes

You can use the Dynamic Content plug-in to turn barcodes created with Dynamic Barcodes into XML-driven objects. These barcodes update automatically when the XML files to which they are linked change.

For more information, see the Dynamic Content documentation.

5.6.3 Barcode Protection

Once you create a barcode with Dynamic Barcodes, this barcode is protected. This means that it won't be possible to edit it with most regular Illustrator tools. This protects the barcode against modifications that might render it invalid, for example distorting it or modifying its size.

You can still edit the barcode's parameters at any time through the Dynamic Barcodes dialog.

Protecting a Barcode

You can protect a Dynamic Barcodes barcode that has been unprotected, or a barcode made in a previous version of Dynamic Barcodes.

1. Open the Dynamic Barcodes plug-in.
2. Select the barcode to protect in your Illustrator document.
3. If necessary, change its parameters in the Dynamic Barcodes dialog.
4. Click the Apply button to apply the parameter changes and protect your barcode.

Tip: You can use this to fix some invalid barcodes.

Handling a Barcode without Dynamic Barcodes

Opening a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes

When opening a document containing a Dynamic Barcodes barcode in an Illustrator application that doesn't have the Dynamic Barcodes plug-in, you will get the following warning:
This **doesn't create any problem in your file**, and you can continue to work with this file as you normally would, without editing the Dynamic Barcodes barcode.

If you need to edit the Dynamic Barcodes barcode with your Illustrator application, see *Editing a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes* on page 152.

**Editing a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes**

If you don't have the Dynamic Barcodes plug-in, you can still use Illustrator to do the following operations without rendering your barcode invalid.

If you don't have Dynamic Barcodes installed, you will **not** be able to

- move or scale the object using the Selection tool
- move or distort it (reflect, shear or scale)
- change a color

You will be able to

- expand the bar code
- Rotate by Selection or Free transform - this can lead to inconsistent results so we recommend not doing this.
- move, rotate and distort by the Transform Each command - this can lead to inconsistent results so we recommend not doing this.
- enclose it in the Envelope and distort
- delete it
- copy and paste it

If the Dynamic Barcode plugin is installed, but without a valid license, you will be able to do everything that is allowed by the plugin, except modifying the content. This means for example moving and rotating is allowed, but due to the bar code protection, any potentially dangerous operations such as scale, reflect or shear are not allowed. You will also be able to change the color of the bar code.

**Unprotecting a Dynamic Barcodes Barcode for Further Editing**

You can expand your Dynamic Barcodes barcode to a regular Illustrator group art to be able to edit it further, but this is not recommended as it will **remove the barcode's protection**.
1. To do this, go to **Object > Expand...** in the Illustrator menu.
2. Choose the object's characteristics to expand, then click **OK**.

This turns your barcode into a regular Illustrator object. You can now for example edit each bar of the barcode individually.

### 5.6.4 Exporting Documents with Barcodes

If you are using other Esko applications, you can export Illustrator documents containing barcodes to the Esko Normalized PDF format, preserving the barcodes' information and editability.

#### Viewing Barcode Information in Other Esko Applications

1. Export your Illustrator document to the Esko Normalized PDF format:
   - If you have Automation Engine, use **Shuttle** to launch the document into your chosen workflow. This converts it to Normalized PDF automatically.
     
     **Note:** See the Adobe Illustrator Client documentation for setup information.
   - If you don't have Automation Engine, use **File > Export** and choose Normalized PDF as the export format.

2. Select (in Automation Engine) or open (in PackEdge / Acrobat) your document and open the XMP information as explained below:

<table>
<thead>
<tr>
<th>If you have...</th>
<th>go to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation Engine</td>
<td><strong>File &gt; Info</strong>.</td>
</tr>
<tr>
<td>PackEdge</td>
<td><strong>File &gt; XMP Info.</strong></td>
</tr>
<tr>
<td>the Esko XMP plug-in in Adobe Acrobat</td>
<td><strong>Esko &gt; XMP Document Info...</strong></td>
</tr>
</tbody>
</table>
3. Click **Barcodes** in the **Data type** column (as below in PackEdge) to show the barcode information.

For more information, see the Shuttle, Automation Engine, PackEdge or XMP plug-in documentation.

**Editing Barcodes in Other Esko Applications**

The Dynamic Barcodes functionality is available both as a **DeskPack** plug-in and in **PackEdge**.

- To edit your document containing barcodes in **PackEdge**:
  a) Export your Illustrator document to the Esko Normalized PDF format:

  - If you have Automation Engine, use **Shuttle** to launch the document into your chosen workflow. This converts it to Normalized PDF automatically.

  **Note:** See the Adobe Illustrator Client documentation for setup information.

  - If you don't have Automation Engine, use File > Export and choose Normalized PDF as the export format.

  b) Open your document in **PackEdge**.
  c) Go to Production > Bar Code... to edit your barcode as you would edit it with Dynamic Barcodes.

  For more information, see the Shuttle and PackEdge documentation.
5.7 Barcode Types and Parameters

5.7.1 Supported Barcode Types

**General Purpose Barcodes**

<table>
<thead>
<tr>
<th>1D</th>
<th>2D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 39</td>
<td>DataMatrix</td>
</tr>
<tr>
<td>2 of 5</td>
<td>QR</td>
</tr>
<tr>
<td>Interleaved 2 of 5</td>
<td>MicroQR</td>
</tr>
<tr>
<td>Codabar</td>
<td></td>
</tr>
<tr>
<td>Code 128</td>
<td></td>
</tr>
<tr>
<td>Code 128 (long)</td>
<td></td>
</tr>
<tr>
<td>MSI</td>
<td></td>
</tr>
</tbody>
</table>

**Retail Barcodes**

<table>
<thead>
<tr>
<th>1D</th>
<th>2D</th>
</tr>
</thead>
<tbody>
<tr>
<td>EAN 13</td>
<td>GS1 DataMatrix</td>
</tr>
<tr>
<td>EAN 8</td>
<td></td>
</tr>
<tr>
<td>UPC-A</td>
<td></td>
</tr>
<tr>
<td>UPC-E</td>
<td></td>
</tr>
<tr>
<td>GS1 DataBar Omnidirectional</td>
<td></td>
</tr>
<tr>
<td>GS1 DataBar Truncated</td>
<td></td>
</tr>
<tr>
<td>GS1 DataBar Stacked</td>
<td></td>
</tr>
<tr>
<td>GS1 DataBar Stacked Omnidirectional</td>
<td></td>
</tr>
<tr>
<td>GS1 DataBar Limited</td>
<td></td>
</tr>
<tr>
<td>GS1 DataBar Expanded</td>
<td></td>
</tr>
<tr>
<td>GS1 DataBar Expanded Stacked</td>
<td></td>
</tr>
</tbody>
</table>
### 1D
- GS1 128
- GS1 U.S. Coupon Interim
- M+S 7
- Marks & Spencer

### 2D
- Pharmaceutical, Healthcare and Cosmetic Barcodes
  - 1D
    - NDC / HRI
    - EAN 13 Swissmedic
    - Laetus Pharma Code
    - CLF-8
    - HIBC 39
    - HIBC 128
    - Paraf Italy
    - PZN
    - PZN8

- Shipment Container Barcodes
  - 1D
    - ITF-14
    - ITF-16
    - UPC-SCS

- Identity Document Barcode
  - 2D
    - PDF417
    - MicroPDF417
GS1 Application Identifiers

These are the GS1 Application Identifiers available in Dynamic Barcodes:

<table>
<thead>
<tr>
<th>AI</th>
<th>Data Content</th>
<th>Format (*)</th>
<th>FNC1 Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>Serial Shipping Container Code (SSCC)</td>
<td>N2+N18</td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>Global Trade Item Number (GTIN)</td>
<td>N2+N14</td>
<td></td>
</tr>
<tr>
<td>02</td>
<td>GTIN of Contained Trade Items</td>
<td>N2+N14</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Batch or Lot Number</td>
<td>N2+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>11</td>
<td>Production Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Due Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Packaging Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Best Before Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Sell By Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Expiration Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Internal product variant</td>
<td>N2+N2</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Serial Number</td>
<td>N2+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>22</td>
<td>Consumer product variant</td>
<td>N2+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>240</td>
<td>Additional Item Identification</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>241</td>
<td>Customer Part Number</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>242</td>
<td>Made-to-Order Variation Number</td>
<td>N3+N..6</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>243</td>
<td>Packaging Component Number</td>
<td>N3+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>250</td>
<td>Secondary Serial Number</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>251</td>
<td>Reference to Source Entity</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>253</td>
<td>Global Document Type Identifier (GDTI)</td>
<td>N3+N13+X..17</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>254</td>
<td>GLN Extension Component</td>
<td>N3+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>255</td>
<td>Global Coupon Number (GCN)</td>
<td>N3+N13+N..12</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>30</td>
<td>Variable Count of Items (Variable Measure Trade Item)</td>
<td>N2+N..8</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>310n</td>
<td>Net weight, kilograms (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>311n</td>
<td>Length or first dimension, metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>312n</td>
<td>Width, diameter, or second dimension, metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>313n</td>
<td>Depth, thickness, height, or third dimension, metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>314n</td>
<td>Area, square metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>315n</td>
<td>Net volume, litres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>316n</td>
<td>Net volume, cubic metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>320n (***</td>
<td>Net weight, pounds (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>321n (***</td>
<td>Length or first dimension, inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>322n (***</td>
<td>Length or first dimension, feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>323n (***</td>
<td>Length or first dimension, yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>324n (***</td>
<td>Width, diameter, or second dimension, inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>325n (***</td>
<td>Width, diameter, or second dimension, feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>326n (***</td>
<td>Width, diameter, or second dimension, yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>327n (***</td>
<td>Depth, thickness, height, or third dimension, inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>328n (***</td>
<td>Depth, thickness, height, or third dimension, feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>329n (***</td>
<td>Depth, thickness, height, or third dimension, yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>330n (***</td>
<td>Logistic weight, kilograms</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>331n (***</td>
<td>Length or first dimension, metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>332n (***</td>
<td>Width, diameter, or second dimension, metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>333n (***</td>
<td>Depth, thickness, height, or third dimension, metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>334n (***</td>
<td>Area, square metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>335n (***</td>
<td>Logistic volume, litres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>336n (***</td>
<td>Logistic volume, cubic metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>337n (***</td>
<td>Kilograms per square metre</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>340n (***</td>
<td>Logistic weight, pounds</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>341n (***</td>
<td>Length or first dimension, inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>342n (***</td>
<td>Length or first dimension, feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>343n (***</td>
<td>Length or first dimension, yards</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>344n (***</td>
<td>Width, diameter, or second dimension, inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>345n (***</td>
<td>Width, diameter, or second dimension, feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>346n (***</td>
<td>Width, diameter, or second dimension, yard</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>347n (***</td>
<td>Depth, thickness, height, or third dimension, inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>348n (***</td>
<td>Depth, thickness, height, or third dimension, feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>Precedence</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>------------------------------------------------------------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td>349n (***</td>
<td>Depth, thickness, height, or third dimension, yards</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>350n (***</td>
<td>Area, square inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>351n (***</td>
<td>Area, square feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>352n (***</td>
<td>Area, square yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>353n (***</td>
<td>Area, square inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>354n (***</td>
<td>Area, square feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>355n (***</td>
<td>Area, square yards</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>356n (***</td>
<td>Net weight, troy ounces (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
</tbody>
</table>
| 357n (*** | Net weight (or volume), ounces (Variable Measure Trade Item) | N4+N6 |}

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Precedence</th>
</tr>
</thead>
<tbody>
<tr>
<td>358n (***</td>
<td>Net volume, quarts (Variable Measure Trade Item)</td>
<td>N4+N6</td>
</tr>
<tr>
<td>359n (***</td>
<td>Net volume, gallons U.S. (Variable Measure Trade Item)</td>
<td>N4+N6</td>
</tr>
<tr>
<td>360n (***</td>
<td>Logistic volume, quarts</td>
<td>N4+N6</td>
</tr>
<tr>
<td>361n (***</td>
<td>Logistic volume, gallons U.S.</td>
<td>N4+N6</td>
</tr>
<tr>
<td>362n (***</td>
<td>Net volume, cubic inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
</tr>
<tr>
<td>363n (***</td>
<td>Net volume, cubic feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
</tr>
<tr>
<td>364n (***</td>
<td>Net volume, cubic yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
</tr>
<tr>
<td>365n (***</td>
<td>Logistic volume, cubic inches</td>
<td>N4+N6</td>
</tr>
<tr>
<td>366n (***</td>
<td>Logistic volume, cubic feet</td>
<td>N4+N6</td>
</tr>
<tr>
<td>367n (***</td>
<td>Logistic volume, cubic yards</td>
<td>N4+N6</td>
</tr>
<tr>
<td>37</td>
<td>Count of Trade Items</td>
<td>N2+N..8</td>
</tr>
<tr>
<td>390n (***</td>
<td>Applicable Amount Payable or Coupon Value, local currency</td>
<td>N4+N..15</td>
</tr>
<tr>
<td>391n (***</td>
<td>Applicable Amount Payable with ISO Currency Code</td>
<td>N4+N3+N..15</td>
</tr>
<tr>
<td>392n (***</td>
<td>Applicable Amount Payable, single monetary area (Variable Measure Trade Item)</td>
<td>N4+N..15</td>
</tr>
<tr>
<td>393n (***</td>
<td>Applicable Amount Payable with ISO Currency Code (Variable Measure Trade Item)</td>
<td>N4+N3+N..15</td>
</tr>
<tr>
<td>394n (***</td>
<td>Percentage discount of a coupon</td>
<td>N4+N4</td>
</tr>
<tr>
<td>400</td>
<td>Customer’s Purchase Order Number</td>
<td>N3+X..30</td>
</tr>
<tr>
<td>401</td>
<td>Global Identification Number for Consignment (GINC)</td>
<td>N3+X..30</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Format</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>402</td>
<td>Global Shipment Identification Number (GSIN)</td>
<td>N3+N17</td>
</tr>
<tr>
<td>403</td>
<td>Routing Code</td>
<td>N3+X..30</td>
</tr>
<tr>
<td>410</td>
<td>Ship to - Deliver to Global Location Number</td>
<td>N3+N13</td>
</tr>
<tr>
<td>411</td>
<td>Bill to - Invoice to Global Location Number</td>
<td>N3+N13</td>
</tr>
<tr>
<td>412</td>
<td>Purchased from Global Location Number</td>
<td>N3+N13</td>
</tr>
<tr>
<td>413</td>
<td>Ship for - Deliver for - Forward to Global Location Number</td>
<td>N3+N13</td>
</tr>
<tr>
<td>414</td>
<td>Identification of a Physical Location - Global Location Number</td>
<td>N3+N13</td>
</tr>
<tr>
<td>415</td>
<td>Global Location Number of the Invoicing Party</td>
<td>N3+N13</td>
</tr>
<tr>
<td>416</td>
<td>GLN of the production or service location</td>
<td>N3+N13</td>
</tr>
<tr>
<td>420</td>
<td>Ship to - Deliver to Postal Code Within a Single Postal Authority</td>
<td>N3+X..20</td>
</tr>
<tr>
<td>421</td>
<td>Ship to - Deliver to Postal Code with ISO Country Code</td>
<td>N3+N3+X..9</td>
</tr>
<tr>
<td>422</td>
<td>Country of Origin of a Trade Item</td>
<td>N3+N3</td>
</tr>
<tr>
<td>423</td>
<td>Country of Initial Processing</td>
<td>N3+N3+N..12</td>
</tr>
<tr>
<td>424</td>
<td>Country of Processing</td>
<td>N3+N3</td>
</tr>
<tr>
<td>425</td>
<td>Country of Disassembly</td>
<td>N3+N3+N..12</td>
</tr>
<tr>
<td>426</td>
<td>Country Covering full Process Chain</td>
<td>N3+N3</td>
</tr>
<tr>
<td>427</td>
<td>Country Subdivision of Origin</td>
<td>N3+X..3</td>
</tr>
<tr>
<td>7001</td>
<td>NATO Stock Number (NSN)</td>
<td>N4+N13</td>
</tr>
<tr>
<td>7002</td>
<td>UN/ECE Meat Carcasses and Cuts Classification</td>
<td>N4+X..30</td>
</tr>
<tr>
<td>7003</td>
<td>Expiration Date and Time</td>
<td>N4+N10</td>
</tr>
<tr>
<td>7004</td>
<td>Active Potency</td>
<td>N4+N..4</td>
</tr>
<tr>
<td>7005</td>
<td>Catch Area</td>
<td>N4+X..12</td>
</tr>
<tr>
<td>7006</td>
<td>First Freeze Date</td>
<td>N4+N6</td>
</tr>
<tr>
<td>7007</td>
<td>Harvest Date</td>
<td>N4+N6..12</td>
</tr>
<tr>
<td>7008</td>
<td>Species for Fishery Purposes</td>
<td>N4+X..3</td>
</tr>
<tr>
<td>7009</td>
<td>Fishing Gear Type</td>
<td>N4+N..10</td>
</tr>
<tr>
<td>7010</td>
<td>Production Method</td>
<td>N4+X..2</td>
</tr>
<tr>
<td>7020</td>
<td>Refurbishment lot ID</td>
<td>N4+X..20</td>
</tr>
<tr>
<td>7021</td>
<td>Functional status</td>
<td>N4+X..20</td>
</tr>
<tr>
<td>7022</td>
<td>Revision status</td>
<td>N4+X..20</td>
</tr>
<tr>
<td>7023</td>
<td>Global Individual Asset Identifier (GIAI) of an assembly</td>
<td>N4+X..30</td>
</tr>
<tr>
<td>703s</td>
<td>Number of Processor with ISO Country Code</td>
<td>N4+N3+X..27</td>
</tr>
<tr>
<td>710</td>
<td>National Healthcare Reimbursement Number (NHRN) – Germany PZN</td>
<td>N3+X..20</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>Format</td>
</tr>
<tr>
<td>---</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>711</td>
<td>National Healthcare Reimbursement Number (NHRN) – France CIP</td>
<td>N3+X..20</td>
</tr>
<tr>
<td>712</td>
<td>National Healthcare Reimbursement Number (NHRN) – Spain CN</td>
<td>N3+X..20</td>
</tr>
<tr>
<td>713</td>
<td>National Healthcare Reimbursement Number (NHRN) – Brasil DRN</td>
<td>N3+X..20</td>
</tr>
<tr>
<td>8001</td>
<td>Roll Products (Width, Length, Core Diameter, Direction, Splices)</td>
<td>N4+N14</td>
</tr>
<tr>
<td>8002</td>
<td>Cellular Mobile Telephone Identifier</td>
<td>N4+X..20</td>
</tr>
<tr>
<td>8003</td>
<td>Global Returnable Asset Identifier (GRAI)</td>
<td>N4+N14+X..16</td>
</tr>
<tr>
<td>8004</td>
<td>Global Individual Asset Identifier (GIAI)</td>
<td>N4+X..30</td>
</tr>
<tr>
<td>8005</td>
<td>Price Per Unit of Measure</td>
<td>N4+N6</td>
</tr>
<tr>
<td>8006</td>
<td>Identification of the Components of a Trade Item</td>
<td>N4+N14+N2+N2</td>
</tr>
<tr>
<td>8007</td>
<td>International Bank Account Number (IBAN)</td>
<td>N4+X..34</td>
</tr>
<tr>
<td>8008</td>
<td>Date and Time of Production</td>
<td>N4+N8+N..4</td>
</tr>
<tr>
<td>8010</td>
<td>Component / Part Identifier (CPID)</td>
<td>N4 + X..30</td>
</tr>
<tr>
<td>8011</td>
<td>Component / Part Identifier Serial Number (CPID SERIAL)</td>
<td>N4 + N..12</td>
</tr>
<tr>
<td>8012</td>
<td>Software version</td>
<td>N4+X..20</td>
</tr>
<tr>
<td>8017</td>
<td>Global Service Relation Number to identify the relationship between an organisation offering services and the provider of services</td>
<td>N4+N18</td>
</tr>
<tr>
<td>8018</td>
<td>Global Service Relation Number to identify the relationship between an organisation offering services and the recipient of services</td>
<td>N4+N18</td>
</tr>
<tr>
<td>8019</td>
<td>Service Relation Instance Number (SRIN)</td>
<td>N4+N..10</td>
</tr>
<tr>
<td>8020</td>
<td>Payment Slip Reference Number</td>
<td>N4+X..25</td>
</tr>
<tr>
<td>8110</td>
<td>Coupon Code Identification for Use in North America</td>
<td>N4+X..70</td>
</tr>
<tr>
<td>8111</td>
<td>Loyalty points of a coupon</td>
<td>N4+N4</td>
</tr>
<tr>
<td>8112</td>
<td>Paperless coupon code identification for use in North America</td>
<td>N4+X..70</td>
</tr>
<tr>
<td>8200</td>
<td>Extended Packaging URL</td>
<td>N4+X..70</td>
</tr>
<tr>
<td>90</td>
<td>Information Mutually Agreed Between Trading Partners</td>
<td>N2+X..30</td>
</tr>
<tr>
<td>91 to 99</td>
<td>Company Internal Information</td>
<td>N2+X..30</td>
</tr>
</tbody>
</table>

**Notes**

- *: The first position indicates the length (number of digits) of the GS1 Application Identifier. The following value refers to the format of the data content.

The following convention is applied:

<table>
<thead>
<tr>
<th>N</th>
<th>numeric digit</th>
</tr>
</thead>
</table>

161
• **: If only year and month are available, DD must be filled with two zeroes.

• ***: The fourth digit of this GS1 Application Identifier indicates the implied decimal point position. Example:
  • 3100 Net weight in kg without a decimal point
  • 3102 Net weight in kg with two decimal points

• FNC1: All GS1 Application Identifiers indicated with (FNC1) are defined as of variable length and shall be delimited unless this Element String is the last one to be encoded in the symbol. The delimiter shall be a Function 1 Symbol Character in GS1-128 Symbology, GS1 DataBar Expanded Versions and GS1 Composite Symbology and should be a Function 1 Symbol Character in GS1 DataMatrix and GS1 QR Code Symbology.

## 5.7.2 Barcode Types

To create a barcode of a specific type, select it in the **Barcode Type** parameter. This displays parameters specific to this barcode type in the **Dynamic Barcodes** dialog.

### 2 of 5

**About this Barcode...**

2 of 5 is a numeric self-checking barcode, which can have a variable length. This barcode only encodes data in the bars. It is used for industrial applications, article numbering, photo development and ticketing.

![Barcode Image]

**Parameters**

**General Parameters**

• **Rotation** on page 201

• **Code** on page 201

**Text Parameters**

• **Add Human Readable Characters** on page 202

• **Font Family, Style and Size** on page 204

• **Alignment** on page 204

• **Vertical Offset** on page 204
Additional Parameters

- Bar Width Reduction on page 205
- Device Compensation on page 205
- Height on page 206
- Characters per unit on page 206
- Ratio on page 208
- Narrow Bar on page 208
- Box on page 212

CLF-8

About this Barcode...
The CLF-8 barcode is part of the same barcode family as the Laetus Pharma Code. It is used in the pharmaceutical industry.

Parameters

General Parameters

- Rotation on page 201
- Code on page 201

Text Parameters

- Add Human Readable Characters on page 202
- Font Family, Style and Size on page 204
- Alignment on page 204
- Vertical Offset on page 204

Additional Parameters

- Bar Width Reduction on page 205
- Device Compensation on page 205
- Height on page 206
- Ratio on page 208
- Narrow Bar on page 208
- Wide Bar on page 208
- Gap on page 208
Codabar

About this Barcode...
The Codabar barcode is commonly used in libraries, blood banks, and the air parcel business. It can encode up to 126 characters of data and two control characters, using digits and the ",", "$", ":", "/" and "+" characters.

Parameters
General Parameters
- Rotation on page 201
- Code on page 201

Text Parameters
- Add Human Readable Characters on page 202
- Font Family, Style and Size on page 204
- Alignment on page 204
- Vertical Offset on page 204

Additional Parameters
- Rational (Constant Bar Width): By enabling this option, you can create a "Rational" Codabar bar code.
- Use "992" Prod. Family in UPC on page 204
- Bar Width Reduction on page 205
- Device Compensation on page 205
- Height on page 206
- Characters per unit on page 206
- Ratio on page 208
- Narrow Bar on page 208
- Box on page 212

Code 128

About this Barcode...
Code 128 is a variable length, high density, alphanumeric barcode. It has the second highest density of all the 1D barcodes (after the GS1 Databar Expanded).
It can contain a set of control characters. These control characters can change the character encoding type. In the absence of control characters, the encoding type is chosen automatically, to optimize the content encoding.

To force the usage of the code-set A, precede your data with the \[a\] control character. To force the usage of the code-set B, precede your data with the \[b\] control character. To obtain an optimal utilization of the code-sets A and B but prevent the usage of the space saving code-set C, use the Code 128 (long) barcode type instead.

### Parameters

**General Parameters**
- Rotation on page 201
- Code on page 201

**Text Parameters**
- Add Human Readable Characters on page 202
- Light Margin Indicator on page 203
- Font Family, Style and Size on page 204
- Alignment on page 204
- Vertical Offset on page 204

**Additional Parameters**
- Bar Width Reduction on page 205
- Device Compensation on page 205
- Height on page 206
- Characters per unit on page 206
- Narrow Bar on page 208
- Box on page 212

### Code 128 (long)

**About this Barcode...**
Code 128 (long) is a version of Code 128 that doesn't use the space-saving “C” character set. This makes Code 128 (long) barcodes generally longer.
Parameters

General Parameters

- *Rotation* on page 201
- *Code* on page 201

Text Parameters

- *Add Human Readable Characters* on page 202
- *Light Margin Indicator* on page 203
- *Font Family, Style and Size* on page 204
- *Alignment* on page 204
- *Vertical Offset* on page 204

Additional Parameters

- *Bar Width Reduction* on page 205
- *Device Compensation* on page 205
- *Height* on page 206
- *Characters per unit* on page 206
- *Narrow Bar* on page 208
- *Box* on page 212

Code 39

About this Barcode...

Code 39 is a popular barcode in industrial barcoding systems, mainly in the U.S.A. It is used in the non-retail industry, particularly in the manufacturing, military, and health sectors. It can encode alphanumeric data.
DataMatrix

About this Barcode...
DataMatrix is used for encoding large amounts of alphanumeric data and / or marking small objects. It can encode all the standard ASCII and extended ASCII characters.

The DataMatrix symbol size can adjust automatically depending on the amount of data.

Dynamic Barcodes doesn't generate human readable characters for DataMatrix symbols. The data to be encoded in a DataMatrix symbol can contain an FNC1 character but only at the beginning of the data.

Note: Dynamic Barcodes always generates DataMatrix symbols with the recommended ECC200 error correction scheme.
EAN 8

About this Barcode...
EAN 8 is an abbreviated version of EAN 13, for use on smaller packages. It contains eight digits of data.

Parameters

General Parameters
• Rotation on page 201
• Code on page 201

Text Parameters
• Add Human Readable Characters on page 202
• Light Margin Indicator on page 203
• Font Family, Style and Size on page 204
• Vertical Offset on page 204

Additional Parameters
• Bar Width Reduction on page 205
• Device Compensation on page 205
• Magnification on page 205
• Height on page 206
• Snap Bars to Output Resolution on page 209
• Box on page 212
EAN 13

About this Barcode...
European Article Numbering system or EAN is the standard for article numbering in Europe. It is also used in Japan where it is called JAN.

Note: EAN is the European equivalent of the UPC system in the U.S.A. and Canada. Both systems use the same size requirements and a similar encoding scheme. This means that most European and American retail barcode scanners can read both EAN and UPC barcodes. For more information on UPC, see **UPC-A** on page 198.

An EAN 13 is a numeric barcode of thirteen digits, and can have two or five additional digits.

Parameters

**General Parameters**

- *Rotation* on page 201
- *Code* on page 201

**Text Parameters**

- *Add Human Readable Characters* on page 202
- *Light Margin Indicator* on page 203
- *Font Family, Style and Size* on page 204
- *Vertical Offset* on page 204

**Additional Parameters**

- *Bar Width Reduction* on page 205
- *Device Compensation* on page 205
- *Magnification* on page 205
EAN 13 Swissmedic

About this Barcode...
EAN 13 Swissmedic is an EAN 13 barcode used for items licensed by the Swiss Agency for Therapeutic Products.
It always starts with "7680", uses a specific text positioning and adds the text "swissmedic" below the code.
For EAN 13 Swissmedic barcodes, only the default font settings can be used.

Parameters

General Parameters
- Rotation on page 201
- Code on page 201

Additional Parameters
- Bar Width Reduction on page 205
- Device Compensation on page 205
- Magnification on page 205
- Height on page 206
- Snap Bars to Output Resolution on page 209
- Box on page 212

GS1 128

About this Barcode...
GS1 128 (formerly EAN 128) is a Code 128 barcode designed primarily to identify products.
Dynamic Content Advanced

It contains one or more FNC1 (GS1 Function Code 1) control characters and Application Identifiers. It shows parentheses around the human readable interpretation of the Application Identifiers, but those parentheses are not encoded in the barcode.

It is alphanumeric and can also contain composite symbols.

Parameters

General Parameters
- Rotation on page 201
- Code on page 201
- Composite Component on page 202

Text Parameters
- Add Human Readable Characters on page 202
- Put on Top on page 203
- Multiple Text Lines on page 203
- Font Family, Style and Size on page 204
- Alignment on page 204
- Vertical Offset on page 204

Additional Parameters
- Bar Width Reduction on page 205
- Device Compensation on page 205
- Magnification on page 205
- Height on page 206
- Narrow Bar on page 208
GS1 DataBar Omnidirectional

About this Barcode...
Barcodes of the GS1 DataBar family (formerly Reduced Space Symbols or RSS) can identify small items, and encode more information than the current EAN or UPC barcodes. They can include GS1 Application Identifiers such as serial numbers, lot numbers, expiration dates...

Note: GS1 DataBar codes are expected to replace most common EAN and UPC barcodes from 2010.

GS1 DataBar Omnidirectional encodes Global Trade Item Numbers (GTIN) in a linear symbol that can be scanned omnidirectionally by suitably programmed slot scanners.

Parameters

General Parameters
- Rotation on page 201
- Code on page 201
- Composite Component on page 202

Text Parameters
- Add Human Readable Characters on page 202
- Put on Top on page 203
- Multiple Text Lines on page 203
- Font Family, Style and Size on page 204
- Alignment on page 204
- Vertical Offset on page 204

Additional Parameters
- Bar Width Reduction on page 205
- Device Compensation on page 205
GS1 DataBar Stacked

About this Barcode...

GS1 DataBar Stacked is a variation of the GS1 DataBar barcode, that is stacked in two rows and used when the normal barcode would be too wide for the product.

Parameters

General Parameters

- Rotation on page 201
- Code on page 201
- Composite Component on page 202

Text Parameters

- Add Human Readable Characters on page 202
- Multiple Text Lines on page 203
- Font Family, Style and Size on page 204
- Alignment on page 204
- Vertical Offset on page 204

Additional Parameters

- Bar Width Reduction on page 205
- Device Compensation on page 205
- Narrow Bar on page 208
- Snap Bars to Output Resolution on page 209

GS1 DataBar Stacked Omnidirectional

About this Barcode...

GS1 DataBar14 Stacked Omnidirectional is taller version of GS1 DataBar14 Stacked, that can be read by omnidirectional scanners.
Parameters

General Parameters
- Rotation on page 201
- Code on page 201
- Composite Component on page 202

Text Parameters
- Add Human Readable Characters on page 202
- Put on Top on page 203
- Multiple Text Lines on page 203
- Font Family, Style and Size on page 204
- Alignment on page 204
- Vertical Offset on page 204

Additional Parameters
- Bar Width Reduction on page 205
- Device Compensation on page 205
- Narrow Bar on page 208
- Snap Bars to Output Resolution on page 209

GS1 DataBar Truncated

About this Barcode...

GS1 DataBar Truncated (formerly RSS Limited) is similar to GS1 DataBar but the height of its bars is truncated.

It encodes Global Trade Item Numbers in a smaller symbol for use on small items. It cannot be scanned omnidirectionally.
Parameters

General Parameters
- Rotation on page 201
- Code on page 201
- Composite Component on page 202

Text Parameters
- Add Human Readable Characters on page 202
- Put on Top on page 203
- Multiple Text Lines on page 203
- Font Family, Style and Size on page 204
- Alignment on page 204
- Vertical Offset on page 204

Additional Parameters
- Bar Width Reduction on page 205
- Device Compensation on page 205
- Narrow Bar on page 208
- Snap Bars to Output Resolution on page 209

GS1 DataBar Expanded

About this Barcode...
GS1 DataBar Expanded (formerly RSS Expanded) encodes regular barcode data ("primary item identification" data) and Application Identifiers. It can encode alphanumeric characters. This barcode can be scanned omnidirectionally by suitably programmed slot scanners.

Parameters

General Parameters
- Rotation on page 201
- Code on page 201
- Composite Component on page 202

Text Parameters
• Add Human Readable Characters on page 202
• Put on Top on page 203
• Multiple Text Lines on page 203
• Font Family, Style and Size on page 204
• Alignment on page 204
• Vertical Offset on page 204

Additional Parameters
• Bar Width Reduction on page 205
• Device Compensation on page 205
• Narrow Bar on page 208
• Snap Bars to Output Resolution on page 209

GS1 DataBar Expanded Stacked

About this Barcode...
GS1 DataBar Expanded Stacked can encode the same amount of data as GS1 DataBar Expanded, but can also “stack” the barcode into several rows to save space.
GS1 DataBar Limited

About this Barcode...

GS1 Databar Limited is smaller than the GS1 DataBar barcode and can only encode Global Trade Item Numbers whose data part starts with “1”.

Parameters

General Parameters
• Rotation on page 201
• Code on page 201
• Composite Component on page 202

Text Parameters
• Add Human Readable Characters on page 202
• Put on Top on page 203
• Multiple Text Lines on page 203
• Font Family, Style and Size on page 204
• Alignment on page 204
• Vertical Offset on page 204

Additional Parameters
• Bar Width Reduction on page 205
• Device Compensation on page 205
• Narrow Bar on page 208
GS1 DataMatrix

About this Barcode...
The GS1 Data Matrix barcode is a high density, high capacity, scalable 2D barcode. It is used to concentrate a lot of (alphanumeric) information in a very small space.

Parameters

General Parameters
- Rotation on page 201
- Code on page 201

Text Parameters
- Add Human Readable Characters on page 202
- Put on Top on page 203
- Multiple Text Lines on page 203
- Light Margin Indicator on page 203
- Font Family, Style and Size on page 204
- Alignment on page 204
- Vertical Offset on page 204

Additional Parameters
- Bar Width Reduction on page 205
- Device Compensation on page 205
- Symbol Type on page 210
- Cell Size on page 210
- Width / Total Height on page 211
- Box on page 212

GS1 QR

About this Barcode...
The GS1 QR barcode is a high density, high capacity, scalable 2D barcode. It is used to assembly multiple GS1 Application Identifiers to a barcode with limited space needs. The GS1 QR
Dynamic Content Advanced

barcode can contain numbers, 0 - 9, upper case letters A-Z, and nine special characters: space, $ % * + - . /

For more technical information on the QR code, see QR on page 194

Parameters

General Parameters

• Rotation on page 201
• Code on page 201

Text Parameters

• Add Human Readable Characters on page 202
• Put on Top on page 203
• Multiple Text Lines on page 203
• Light Margin Indicator on page 203
• Font Family, Style and Size on page 204
• Alignment on page 204
• Vertical Offset on page 204

Additional Parameters

• Bar Width Reduction on page 205
• Device Compensation on page 205
• Symbol Type on page 210
• Cell Size on page 210
• Width / Total Height on page 211
• Box on page 212

Specific Parameters

Minimum Symbol Size

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note: If the number of cells you choose for your symbol is too small to encode the data you entered in Code, Dynamic Barcodes will use a bigger symbol size automatically.

Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.
• Level M: 15% of codewords can be restored.
• Level **Q**: 25% of codewords can be restored.
• Level **H**: 30% of codewords can be restored.

**Note:** Keep in mind that a higher correction level makes the barcode bigger (as more check sums are added to the barcode) and may limit the maximum length of the encoded data.

**Width / Height**

The **Width** and **Height** parameters depend on the **Cell Size** and the number of cells used for the symbol (**Minimum Symbol Size**).

For example, a symbol of 25 x 25 cells where each cell is 2 mm gives a Width and Height of 50 x 50 mm.

**GS1 U.S. Coupon Interim**

**About this Barcode...**

GS1 U.S. Coupon Interim is an interim coupon barcode. It is used during the transition between UPC-A coupons and the new GS1 Databar Expanded Stacked coupons, that can encode more information.

It is made of both an old UPC-A coupon barcode, and a new Databar Expanded Stacked coupon barcode, to be readable by both old and new scanners.

**Parameters**

**General Parameters**

• **Rotation** on page 201
• **Code** on page 201

**Text Parameters**

• **Add Human Readable Characters** on page 202
• **Font Family, Style and Size** on page 204

**Additional Parameters**

• **Use “992” Prod. Family in UPC** on page 204
• **Max. Row Width** on page 204
• **Bar Width Reduction** on page 205
• **Device Compensation** on page 205
HIBC 128

About this Barcode...
This barcode is based on the Code 128 symbology. It encodes the organization's primary and/or secondary Labeler Identification Code (LIC). This encoding begins with the “+” character. If both primary and secondary Labeler Identification Codes are encoded in one barcode, they are divided by the “/” character.

Parameters
General Parameters
• Rotation on page 201
• Code on page 201

Text Parameters
• Add Human Readable Characters on page 202
• Font Family, Style and Size on page 204
• Vertical Offset on page 204

Additional Parameters
• Bar Width Reduction on page 205
• Device Compensation on page 205
• Magnification on page 205
• Height on page 206
• Snap Bars to Output Resolution on page 209
• Box on page 212

HIBC 39

About this Barcode...
This barcode is based on the Code 39 symbology.
It encodes the organization's primary and/or secondary Labeler Identification Code (LIC). This encoding begins with the “+” character. If both primary and secondary Labeler Identification Codes are encoded in one barcode, they are divided by the “/” character.

**Parameters**

**General Parameters**
- Rotation on page 201
- Code on page 201

**Text Parameters**
- Add Human Readable Characters on page 202
- Font Family, Style and Size on page 204
- Vertical Offset on page 204

**Additional Parameters**
- Bar Width Reduction on page 205
- Device Compensation on page 205
- Magnification on page 205
- Height on page 206
- Snap Bars to Output Resolution on page 209
- Box on page 212

**ITF-14**

**About this Barcode...**
ITF-14 is a standardized version of the Interleaved 2 of 5 barcode, containing 14 digits, the last being a check digit.
Dynamic Content Advanced

- *Rotation* on page 201
- *Code* on page 201

**Text Parameters**
- *Add Human Readable Characters* on page 202
- *Font Family, Style and Size* on page 204
- *Vertical Offset* on page 204

**Additional Parameters**
- *Text Format* on page 205
- *Bar Width Reduction* on page 205
- *Device Compensation* on page 205
- *Magnification* on page 205
- *Height* on page 206
- *Snap Bars to Output Resolution* on page 209
- *Total Height* on page 211
- *Smax / Smin* on page 211
- *Box* on page 212

**ITF-16**

**About this Barcode...**

ITF-16 is a standardized version of the Interleaved 2 of 5 barcode, containing 16 digits, the last being a check digit.

---

**Parameters**

**General Parameters**
- *Rotation* on page 201
- *Code* on page 201
**Text Parameters**

- *Add Human Readable Characters* on page 202
- *Font Family, Style and Size* on page 204
- *Vertical Offset* on page 204

**Additional Parameters**

- *Text Format* on page 205
- *Bar Width Reduction* on page 205
- *Device Compensation* on page 205
- *Magnification* on page 205
- *Height* on page 206
- *Snap Bars to Output Resolution* on page 209
- *Total Height* on page 211
- *Smax / Smin* on page 211
- *Box* on page 212

**Interleaved 2 of 5**

**About this Barcode...**

Interleaved 2 of 5 (or Int. 2 of 5) is a barcode originally used for transportation packaging, that can have any even number of digits. Since this type of packaging consists mainly of cardboard boxes printed in low quality, the Interleaved 2 of 5 barcode is more tolerant to distortion than other barcodes.
• **Vertical Offset** on page 204

**Additional Parameters**

• **Bar Width Reduction** on page 205
• **Device Compensation** on page 205
• **Height** on page 206
• **Characters per unit** on page 206
• **Ratio** on page 208
• **Narrow Bar** on page 208
• **Box** on page 212

**Laetus Pharma Code**

**About this Barcode...**

This barcode was developed specifically to meet the requirements of the pharmaceutical packaging process. It has established itself as the worldwide pharmaceutical industry barcode standard. It can encode numeric or binary data.

---

**Parameters**

Laetus Pharma

**General Parameters**

• **Rotation** on page 201
• **Code** on page 201

**Text Parameters**

• **Add Human Readable Characters** on page 202
• **Font Family, Style and Size** on page 204
• **Alignment** on page 204
• **Vertical Offset** on page 204

**Additional Parameters**

• **Miniature**: Use this option to create a miniature version of the bar code
• **Bar Width Reduction** on page 205
• **Device Compensation** on page 205
• **Height** on page 206
Dynamic Content Advanced

- **Ratio** on page 208
- **Narrow Bar** on page 208
- **Wide Bar** on page 208
- **Gap** on page 208
- **Decimal Input** on page 209
- **Box** on page 212

M+S 7

**About this Barcode...**

The M+S 7 barcode is an EAN 8 barcode modified by Marks & Spencer’s, for use on own-brand products sold in their stores.

To make the M+S 7 barcode, the initial “0” is removed and the extra letters “M” and “S” are added to the human readable characters.

This means that the human readable characters contain seven digits plus the “M” and “S” letters.

**Note:** This doesn't affect the data encoded in the barcode (it still encodes eight digits), so you should enter eight digits when creating a M+S 7 barcode.

---

**Parameters**

**General Parameters**
- **Rotation** on page 201
- **Code** on page 201

**Text Parameters**
- **Add Human Readable Characters** on page 202
- **Font Family, Style and Size** on page 204
- **Vertical Offset** on page 204

**Additional Parameters**
MSI

About this Barcode...
MSI, also known as Modified Plessey, was developed by the MSI Data Corporation, based on the original Plessey Code. It is a numeric barcode used primarily to mark retail shelves for inventory control.

Parameters

General Parameters
• Rotation on page 201
• Code on page 201

Text Parameters
• Add Human Readable Characters on page 202
• Font Family, Style and Size on page 204
• Alignment on page 204
• Vertical Offset on page 204

Additional Parameters
• Bar Width Reduction on page 205
• Device Compensation on page 205
• Height on page 206
• Characters per unit on page 206
• Ratio on page 208
• Narrow Bar on page 208
• Box on page 212

Marks & Spencer's

About this Barcode...
The Marks & Spencer's barcode is also an EAN 8 barcode modified by Marks & Spencer's for use on own-brand products.

Parameters

General Parameters
• Rotation on page 201
• Code on page 201

Text Parameters
• Add Human Readable Characters on page 202
• Font Family, Style and Size on page 204
• Vertical Offset on page 204

Additional Parameters
• Bar Width Reduction on page 205
• Device Compensation on page 205
• Magnification on page 205
• Height on page 206
• Snap Bars to Output Resolution on page 209
• Box on page 212

NDC / HRI

About this Barcode...
The NDC / HRI barcode is a variant of the UPC barcode with special human readable interpretation formats compliant to the US National Drug Code definition.
Parameters

General Parameters
• Rotation on page 201
• Code on page 201

Text Parameters
• Add Human Readable Characters on page 202
• Font Family, Style and Size on page 204
• Vertical Offset on page 204

Additional Parameters
• Text Format on page 205
• Bar Width Reduction on page 205
• Device Compensation on page 205
• Magnification on page 205
• Height on page 206
• Snap Bars to Output Resolution on page 209
• Box on page 212

Paraf Italy

About this Barcode...
This barcode is a variant of Code 39 used by the Italian Health and Cosmetics Industry. It is also called Code 32.
Use **Code Base32** when your barcode data is encoded in the Base 32 format. This format uses case-insensitive alphanumeric characters to encode data.

Use **Code Base10** when your barcode data is in decimal format. Paraf Italy barcodes in decimal format should start with an "A" (included automatically by Dynamic Barcodes), have 8 digits of data and end with a check digit (calculated automatically by Dynamic Barcodes).

**Parameters**

**General Parameters**
- Rotation on page 201
- Code on page 201

**Additional Parameters**
- Bar Width Reduction on page 205
- Device Compensation on page 205
- Height on page 206
- Narrow Bar on page 208
- Box on page 212

**PDF417**

**About this Barcode...**

PDF417 is a 2D barcode mainly used in security printing (passports, identity cards, driving licences...).

It is a “self-checking” barcode that can have different levels of error correction.

It can encode data using one of three “compaction” modes: Text (to encode all alphanumeric and punctuation characters in the ISO-8859-1 character set), Numeric (to encode only numeric characters) or Binary (to encode 8-bit characters).

It can use the three compaction modes in a single barcode if necessary, but you can choose to disable the Text and/or Numeric compaction modes.

![PDF417 Barcode Example](image-url)
Dynamic Content Advanced

- **Height** on page 206
- **Narrow Bar** on page 208
- **Box** on page 212

### Specific Parameters

#### Columns
You can give your barcode between 1 and 30 Columns. The number of columns corresponds to the number of PDF417 codewords.

#### Rows
You can give your barcode between 3 and 90 Rows.

#### Truncated
Choose Truncated to make the symbol less wide by truncating the end character (which is not part of the encoded data) and the end pattern. In the example below, the top PDF417 barcode is not truncated, and the bottom barcode is truncated (but encodes the same data).

```
[Image: truncated_barcode.png]
```

#### Initialize in Alpha Submode
Choose this option to generate a “shift to Text mode” character at the beginning of the barcode when using Text compaction mode. This makes the encoding clear for barcode scanners.

#### Allow Text Compaction
Choose this to let Dynamic Barcodes switch to Text compaction mode automatically when your barcode contains text data.

This encodes the text data in your barcode more efficiently (it makes that part of your barcode smaller).

#### Allow Numeric Compaction
Choose this to let Dynamic Barcodes switch to Numeric compaction mode automatically when your barcode contains numeric data.

This encodes the numeric data in your barcode more efficiently.

### Note:
Dynamic Barcodes can always switch to the Binary compaction mode if your barcode contains binary data.

If you don’t enable either Allow Text Compaction or Allow Numeric Compaction, Dynamic Barcodes will only use Binary compaction mode.

#### Error Correction Level
Error correction adds check sums to the barcode to detect and correct incorrect data. You can choose an **Error correction level** from 0 to 8.
The higher the correction level, the more check sums are added to the barcode and the more incorrect data can be corrected. Keep in mind that a higher correction level makes the barcode bigger and may limit the maximum length of the encoded data.

**Note:** Level 0 means that there is only one check sum added to the data, so incorrect data can be detected but not corrected.

You can choose **Automatic** to let the plug-in pick the best error correction level for the data encoded.

**MicroPDF417**

**About this Barcode...**

MicroPDF417 is a 2D multi-row barcode derived from PDF417, for use on smaller areas. It can encode up to 150 bytes.

**Parameters**

**General Parameters**
- *Rotation* on page 201
- *Code* on page 201

**Additional Parameters**
- *Bar Width Reduction* on page 205
- *Device Compensation* on page 205
- *Height* on page 206
- *Narrow Bar* on page 208
- *Snap Bars to Output Resolution* on page 209
- *Box* on page 212

**Specific Parameters**

**Columns**
You can give your barcode between 1 and 4 **Columns**.

**Rows**
You can give your barcode between 4 and 44 **Rows**.

**Allow Text Compaction**
Choose this to let Dynamic Barcodes switch to Text compaction mode automatically when your barcode contains text data.

This encodes the text data in your barcode more efficiently (it makes that part of your barcode smaller).

**Allow Numeric Compaction**
Choose this to let Dynamic Barcodes switch to Numeric compaction mode automatically when your barcode contains numeric data.
This encodes the numeric data in your barcode more efficiently.

**Note:**
Dynamic Barcodes can always switch to the Binary compaction mode if your barcode contains binary data.
If you don't enable either **Allow Text Compaction** or **Allow Numeric Compaction**, Dynamic Barcodes will only use Binary compaction mode.

**PZN**

**About this Barcode...**
The PZN (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and healthcare products in Germany. The PZN code is written in the format “PZN-nnnnnnn” but only the numeric part including the leading dash is encoded.

**Parameters**

**General Parameters**
- *Rotation* on page 201
- *Code* on page 201

**Text Parameters**
- *Add Human Readable Characters* on page 202
- *Font Family, Style and Size* on page 204
- *Alignment* on page 204
- *Vertical Offset* on page 204

**Additional Parameters**
- *Bar Width Reduction* on page 205
- *Device Compensation* on page 205
- *Size* on page 206
- *Height* on page 206
- *Characters per unit* on page 206
- *Ratio* on page 208
PZN8

About this Barcode...
The PZN8 (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and healthcare products in Germany. The PZN code is written in the format “PZN-nnnnnnnn” but only the numeric part including the leading dash is encoded.

Parameters

General Parameters
- Rotation on page 201
- Code on page 201

Text Parameters
- Add Human Readable Characters on page 202
- Font Family, Style and Size on page 204
- Alignment on page 204
- Vertical Offset on page 204

Additional Parameters
- Bar Width Reduction on page 205
- Device Compensation on page 205
- Size on page 206
- Height on page 206
- Characters per unit on page 206
- Ratio on page 208
- Narrow Bar on page 208
- Box on page 212

QR

About this Barcode...
The QR barcode is a 2-dimensional barcode used for commercial tracking and convenience-oriented applications aimed at mobile phone users (known as "mobile tagging").
QR codes storing addresses and URLs may appear in magazines, on signs, buses, business cards, or other objects... Users with a camera phone equipped with the correct reader application can scan the QR code to display text, contact information, connect to a wireless network, or open a web page in the phone’s browser.

QR codes have the following structure:

- Position pattern (required)
- Alignment pattern (required)
- Timing pattern (required)
- Version information
- Format information
- Data and error correction keys

**Parameters**

**General Parameters**

- *Rotation* on page 201
- *Code* on page 201

**Additional Parameters**

- *Bar Width Reduction* on page 205
- *Device Compensation* on page 205
- *Cell Size* on page 210
- *Width / Total Height* on page 211
- *Box* on page 212
Specific Parameters

Minimum Symbol Size
Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note: If the number of cells you choose for your symbol is too small to encode the data you entered in Code, Dynamic Barcodes will use a bigger symbol size automatically.

Error Correction
Error correction adds check sums to the barcode to detect and correct incorrect data. You can choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.
• Level M: 15% of codewords can be restored.
• Level Q: 25% of codewords can be restored.
• Level H: 30% of codewords can be restored.

Note: Keep in mind that a higher correction level makes the barcode bigger (as more check sums are added to the barcode) and may limit the maximum length of the encoded data.

Width / Height
The Width and Height parameters depend on the Cell Size and the number of cells used for the symbol (Minimum Symbol Size).

For example, a symbol of 25 x 25 cells where each cell is 2 mm gives a Width and Height of 50 x 50 mm.

MicroQR

About this Barcode...
The Micro QR Code is a very small QR Code for use on smaller spaces (for example to encode the ID of printed circuit boards and electronics parts).

It works with smaller amounts of data (maximum 35 numeric characters), and uses only one position pattern.

Parameters

General Parameters
• Rotation on page 201
• Code on page 201

Additional Parameters
• Bar Width Reduction on page 205
• Device Compensation on page 205
• **Cell Size** on page 210
• **Width / Total Height** on page 211
• **Box** on page 212

**Specific Parameters**

**Minimum Symbol Size**

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

**Note:** If the number of cells you choose for your symbol is too small to encode the data you entered in **Code**, Dynamic Barcodes will use a bigger symbol size automatically.

**Error Correction**

Error correction adds check sums to the barcode to detect and correct incorrect data. You can choose one of the following **Error correction** levels:

- **Level L**: 7% of codewords can be restored.
- **Level M**: 15% of codewords can be restored.
- **Level Q**: 25% of codewords can be restored.
- **Level H**: 30% of codewords can be restored.

**Note:** Keep in mind that a higher correction level makes the barcode bigger (as more check sums are added to the barcode) and may limit the maximum length of the encoded data.

**Width / Height**

The **Width** and **Height** parameters depend on the **Cell Size** and the number of cells used for the symbol (**Minimum Symbol Size**).

For example, a symbol of 15 x 15 cells where each cell is 2 mm gives a Width and Height of 30 x 30 mm.

**SICK Code**

**About this Barcode...**

SICK is a bar code used in the German packaging industry. It's a binary bar code, using a thick bar for a 0, and a thin bar for a 1. It can have up to 12 bars. It can encode numeric or binary data.

- In binary mode all digits are encoded including leading zeroes, ie. "0001" is encoded as a three thin and one thick bar.
- In decimal mode you can define the number of bars in total, by enter e.g. "6/4". The first number (6) defines the total number of bars, the second (4) defines the value to be encoded. If you don't define the number of bars, in other words if you enter a single number, the minimal number of bars needed for the value is used, and the code is adjusted accordingly. If you for example enter "9", the value will change to "4/9", as you need at least 4 bars to encode this value.
- The defaults follow the mostly used standard "Codetype A", for generating the "Codetype B" should be changed the barcode parameters as following: Narrow Bar to 1.25mm (from 0.5mm), Wide Bar to 3.75mm (from 1.5mm) and Gap to 2.5mm (from 1mm)
By default, the values for the Narrow Bar (0.5mm), Wide Bar (1.5mm) and Gap (1mm) are set for the mostly used standard “Codetype A”. If you want to generate a SICK code using "Codetype B", you should set the Narrow Bar to 1.25mm, the Wide Bar to 3.75mm and the Gap to 2.5mm.

**Parameters**

**General Parameters**
- Rotation on page 201
- Code on page 201

**Text Parameters**
- Add Human Readable Characters on page 202
- Font Family, Style and Size on page 204
- Alignment on page 204
- Vertical Offset on page 204

**Additional Parameters**
- Bar Width Reduction on page 205
- Device Compensation on page 205
- Height on page 206
- Ratio on page 208
- Narrow Bar on page 208
- Wide Bar on page 208
- Gap on page 208
- Decimal Input on page 209
- Box on page 212

**UPC-A**

**About this Barcode...**
Universal Product Code or UPC is the standard for article numbering in the U.S.A. and Canada. It is similar to the EAN system and compatible with it. For more information on EAN, see EAN 13 on page 169.
UPC-A is a numeric barcode of up to twelve digits, plus two or five additional digits.

**Parameters**

**General Parameters**
- *Rotation* on page 201
- *Code* on page 201

**Text Parameters**
- *Add Human Readable Characters* on page 202
- *Font Family, Style and Size* on page 204
- *Vertical Offset* on page 204

**Additional Parameters**
- *Bar Width Reduction* on page 205
- *Device Compensation* on page 205
- *Magnification* on page 205
- *Height* on page 206
- *Snap Bars to Output Resolution* on page 209
- *Box* on page 212

**UPC-E**

**About this Barcode...**

UPC-E is an abbreviated version of UPC-A, for use on smaller packages. It is a numeric barcode of eight digits, with an optional 2 or 5 digits add-on. You can also directly enter the 12-digit code of UPC-A codes that can be represented in 8 digits.
Parameters

General Parameters

• Rotation on page 201
• Code on page 201

Text Parameters

• Add Human Readable Characters on page 202
• Font Family, Style and Size on page 204
• Vertical Offset on page 204

Additional Parameters

• Bar Width Reduction on page 205
• Device Compensation on page 205
• Magnification on page 205
• Height on page 206
• Snap Bars to Output Resolution on page 209
• Box on page 212

UPC-SCS

About this Barcode...

The UPC–SCS (Shipping Container Symbol) barcode is a version of the Interleaved 2 of 5 barcode that has a structure very similar to the Universal Product Code's (UPC) and specific formatting of the human readable interpretation.
5.7.3 Barcode Parameters

Rotation
To rotate your barcode by 90, 180 or 270 degrees, use the Rotation buttons.

To rotate it by any other angle, enter that angle in the Rotation field.

Code
Enter the data to encode in your bar code.
Dynamic Barcodes checks that the data you have entered is valid for your chosen Barcode Type. If it isn't, a warning / error will pop up.

Code for GS1 Bar Codes
When entering data to be encoded in GS1 bar codes, you can either enter Application Identifiers (AI) including the brackets, or you can enter the code without brackets, using FNC1 code at the end of each variable-length element in the data. While entering GS1 data, following remarks should be taken into account:

• Do not add the mandatory FNC1 character at the beginning of the data. Dynamic Barcodes will add it automatically.
• For GS1 bar codes intended for encoding AI (01) only, AI has to be omitted, i.e. don't enter '01' at the beginning. It doesn't matter if entered with or without brackets.

• The Composite Component can be created using the same rules for using brackets and [F1]. It's not necessary to keep the same way of entering the Composite Component and the main code.

• If you don't use brackets for entering AI, type [F1] at the end of each variable-length element in the data, to represent a FNC1 terminating character, except when the variable-length element is placed at the end of the whole code.

• You don't need to type [F1] at the end of fixed-length elements.

• Do not mix using [F1] as terminators of variable AI and entering brackets around the AI.

Dynamic Barcodes also checks the validity of the Application Identifiers you enter in the Code and / or in the Composite Component of GS1 bar codes.

Composite Component

A Composite Component is a 2D symbol placed on top of a GS1 barcode, that encodes extra information (batch number, expiration date...).

If you want your barcode to have a Composite Component, enter the (alphanumeric) data to encode in this field.

**Note:** Dynamic Barcodes checks the data you enter for the Composite Component (for example to see if the Application Identifiers you entered are correct), and displays a warning if it is invalid.

Add Human Readable Characters

This parameter adds “human readable” characters (numeric or alphanumeric characters) under your barcode.

This is the same barcode with and without human readable characters:
Put on Top
This parameter allows you to put the Human Readable Characters above instead of below the barcode bars.

Multiple Text Lines
Select this parameter if you want the human readable characters to be printed on multiple lines below the barcode. Dynamic Barcodes will start a new line for every element of the barcode data (starting with the Application Identifier).

Note: When opening your document in PackEdge, the characters will be placed back on a single line.

Light Margin Indicator
This parameter adds “<” and “>” signs (or only “>” depending on the barcode type) at the bottom of your barcode. This indicates the width the barcode should have for optimal reading.
Font Family, Style and Size
These options can be used to define the font family, style and size to be used for the human readable characters. By choosing [default font], all other Text Parameters are disabled, as the default values are used.

**Note:** If the font used in a bar code is not available when opening the file, Adobe Illustrator will warn about a missing font. You can however only fix the problem using the Dynamic Barcode palette, since Adobe Illustrator's "Find Font" feature can not be used.

Alignment
When using human readable characters, in combination with custom font settings, you can set text alignment to **Left**, **Center** or **Right**.

Vertical Offset
This parameter allows you to add extra space between your barcode bars and the human readable characters.

**Note:** When opening your document in PackEdge, the characters will be placed just below the bars again.

Use “992” Prod. Family in UPC
Enable this parameter to use the special “992” product family in your barcode (for specific offers like discounts on the customer’s next purchase or on variable weight items...).

Max. Row Width
Use this parameter to define how many segments of data (groups of bars encoding several digits) can fit in one row. If the barcode contains more segments, they will be stacked.

In the example below, the first barcode has a **Max. Row Width** of 8 segments. When reducing this to 4 segments, the segments that don't fit in the row width anymore are stacked, forming a second row (second barcode).
The GS1 Max Row Width parameter applies to the GS1 Databar Expanded Stacked component of the GS1 U.S. Coupon Interim barcode.

Text Format
Choose a text format for the human readable characters of your barcode.
For NDC/HRI barcodes, you can choose a variant of the U.S. National Drug Code.
For ITF-14, ITF-16 and UPC-SCS barcodes, you can choose a variant of the Shipping Container Symbol.

Bar Width Reduction
Use this to adjust the width of barcode bars, in order to compensate for ink bleeding when printing on your substrate.
Your printer or customer will usually provide you with the value to use. For example if your printer tells you that the line width will increase by 0.01mm, you should use a Bar Width Reduction value of 0.01 mm.
You can enter the Bar Width Reduction in microns, milliinches (“mil”), millimeters or inches.

Tip: You can enter a negative value if you want to print thicker and not thinner bars.

Device Compensation
Use this if your printer gave you a separate device bleed value. This parameter adjusts the bar’s width to compensate for bleed caused by the plate or film making process.
You can enter the Device Compensation in microns, milliinches (“mil”), millimeters or inches.

Note: If you use both a Bar Width Reduction and a Device Compensation value, Dynamic Barcodes will add them to adjust the bar’s width.

Tip: You can enter a negative value if you want to print thicker and not thinner bars.

Magnification
Use this parameter to increase or decrease the barcode size proportionally.
In the example below, you can see the same barcode at 80%, 100% and 120% magnification.
Size

Choose to give your PZN barcode a **Small**, **Normal** or **Large** size. Those are predefined sizes for this barcode. The actual Height, Characters per unit, Ratio and Narrow Bar values are shown underneath.

By selecting **Custom**, you can manually edit these four parameters.

Height

Enter the height to give to your barcode's bars. They need to be tall enough to be read easily by barcode scanners.

**Code 128**

In Dynamic Barcodes, you can create Code 128 barcodes shorter than the minimum height. Dynamic Barcodes will just display a warning, but if you export the document to EPF and open it in PackEdge, PackEdge will extend the barcode to its minimum required height.

**Bars and Digits**

For:

- EAN 8 & 13
- HIBC 128 and 39
- M+S 7, and Marks & Spencer’s
- NDC / HRI
- UPC-A and UPC-E

For the bar codes listed above, the height you enter is the combined height of the bars and the human readable characters). Your barcode needs to be tall enough to be read easily by barcode scanners.

⚠️ **Attention:** Do not change the **Height** of the barcode before entering a **Magnification** value. The **Height** will change again according to the **Magnification** factor you define.

Characters per unit

This parameter allows you to define your barcode's width based on the encoding of (numeric or alphanumeric) characters.
You can choose the unit to use: **micron**, **mil** (milliinches), **mm** or **inch**. For example, choose **mm** and use **1 Character per unit** in the **Dynamic Barcodes** dialog if you want the bars needed to encode one character to take up 1 mm.

Increase the **Characters per unit** value to make the barcode narrower, or decrease it to make the barcode wider. For example, if you choose **0.5 Character per unit**, the bars needed to encode one character will take up 2 mm.

**Note:** Barcodes like Interleaved 2 of 5 encode two characters together in a group of black and white bars. For these barcodes, Dynamic Barcodes takes half of the group of black and white bars to measure one character.
Ratio
The **Ratio** is the factor between the width of the narrow bar and the width of the wide bar in your barcode. For example, enter 3 if you want your wide bar to be three times as wide as your narrow bar.

Narrow Bar
This parameter determines the width of the narrowest bar of your barcode (and affects the width of your barcode proportionally). For GS1 barcodes, this affects the size (height and width) of your barcode proportionally.

Wide Bar
This parameter determines the width of the widest bar of your barcode.

Gap
Enter the width of the white space between the bars.

**Note:** The **Ratio** influences the **Gap** size: increasing the Ratio also increases the **Gap** size.

Vertical alignment
Dynamic Barcodes allows you to resize either the UPC-A or the GS1 Databar Expanded Stacked coupon barcode, so they are aligned vertically with each other. You can choose:

- **None** to keep the original size of both the UPC and the GS1 barcodes,
Dynamic Content Advanced

• **Resize UPC to GS1** to resize the UPC barcode so it has the same height as the GS1 barcode,

• **Resize GS1 to UPC** to resize the GS1 barcode so it has the same height as the UPC barcode.

**Snap Bars to Output Resolution**

Use this to adjust the barcode size parameters (**Bar Width Reduction**, **Device Compensation** and **Magnification**) so that the bars’ width and height take up a complete number of pixels or dots.

Enable **Snap Bars to Output Resolution** and enter the resolution you will use to print your barcode in ppi.

**Decimal Input**

Use this parameter to change the type of data you can enter in the **Code** field.

• Disable it to enter the data to encode in binary format.

• Enable it to enter the data in decimal instead of binary format.
**Note:** When using binary format for the Laetus Pharma Code/CLF-8 barcode data, you need to use a special “Pharma” binary format.

To convert a decimal number into a Pharma binary number, do the following:

1. Add 1 to your decimal number.
2. Convert the result to a binary number using a regular binary conversion algorithm.
3. Remove the first digit (which is 1).

You now have your Pharma binary input for the Laetus Pharma Code/CLF-8 barcode.

For example, you want to encode the number 3.

1. \(3+1=4\)
2. 4 in binary is 100.
3. Without the first digit, it’s 00.

Enter 00 in the **Code** field of your Laetus Pharma Code/CLF-8 barcode.

---

**Add Check Digit**

Use this parameter to add a check digit to your barcode data.

**Note:** Code 39 doesn't usually contain a check digit but it can be required in some cases.

---

**Symbol Type**

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

**Note:** If the number of cells you choose for your symbol is too small to encode the data you entered in **Code**, Dynamic Barcodes will display an error.

You can choose **Best Fit** to make Dynamic Barcodes automatically adapt the number of cells to the amount of data you entered in **Code**.

---

**Cell Size**

Enter the size you want to give to each cell of the symbol. This affects the size of the whole symbol.

The unit used is the one you chose as Illustrator’s **General** unit in the **Units & Display Performance Preferences**.
In the example below, the first symbol has a 1 mm cell size (cells sides are 1 mm), and the second one a 2 mm cell size.

**Width / Total Height**

The **Width** and **Total Height** parameters depend on the **Cell Size** and the number of cells used for the symbol (**Symbol Type**).

In the example below, a symbol of 10 x 10 cells where each cell is 3 mm gives a Width and Total Height of 30 x 30 mm.

**Total Height**

Enter the total height you want to give to your barcode. This is the combined height of the bars, the human readable characters and the box. If your barcode doesn't contain human readable characters or a box, the **Total Height** is the same as the bars’ **Height**.

**Smax / Smin**

Use these parameters to define the width of the printability gauges (“H” marks) either side of your barcode. **Smax** defines the width of the left “H”, **Smin** defines the width of the right “H”. Enter 0 in both fields if you don’t want printability gauges.

In the example below, the top barcode has a value of 0 for both **Smax** and **Smin**, the middle one has a value of 4 and the bottom one has a value of 8 (the maximum).
**Box**

Use this parameter to create an opaque white box under your barcode.

Use the **Top**, **Bottom**, **Left** and **Right** fields to add a white margin around your barcode and make the box bigger.
By default, Dynamic Barcodes links the four margins' values so that when you change one of them, the other ones are updated automatically.

If you want to change them independently, click the link symbol to make it look detached.

For ITF, UCP and UPC-SCS bar codes, the box will be transparent, with bearer bars around it. The **Box Line Width** parameter defines the width of the bearer bars.

The option **Only Top and Bottom Bars** limits the bearer bars to only the top and bottom line.

### 5.8 Barcode Parameters from the Job Folder

Automation Engine stores information related to the printing jobs within the Job Folder. Each Job Folder can hold various job-related technical information, including barcode parameters.

The following barcode parameters can be set in Automation Engine Pilot:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of barcode. You can't have two different bar codes of the same type in one job.</td>
<td>![Symbol Type](page 210)</td>
</tr>
<tr>
<td>Sub Type</td>
<td>The size of the symbol for Datamatrix barcodes.</td>
<td>![Symbol Type](page 210)</td>
</tr>
<tr>
<td>Code</td>
<td>The encoded value including check digits.</td>
<td>![Code](page 201)</td>
</tr>
<tr>
<td>Composite Code</td>
<td>For barcodes with a Composite Component - mainly GS1 Databar codes</td>
<td>![Composite Component](page 202)</td>
</tr>
<tr>
<td>Output Resolution</td>
<td>Snap Bars to Output Resolution - mainly GS1 Databar codes</td>
<td>![Output Resolution](page 209)</td>
</tr>
<tr>
<td>Bar Width Reduction</td>
<td>Bar Width Reduction - mainly GS1 Databar barcodes</td>
<td>![Bar Width Reduction](page 205)</td>
</tr>
<tr>
<td>Device Compensation</td>
<td>Device Compensation - mainly GS1 Databar barcodes</td>
<td>![Device Compensation](page 205)</td>
</tr>
<tr>
<td>Narrow Bar</td>
<td>Main size parameter for Code128, Int2of5 and GS1 Databar barcodes</td>
<td>![Narrow Bar](page 208)</td>
</tr>
<tr>
<td>Magnification</td>
<td>Main proportional size parameter for EAN and UPC based barcodes</td>
<td>![Magnification](page 205)</td>
</tr>
<tr>
<td>Ratio</td>
<td>Used for Int2of5 barcodes</td>
<td>![Ratio](page 208)</td>
</tr>
</tbody>
</table>
**Important:** Automation Engine does not check the parameters. All listed parameters are available for all barcode types, even if they are not valid for the given barcode type. Make sure you’re entering the valid inputs, including a correct Code with its check digit.

**Note:** It is not necessary to have the parameters already set on the Job Setup when creating barcodes: as soon as the Job Setup contains the settings for connected barcodes, these barcode parameters will be applied. This allows you to create templates or placeholders before the actual data (code for the barcode, etc) is available.

### 5.8.1 Connecting to a Job Folder

In order to take parameters from an Automation Engine Job Folder, you need to be connected to an Automation Engine, and open the file from the Automation Engine Job Folder. For easy locating the file on the server, you can use **File > Job Folder > Open from Job folder**

For more information on how to connect to Automation Engine, and on opening from a Job Folder, we refer to the Esko DataExchange documentation. See [http://help.esko.com/products/Esko%20Data%20Exchange%20for%20Adobe%20Illustrator](http://help.esko.com/products/Esko%20Data%20Exchange%20for%20Adobe%20Illustrator)

### 5.8.2 Connect Dynamic Barcodes to Job Setup

To use the Barcode properties from the Job Folder, enable the **Get Properties from Job Setup**. When enabled, the icon on the right will indicate the status:
Dynamic Content Advanced

- Gray: the feature is disabled
- Green: the connection is established
- Red: the file is not in a Job Folder, or the connection is down.

5.8.3 Use Barcode parameters from Job Setup

To use the barcode parameters from Job Setup, select a barcode type from the Barcode Type list that is defined in the Job setup. You can recognize these barcode types by the green icon in front.

As soon as you select one of the barcode types defined in the Job Setup, all parameters that are defined in the job setup will be entered (and no longer be editable), indicated by the same green icon.
In the example above, only the **Code** is defined in the Job Setup. All other parameters can be entered freely.

### 5.8.4 Updating barcode parameters from Job Setup

If a barcode is connected to the Job Setup, any changes to the barcode parameters in the Job Setup, whether it is a changed parameter or a newly added parameter, will automatically and immediately be taken into account in Dynamic Barcodes.

When opening a file, all barcodes with the **Get Properties from Job Setup** option enabled will be updated automatically.

If a barcode type is removed from the Job Setup, the corresponding barcodes in the job will no longer be connected, so the **Get Properties from Job Setup** option is disabled.

A barcode will also be disconnected and the **Get Properties from Job Setup** option will be disabled in case the barcode parameters in the Job Setup are invalid for the given barcode type. You will need to change the parameters in the Job Setup. Note that after correcting the parameters, you need to manually reconnect the barcode by enabling **Get Properties from Job Setup**.
6. Dynamic Marks

6.1 Copyright Notice

© Copyright 2018 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2015. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.


Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com

### 6.1.1 Third party license information

This product includes Botan.

Copyright (C) 1999–2009 Jack Lloyd
2001 Peter J Jones
2004–2007 Justin Karneges
2005 Matthew Gregan
2005-2006 Matt Johnston
2006 Luca Piccarreta
2007 Yves Jerschow
2007–2008 FlexSecure GmbH
2007–2008 Technische Universität Darmstadt
2007–2008 Falko Strenzke
2007–2008 Martin Doering
2007 Manuel Hartl
2007 Christoph Ludwig
2007 Patrick Sona

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer.
notice, this list of conditions, and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S) OR CONTRIBUTOR(S) BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes ICC Profiles.

Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
ColourKit Profiler Suite (www.colourprofiling.com)

------------------------------------------------------------
This product includes ICC Profiles.

Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org

------------------------------------------------------------
This product includes ICC Profiles.

Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org

------------------------------------------------------------
This product includes ICC Profiles.

Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and
SWOP(R) are all registered trademarks of IDEAlliance(C).

------------------------------------------------------------
This product includes curl.

Copyright (c) 1996 - 2015, Daniel Stenberg, <daniel@haxx.se>.
All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose
with or without fee is hereby granted, provided that the above copyright
notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not
be used in advertising or otherwise to promote the sale, use or other dealings
in this Software without prior written authorization of the copyright holder.

------------------------------------------------------------
This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and
its documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of
Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

------------------------------------------------------------

This product includes FCollada.

Copyright 2006 Feeling Software. All rights reserved.
Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

------------------------------------------------------------

This product includes FreeType.

Portions of this software are copyright (C) 2014 The FreeType Project (www.freetype.org) licensed under the Freetype License. All rights reserved.

------------------------------------------------------------

This product includes gSOAP.

EXHIBIT B.

Part of the software embedded in this product is gSOAP software.

Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes ICU.

Copyright (c) 1995-2014 International Business Machines Corporation and others All rights reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes ilmbase.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes iODBC.

Copyright (C) 1995-2006, OpenLink Software Inc and Ke Jin. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of OpenLink Software Inc. nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL OPENLINK OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes IP*Works!.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES; SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSH.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.
LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N Software, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N Software's licensors and their suppliers shall have no liability to you for any damages suffered by you or any third party as a result of using the licensed software, or any portion thereof. Notwithstanding the foregoing, in no event shall /N Software, its licensors, or any of their respective suppliers be liable for any lost revenue, profit or data, or for indirect, punitive, special, incidental or consequential damages of any character, including, without limitation, any commercial damages or losses, however caused and regardless of the theory of liability, arising out of the use or inability to use the licensed software, or any portion thereof, even if /N Software, its licensors and/or any of their respective suppliers have been informed of the possibility of such damages. Some states do not allow the exclusion of incidental or consequential damages, so the above limitations may not apply. Each exclusion of limitation is intended to be separate and therefore severable.

This product includes IP*Works! SSL.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N Software specifically does not warrant, guarantee, or make any representations regarding the use, or the results of the use, of the licensed software or documentation in terms of correctness, accuracy, reliability, currentness, or otherwise. The entire risk as to the results and performance of the licensed software is assumed by you. No oral or written information or advice given by /N Software or its employees shall create a warranty or in any way increase the scope of this warranty, and you may not rely on any such information or advice. Further, the licensed software is not fault-tolerant and is not designed, manufactured or intended for use or resale as on-line control equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons systems, in which the failure of the licensed software could lead directly to death, personal injury, or severe physical or environmental damage ("HIGH RISK ACTIVITIES"). /N Software and its suppliers specifically disclaim any express or implied warranty of fitness for high risk activities.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N Software, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N Software's licensors and their suppliers shall have no liability to you for any damages suffered by you or any third party as a result of using the licensed software, or any portion thereof. Notwithstanding the foregoing, in no event shall /N Software, its licensors, or any of their respective suppliers be liable for any lost revenue, profit or data, or for indirect, punitive, special, incidental or consequential damages of any character, including, without limitation, any commercial damages or losses, however caused and regardless of the theory of liability, arising out of the use or inability to use the licensed software, or any portion thereof, even if /N Software, its licensors and/or any of their respective suppliers have been informed of the possibility of such damages. Some states do not allow the exclusion of incidental or consequential damages, so the above limitations may not apply. Each exclusion of limitation is intended to be separate and therefore severable.

This product includes JBIG2Lib.

Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.

This product includes JPEGLib.

This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.

All Rights Reserved.

This software is based in part on the work of the Independent JPEG Group.

This product includes Little CMS.
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

This product includes leptonica.
- Copyright (C) 2001-2016 Leptonica. All rights reserved.
- Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
  - Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
  - Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
- THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL ANY CONTRIBUTOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes libpng.
Copyright (c) 2000-2002 Glenn Randers-Pehrson
The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all warranties, expressed or implied, including, without limitation, the warranties of merchantability and of fitness for any purpose. The Contributing Authors and Group 42, Inc. assume no liability for direct, indirect, incidental, special, exemplary, or consequential damages, which may result from the use of the PNG Reference Library, even if advised of the possibility of such damage. There is no warranty against interference with your enjoyment of the library or against infringement. There is no warranty that our efforts or the library will fulfill any of your particular purposes or needs. This library is provided with all faults, and the entire risk of satisfactory quality, performance, accuracy, and effort is with the user.

This product includes libxml2.
Copyright (C) 1998-2012 Daniel Veillard. All Rights Reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is fur-
nished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

-------------------------------------------------------------------

This product includes openexr.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm
Entertainment Company Ltd. Portions contributed and copyright held by
others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with
the distribution.

* Neither the name of Industrial Light & Magic nor the names of
any other contributors to this software may be used to endorse or
promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

-------------------------------------------------------------------

This product includes OpenJPEG.

Copyright (c) 2002-2012, Communications and Remote Sensing Laboratory, Universite
catholique de Louvain (UCL), Belgium
Copyright (c) 2002-2012, Professor Benoit Macq
Copyright (c) 2003-2012, Antonio Descampe
Copyright (c) 2003-2009, Francois-Olivier Devaux
Copyright (c) 2005, Herve Drolon, FreeImage Team
Copyright (c) 2002-2003, Yannick Verschueren
Copyright (c) 2001-2003, David Janssens
Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
Copyright (c) 2012, CS Systemes d'Information, France
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:
1. Redistributions of source code must retain the above copyright
   notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
   notice, this list of conditions and the following disclaimer in the
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS `AS IS' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenSSL.

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment:
   "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org.
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following acknowledgment:
   "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT `AS IS' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenSSL.

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer.
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
3. All other materials mentioning features or use of this software
must display the following acknowledgement:
"This product includes cryptographic software written by
Eric Young (eay@cryptsoft.com)"
The word 'cryptographic' can be left out if the routines from the library
being used are not cryptographic related :-().
4. If you include any Windows specific code (or a derivative thereof) from
the apps directory (application code) you must include an acknowledgement:
"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
 DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
 OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

------------------------------------------------------------
This product and use of this product is under license from Markzware
under U.S. Patent No. 5,963,641.
------------------------------------------------------------
This product includes Qt.
The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).
------------------------------------------------------------
The Qt Toolkit is Copyright (C) 2014 Digia Plc and/or its subsidiary(-ies).

------------------------------------------------------------
This product includes QtMigration.
Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:
* Redistributions of source code must retain the above copyright
 notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright
 notice, this list of conditions and the following disclaimer in
 the documentation and/or other materials provided with the
 distribution.
* Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
 of its contributors may be used to endorse or promote products derived
 from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes tesseract.
Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0
This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes XercesC.

NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this case for the Apache Xerces distribution.

This product includes software developed by The Apache Software Foundation (http://www.apache.org/).

Portions of this software were originally based on the following:

This product includes XMP Toolkit.

Copyright (c) 1999 - 2010, Adobe Systems Incorporated
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Adobe Systems Incorporated, nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes zlib.

Copyright (C) 1995-2004 Jean-loup Gailly and Mark Adler
6.2 Getting started

Using the Dynamic Marks plugin, you can create sets of marks, add them in a document, and have full control over these marks.

6.2.1 Creating a first Mark Set

1. Open a file in Illustrator. Create some objects you want to use as marks.
2. Go to Window > Esko > Dynamic Marks > Dynamic Marks to open the Dynamic Marks panel.
3. Click Create a Mark Set to start a new Mark Set.
   
   **Note:** This step is optional. If no Mark Set is present, you can also immediately start adding marks (see step 4), a new Mark Set will be created automatically.

4. You can add marks in two ways:
   - Select the objects you want to use as mark one by one, and click the Add Selected Art as Mark button.
   - Click the Add Standard Mark button to add a standard mark to the set.
5. From the fly-out menu, select Save mark set

   **Note:**
   
   You can only save a Mark set if the Illustrator file is saved. If not, you will be prompted to do so before saving the Mark Set.
6.3 The Dynamic Marks palette

In the Dynamic Marks palette, you can manage the marks in a set. The palette will show the name of the latest loaded or saved mark set, and all the marks in the set. The icon in front of the mark name will show the type of mark: a standard mark, text, an object, ...

In the palette, you can

- change the name of a Mark by double-clicking it
- select and zoom in on a Mark, by clicking the button or from the fly-out menu
- add the selected artwork as a Mark, by clicking the button or from the fly-out menu. See Adding objects as Mark on page 231
- add a Standard Mark, by clicking the button or from the fly-out menu. See Adding a Standard Mark on page 231
- remove the selected Mark, by clicking the button or from the fly-out menu.

**Note:**

Removing a Mark will remove the entry in the Mark Set as well as the actual object.

- update an On Demand mark (indicated by the icon) by clicking the Update button. See Updating Dynamic Marks on page 232
- expand a mark, by selecting the function in the fly-out menu. Expanding a mark replaces the Dynamic Mark by a normal object.
- change the order of the Marks by clicking and dragging.
  - If the corresponding objects are in the same layer in the Layers menu, their order will be changed the same way.
• If you change the order in the Layers palette, the Marks in the Dynamic Marks palette will change accordingly.

Note that the Marks list shows the topmost Mark at the bottom of the list, while the Layers palette works the other way around.

**Note:** Same as in Adobe Illustrator’s Layer palette, there are two different types of selecting in the Dynamic Marks palette:

• If you click the name, the Mark is selected in a blue bar, but the actual art is not selected in Adobe Illustrator. This selection is used for Dynamic Mark palette operations (zoom, trash, expand, remove).
• If you click at the right side of the row (or if you select the art using the Illustrator select tools), the Mark is showing a colored rectangle, indicating that the actual art is selected in Adobe Illustrator. This selection is used for the Marks Properties.

### 6.3.1 Adding a Standard Mark

You can add one of the predefined Standard Marks to your Mark set:

1. Click the **Add Standard Mark** button or select **Add Standard Mark** from the fly-out menu.
2. Select the Standard Mark you want to add.
3. Click **Add**.

The Standard Mark will be added to the Mark Set, and in the current document. You can change its properties in the Dynamic Marks Properties palette. See *Dynamic Mark Properties* on page 232.

The Standard Marks currently available are:

• Cut Mark
• Bearer Bars
• Gradation Strip
• Grid Marks
• Corner Marks
• Color Patches
• Image Mark

For more information on the properties for the Standard Marks, see *Specific Mark Properties* on page 237.

**Note:** It is not possible to apply scaling on standard marks. Every time the marks are updated, they will be regenerated at their original size.

### 6.3.2 Adding objects as Mark

You can add existing objects as a Mark to your set.
1. Select the object you want to use as a mark

2. Click the **Add Selected Art as Mark** button or select **Add Selected Art as Mark** from the fly-out menu.

   The new Mark will appear in the Dynamic Marks palette. You can change its properties in the Dynamic Marks Properties palette. See *Dynamic Mark Properties* on page 232

   **Note:** If you select multiple objects, these objects will be grouped and added as one single mark in your set.

### 6.3.3 Updating Dynamic Marks

By default, all Dynamic Marks are updated automatically. There are however some exceptions to this.

**Changes in the Ink Manager**

If the ink list in the document changes after adding the marks, you must click Update Ink List in the Ink Manager for the marks to adjust to the updated ink list. See *Color* on page 235

**On Demand marks**

**On Demand** marks are marks that are not updated automatically. These marks are indicated in the Dynamic Marks palette using this icon: ![on_demand_icon].

These marks will only be updated by clicking the **Update** button. The only **On Demand** mark at this moment is a Text Mark using the "Ink Coverage" variable.

### 6.4 Dynamic Mark Properties

You can open the Dynamic Mark Properties by choosing **Window > Esko > Dynamic Marks > Dynamic Mark Properties** or by choosing **Open Properties Palette** from the flyout menu of the Dynamic Marks palette.
6.4.1 Position

The position of a Mark is based on 3 settings:

Attach to

The position of the Mark can be based on

• Any page box: Media Box, Crop Box, Bleed Box, Trim Box or Art Box

Note:

• a Page Box that is not defined in the file, will be greyed out
• If you load a Marks set that uses a page box not defined in the current file, the Trim Box is used instead, and a warning is shown
• You can’t delete a Page Box if there’s a mark attached to it.

• another Dynamic Mark
• a PowerLayout Repetition, such as "PowerLayout Grid 1"
• Named Art

Named Art is any art in your Illustrator document, that you gave a name in the Layers palette: browse to the object you want to name in the Layers palette, double click the default name (eg. <path>) and enter a name.

When selecting Named Art..., you get a separate dialog, in which you can either type the name of the Named Art you want to use, or select it from the dropdown at the right. Once Named Art has been used, it remains available in the Attach To dropdown.

Named Art is only possible on objects, not on groups. Named Art can’t be hidden or locked.

Note: Standard Marks will be automatically attached to a currently selected PowerLayout Standalone grid or another selected Dynamic Mark. If no grid or Dynamic Mark is selected, the Standard Mark is attached to the Trim Box.

A PowerLayout Standalone grid is a Step and Repeat of a single file or object(s), generated by the PowerLayout Standalone plug-in. If such a grid is available in the document, you can select its name in the dropdown. For more information, see the PowerLayout Standalone documentation.

Positioning

The way the Mark is attached, can be chosen by clicking and dragging the blue square (representing the Mark) to the desired position on the grey square (representing the Attach To reference). Each square has 9 reference points (top left center and right, middle left center and right, and bottom left center and right), so you have 81 different ways of positioning the mark.

This setting is not available for Bearer Bars and for Cut Marks.

In the example underneath, the top center of the (bounding box of the) mark will be placed on the left bottom corner of the (bounding box of the) reference defined in the Attach to field.
**Note:** If you create a Mark from an existing object, the Positioning settings (the blue rectangle) will be automatically set, using the smallest offset possible while keeping the object at the same location.

**Offset**

In the offset fields, you can move the mark based on the defined position. The direction of the offset (up, down, left or right) depends on the positioning, and is shown by the arrows.

**Note:** You can also manually move Marks. In that case, the offset will automatically adjust to the new location. The other settings (Attach To and Positioning) will NOT change.

**Repeat**

For custom marks, you can use the Repeat buttons, to choose if the mark should be repeated or not.

From left to right:

- No repeat
- Repeat on all 4 sides. The positions of the marks are rotated 90° around the center of the Attach To object. Examples:

- Repeated horizontally. The positions of the marks are mirrored over the vertical center line. Examples:
6.4.2 Color

The color of a mark can be one of these settings:

**Registration**
The mark will be colored with 100% of every ink used in the document. If you change the tint to e.g. 42%, the mark will get 42% of every ink used in the document.
Changing the inks in the document can change the color of the mark.

**Note:** If you manually change the color of a mark set to Registration, its color setting will change to "Static" (see below), using the newly set color.

**Static**
If color is set to "Static", the current color is stored, based on the actual inks. The color of the mark will not change if the order of the ink list is changed.

**Note:**
When placed on an existing document, "Static" marks are the only marks that affect the ink list: the inks used in the mark will be added if necessary.

**Dynamic**
If color is set to "Dynamic", the current color is stored, but based on the ink positions in the Ink Manager, and not the actual inks.
For example, if the first ink is Cyan, a 100% cyan mark is stored as "100% of the first ink". If the first ink is different (by changing the ink order, or by placing the mark on a different file), the mark will become 100% of the first ink.

**Note:** If the ink list in the document changes after adding the marks, you must click Update Ink List in the Ink Manager for the marks to adjust to the updated ink list.

**Darkest**
The mark will be colored with 100% of the darkest ink used in the document. You can't change the percentage for "Darkest" ink, it will always be 100%.
Changing the inks in the document can change the color of the mark. Technical inks are not used in the mark.

**Note:** If you manually change the color of a mark set to Darkest, the color will change back to the darkest ink at the next mark update.

### Black or Darkest

If the document contains a Process Black ink, the mark will be colored with 100% Black, otherwise the darkest ink used in the document is used. You can’t change the percentage for "Black or Darkest" ink, it will always be 100%.

Changing the inks in the document can change the color of the mark. Technical inks are not used in the mark.

### Fill / Stroke

For custom marks and for Color Patch marks, you can define both the Fill and the Stroke Color. For Stroke, you have an extra option *Same as fill*

### Defaults

Every Dynamic Mark has a default color attribute:

<table>
<thead>
<tr>
<th>Mark Type</th>
<th>Available Color Options</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom mark (plain object)</td>
<td>all*</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Cut Mark</td>
<td>Registration, Darkest, Static</td>
<td>Darkest</td>
</tr>
<tr>
<td>Text</td>
<td>all</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Image Mark</td>
<td>Static, Dynamic**</td>
<td>Static</td>
</tr>
<tr>
<td>Dynamic Objects (Barcode, Panel, Table)</td>
<td>all</td>
<td>Static</td>
</tr>
<tr>
<td>Bearer Bar</td>
<td>all</td>
<td>Registration</td>
</tr>
<tr>
<td>Gradation Strip</td>
<td>No Color Options</td>
<td>not applicable</td>
</tr>
<tr>
<td>Grid Marks</td>
<td>Registration, Darkest, Static</td>
<td>Registration</td>
</tr>
<tr>
<td>Corner Marks</td>
<td>Registration, Darkest, Static</td>
<td>Registration</td>
</tr>
<tr>
<td>Color Patch</td>
<td>only applicable for stroke: all</td>
<td>same as fill</td>
</tr>
</tbody>
</table>

(*) A Custom mark created from a mesh or gradient object will always have color attribute "Static". This can't be changed.

(**): EPS image marks can only be Static.

**Note:** A Gradation Strip doesn't allow setting Color options. A Gradation Strip always uses every ink, except for technical inks.

### Inks

When using **Dynamic** color, you can choose what inks to include: All inks, only technical inks or only printing inks.

For any other color option, you can’t change the drop down: for Static color and Registration it is fixed at "All", while for "Darkest" it is fixed at "Only Printing".
If the option **Include Varnish Inks** is disabled, inks set as "Varnish" will not be taken into account for Dynamic color.

### 6.4.3 Specific Mark Properties

Standard Marks have, beside Position and Color, some specific properties.

Also Text Marks have specific properties, allowing to create dynamic Text Marks.

**Cut Mark Properties**

Cut Marks are created from a symbol named "CutMark", and are by default 0,1mm wide and 10mm long.

**Position**: Cut Marks will be automatically attached to a currently selected PowerLayout Standalone grid or another selected Dynamic Mark. If no grid or Dynamic Mark is selected, the Cut Mark is attached to the Trim Box.

**Color**: Cut Marks are by default in "Darkest" color.

**Offset**: allows to define the offset for the Cut Marks. A positive offset will move the Cut Marks to the outside.

**Symbol**: allows to change the symbol used for the Cut Mark. See *Changing the Symbol of a Standard Mark* on page 258,

**Bearer Bars Properties**

Adding a Bearer Bars mark will create two bars, one on each side, left and right (default) or top and bottom. The bars will automatically take the size (vertical or horizontal) of the "Attach" selection.
Position: Bearer Bars will be automatically attached to a currently selected PowerLayout Standalone grid or another selected Dynamic Mark. If no grid or Dynamic Mark is selected, the Bearer Bars are attached to the Trim Box.

If the Show on Both Sides option is selected, you will get a Bearer Bar on both sides (top and bottom, or left and right).

By positioning the blue rectangles, you can choose between a vertical or horizontal orientation.

Color: Bearer Bars are by default in Registration color.

Width: The width of the Bearer Bar.

Extend: allows to extend the Bearer Bar on both size. Entering e.g. +5mm will extend the Bearer Bar by 5 mm on both ends.

Offset defines the distance between the Attach to object and the Bearer Bars.

Gradation Strip Properties

Gradation Strips are created from a symbol named "GradationStrip", and are by default 3 rectangles of 5 x 5mm, horizontally, colored 40%, 80% and 100%, one strip per ink.
**Position:** Gradation Strips will be automatically attached to a currently selected PowerLayout Standalone grid or another selected Dynamic Mark. If no grid or Dynamic Mark is selected, the Gradation Strip is attached to the Trim Box.

If you change the Positioning setting (the blue rectangle), the gradation strip will rotate automatically based on the position of the blue rectangle.

**Width:** The width can be set to "One Strip per Ink" or to "Repeat to Fit".

**Symbol:** allows to change the symbol used for the Gradation Strip Mark. See *Changing the Symbol of a Standard Mark* on page 258.

You can use any type of art in the symbol, but only paths and compound paths will be colored. If you will use any text in your Gradation Strip symbol, it will be automatically colored with darkest ink.

If you change the default Gradation Strip symbol, the default position will be based on the size of the symbol. If the width of the symbol is bigger than its height, the Gradation Strip will be created horizontally by default. If the height is bigger, the Gradation Strip will be created vertically by default.

**Flip:** when set to "Normal", the gradation is built from left to right, when set to "Reverted", the gradation strip is built from right to left.

**Grid Mark Properties**

Grid Marks are created from a symbol named "GridMark", and are by default a rectangle of 5 x 5mm, in Registration color.

![Dynamic Marks Properties](image-url)
**Position**: Grid Marks will be automatically attached to a currently selected PowerLayout Standalone grid. If no grid is selected, you will get an error message.

**Mark Positions & Copies**:  
Using the **Where** buttons, you can define where you want the Grid Marks:

- on the left side of the Repeat  
- on the right side of the Repeat  
- on top of the Repeat  
- below the Repeat  
- in between the columns  
- in between the rows.

**Note**: The "in between" options can not be used in combination with **stagger**. If you enable stagger while grid marks are set to "in between", or if you load a mark set containing such a mark, the grid marks will be placed at the side, and a warning will be given.

For the Mark Position, you can (besides the normal Position settings) set the **Reference**. The Reference defines what cell or column to use as a reference. You can set the Reference to **Outer Left Cell** or **Outer Right Cell**, or to **Outer Left Column** or **Outer Right Column**.

If the Grid Marks are placed on the top or bottom of the repeat, the options become top/bottom instead of left/right, and Row instead of Column.

If a **Column** is used, a single Grid Mark is placed, using the column as reference.

In case you use a **Cell** as Reference, you can choose to **Repeat** the grid mark every Row (or Column), every 2 rows, etc...

The examples underneath shows a 5 by 5 repeat with staggering. The Position is always centered at the left side.
Symbol: allows to change the symbol used for the Gradation Strip Mark. See Changing the Symbol of a Standard Mark on page 258.

White Underprint: see White Underprint on page 257

Corner Mark Properties
Corner Marks are created from a symbol named "CornerMark".
**Bounding Box Corners** or **Repetition Corners**:

Using the buttons, you can define if you want corner marks on the bounding box of the selected **Attach To** area, or on the corners of every one-up. This option is only available if you attached the corner mark to a Repeat Grid.

**Set Symbol**: allows to change the symbol used for the Gradation Strip Mark. See *Changing the Symbol of a Standard Mark* on page 258.

**Offset** allows to define the offset between the corner and the corner mark. If the lock is enabled, vertical and horizontal offset are kept the same. If the lock is disabled, you can enter different values for vertical and horizontal offset.

If an offset of 0mm is used (in the image underneath on the left), the bounding box of the corner mark is placed on the outside of the selected page box. The page box is shown in red, the corner mark in black and the bounding box in blue.

In the image on the right, the default offset of -8mm is used. You can see the Corner Mark being moved 8 mm to the inside, based on the original position. Since the default symbol is 10 mm by 10mm, this default setting places the corner mark at 2 mm to the outside of the selected page box.
Color Patch Properties

Color Patch marks are created from a symbol named "ColorPatch".

Set Symbol: allows to change the symbol used for the Color Patch Mark. See Changing the Symbol of a Standard Mark on page 258.

A Color Patch mark is dynamically colored in one ink. The Index defines the ink to use, based on the ink position in the Ink Manager.

You can however define a different color for the text and for the stroke.

The number of text fields depends on the number of text fields in the symbol. When using the default symbol, a Color Patch contains 3 text fields, set to the short ink name, the ruling and angle, and the index.

Note: When you create a symbol for Color Patch using exact the same variable names (case sensitive), Dynamic Marks will automatically use these variables. This way, you can quickly create a Color Patch symbol with working variable text fields.

Text Mark properties

A Text Mark is a Custom Mark created from a text object. Text Marks can consist of static and dynamic text.

1. Create a text object, using the font and text settings you want to use, and add it as a Custom Mark.
   
   For more info on adding objects as Mark, see Adding objects as Mark on page 231
2. Open the Dynamic Mark Properties palette, by choosing **Window > Esko > Dynamic Marks > Dynamic Mark Properties**

The existing text is **static**, which means it won't change when you use the Mark into another document, or if the document changes.

You can make all or part of the text **dynamic**, to have it change with every document you use your mark into.

![Dynamic Marks Properties](image)

**Note:** If you want to have some static text, just leave that part of the text as it is (or type in new text) in the **Text** area.

3. To get dynamic text, you need to insert dynamic **fields**.

Place your cursor where you want the field to be, or select the text to replace with a field, and click the **Insert / Modify ...** button.

4. In the **Insert Field** dialog that opens, choose the fields to insert:

   a) Select **Local Variables** to select variables from the local file, or **Server Variables** to use SmartNames from the Automation Engine server. In that case, all Database queries defined on the server will be available, as well as all job and product parameters.

   b) choose a field **Category**, for example **Barcodes, Date & Time**...

   c) in that **Category**, choose the **Field** you want to use (see **Categories and Types** on page 245 for a list of available categories and fields),

   d) if applicable, choose the **Format** to use for your chosen **Field** (see **Formatting Dynamic Fields** on page 249 for details),
**Dynamic Content Advanced**

Note: The **Preview** line shows how the field will be resolved in the current document.

e) when you are satisfied with how your field will look like, click **OK**.

The dynamic parts of a text object will appear between square brackets.

**White Underprint** allows to add White Underprint to your Mark. See *White Underprint* on page 257

**Categories and Types**

**Local Variables**

<table>
<thead>
<tr>
<th>Barcodes</th>
<th>Date &amp; Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Number of Barcodes</td>
<td>• Date</td>
</tr>
<tr>
<td>• Barcode Type</td>
<td>• Time</td>
</tr>
<tr>
<td>• Barcode Code</td>
<td>• Date and Time</td>
</tr>
<tr>
<td>• Bar Width Reduction</td>
<td></td>
</tr>
<tr>
<td>• Barcode Magnification</td>
<td></td>
</tr>
<tr>
<td>• Barcode Device Compensation</td>
<td></td>
</tr>
<tr>
<td>• Barcode Narrow Bar</td>
<td></td>
</tr>
</tbody>
</table>

245
| Document       | • File Name  
|               | • Fonts      
|               | • Layer Names
|               | • CMYK Profile
|               | • RGB Profile
|               | • Color Mode
|               | • Trim Box   
|               | • Crop Box   
|               | • Bleed Box  
|               | • Media Box  
|               | • Art Box    

| File Info (XMP) | • Description
|                | • Author
|                | • Document Title
|                | • Author Title

| Inks           | • Number of Inks
|                | • Number of Technical Inks
|                | • Ink Names
|                | • Technical Ink Names
|                | • Short Ink Names
|                | • Abbreviated Ink Names
|                | • Ink Types
|                | • Ink Dotshapes
|                | • Ink Angles
|                | • Ink Rulings
|                | • Printing Method
|                | • Ink Coverage

| Links          | • Placed Files
|                | • XML Content Files
|                | • Structural Design File

| System         | • Illustrator Version
|                | • Creative Suite Version
|                | • OS Type
|                | • OS Version
|                | • Short User Name
|                | • Full User Name

| Server Variables | • Extension of File
|                  | • File
|                  | • File Type
|                  | • First Folder of File
|                  | • Folder of File |
Dynamic Content Advanced

Job Info

- Folder of Input
- Job Name
- Order ID
- Sub Order ID
- Description
- Due Date
- Project ID
- Last Actor
- Job URL
- Category
- Category2
- Category3
- Category4
- Category5
- Category6
- Category7
- Customer Ref
- CSR
- CSR Email
- Customer ID
- Customer Name
- Customer Description
- Due Day
- Due Time
- Job Container Name
- Job Container URL
- Job CT URL
- Job ID
- Name of Folder of Job
- JI Legacy Job (JDF)
- JI Originator (JDF)
- PS Printer Name
- PS Printer Name (JDF)
- Job Parameters
- Number of Barcodes
- Barcode Type
- Barcode Code
- Bar Width Reduction
- Barcode Magnification
- Barcode Device Compensation
- Barcode Narrow Bar
- Number of Inks
- Number of Technical Inks
- Ink Names
- Technical Ink Names
- Short Ink Names
- Ink Types
<table>
<thead>
<tr>
<th>Dynamic Content Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
</tr>
<tr>
<td>Misc</td>
</tr>
<tr>
<td>Path Info</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Product Info</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Job Barcodes</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
Formatting Dynamic Fields

You can format certain fields so they look a certain way (for example, have the date in European or American format).

You can use predefined formats or create custom formats. You can also choose to use a different format for each field, or the same format for all fields.

**Using an Existing Format**

- You can choose an existing format to apply to your field in the **Format** list.
  
  For example, use `[name][ext]` to display the file name and extension when using the **File Name** field.
Tip: Hover over to get more information about the different formats.

**Defining a Custom Format**

To define your own field format:

1. Choose **Custom** in the format list.
2. Define your format in the box below (using the predefined formats and the information under for help).
Dynamic Content Advanced

Note:

• The items in square brackets, like [major], are dynamic, the rest of the text is static.

• Use the Enter key to get a new line.

3. Check how your format resolves for the current file in the Preview line.
4. Click OK when you are satisfied.

Repeating the Format for All Items

If the field you want to use can have several values (e.g. Fonts, Ink Names, Placed Files...), you can put them all in one dynamic object.

You can also set the same format for all those values at once.

After choosing an existing format or defining a custom one:

1. Select Repeat format for all items.
2. Choose the Separator you want to use between the values (Comma, Space...).
Note: You can also specify your own separator by typing it directly in the Separator list.

3. When you are satisfied with what you see in the Preview, click OK.

Formatting Dynamic Fields for Inks
When using variables of the category Ink, the Format field is used to select the ink based on the ink index.

If for example you use the variable "Ink Names", and set the Format to [3], the variable will return the Ink Name for the 3rd ink in the document, e.g. "Process Yellow".

Note: This does not apply to the "Number of Inks" and "Number of Technical Inks" variables.

Ink Coverage
When using the Ink Coverage variable, you can set some additional parameters.

• The Area defines in which page box the Ink Coverage will be calculated. You can choose any defined page box.
• The Unit. This can be pt², in², mm², cm² or a percentage of the total area (%). When possible, the area unit corresponding to the current Adobe Illustrator unit is used, otherwise it will be %.

**Important:** If you use the Ink Coverage variable, the Dynamic Mark becomes an "On Demand" mark, so it will not be updated automatically. See *Updating Dynamic Marks* on page 232

**Reflow text**

If you create a custom mark based on text in a text frame, resizing using standard transform tools will resize the text "as is" instead of reflowing the text inside the resized text box.

If the Reflow Text option is enabled, resizing using standard transform tools will resize the text box, and the text will reflow inside the resized text box.

**Barcode Mark properties**

A Barcode Mark is a Custom Mark created from a Barcode object. For more information on creating barcodes, please refer to the Dynamic Barcodes documentation.

1. Create a barcode, using the barcode type and settings you want to use, and add it as a Custom Mark.
   
   For more info on adding objects as Mark, see *Adding objects as Mark* on page 231
2. Open the Dynamic Mark Properties palette, by choosing **Window > Esko > Dynamic Marks > Dynamic Mark Properties**

   The existing Barcode is **static**, which means it won't change when you use the Mark into another document, or if the document changes.

   You can make all or part of the code **dynamic**, to have it change with every document you use your mark into.

3. To get a dynamic barcode, you need to insert dynamic **fields**.

   Place your cursor where you want the field to be, or select the text to replace with a field, and click the **Insert / Modify ...** button.

4. In the **Insert Field** dialog that opens, choose the fields to insert:
   a) choose a field **Category**, for example **Barcodes, Date & Time**...
   b) in that **Category**, choose the **Field** you want to use (see **Categories and Types** on page 245 for a list of available categories and fields),
   c) if applicable, choose the **Format** to use for your chosen **Field** (see **Formatting Dynamic Fields** on page 249 for details),

   **Note:** The **Preview** line shows how the field will be resolved in the current document.
   d) when you are satisfied with how your field will look like, click **OK**.

   The dynamic parts of a barcode will appear between square brackets.
**Note:** Only the barcode's code can be changed after making. You can not change the barcode type or other settings after creating a Mark from a bar code. To change these settings, you have to delete the Mark and create a new one.

**White Underprint** allows to add White Underprint to your Mark. See *White Underprint* on page 257

**Image Mark properties**

An image Mark is a mark created from a linked image

1. There are two ways to create an Image Mark
   - Click the Add Standard Mark button or select Add Standard Mark from the fly-out menu, and choose Image Mark as type.
   - Place an image (supported file formats are JPG, PDF, TIFF, EPS and PSD) as a link, and add it as a Custom Mark. For more info on adding objects as Mark, see *Adding objects as Mark* on page 231
2. Open the Dynamic Mark Properties palette, by choosing Window > Esko > Dynamic Marks > Dynamic Mark Properties
   
   If the Image Mark was created from an existing image, the Dynamic Mark Properties will reflect the properties of this image: its position attached to the top left corner of the trim box, and the path of the linked file.
3. Set the **Scaling**
   - When set to **Numeric**, you can enter the scaling in %.
   - **Scale to Fit** will scale the image proportionally to fit the object defined in the "Attach to" field. You can use this for example to fit the image inside a named object. The % field will reflect the current scale factor.
   - **Downscale to Fit** is the same as "Scale to Fit", but the image will only be downscaled (if necessary), not upscaled. The % field will reflect the current scale factor.

4. Set the **Rotation** for the image using the buttons

5. Use the **File** field to set the path for the linked image. If the path is valid, the image will be shown in the document. Otherwise, a placeholder is shown.

   If you used a placed image to create the Image Mark, its file path will be entered automatically.

   You can enter the path manually, or use the **Browse** button.

   You can use dynamic text in the path, e.g. the Job Folder. Use the **Insert/Modify** button. For more information on dynamic text, see *Text Mark properties* on page 243

6. **Color** can be set to Static or Dynamic. For an EPS image, only Static is allowed.
### Dynamic Content Advanced

| Note: | If you switch from Dynamic to Static, the colors from the original file are used. If there is a difference in the number of channels between two real images, the mark will switch back to static. |

| 7. **White Underprint** allows to add White Underprint to your Mark. See [White Underprint](#) on page 257 |

| Note: | Image marks can NOT be modified (rotating, channel mapping, etc) outside of the Dynamic Marks Properties palette. |

**White Underprint**

White Underprint allows you to create a white background underneath the selected marks. This white background can be necessary when printing on transparent or metal material. White Underprint is available for Text Marks, Barcode Marks and Grid Marks

**White Underprint Object**

White Underprint objects will be created in a top-level "White Underprint" layer, and will be put in overprint.

The White Underprint object will be

- a solid rectangle, using the bounding box of a **Text Mark**
- a solid rectangle, using the bounding box of a **Barcode Mark**
- a solid rectangle, using the bounding box of a **Grid Mark**

The **Add Bar** option, available for Grid Marks, will stretch the White Underprint over the full size of the Media Box (or Trim Box if no Media Box is defined).

- For vertical grid marks, the White Underprint object will be a vertical bar, using the width of the grid mark, and the height of the Media Box
- For horizontal grid marks, the White Underprint object will be a horizontal bar, using the height of the grid mark, and the width of the Media Box

If the Mark is modified, deleted or expanded, the White Underprint will also be modified, deleted or expanded.

**White Underprint Ink**

The Ink used for White Underprint on Dynamic Marks can be defined by clicking the **Ink Settings** button, and entering the name of the Ink to be used for White Underprint.

In case the defined ink doesn't exist yet, a new spot color will be added to the swatches, using the Ink name and the Color patch.

When the name of an existing swatch is entered, this ink will be used for White Underprint.

| Note: | White Underprint can only use Spot Colors. If an existing swatch name is entered, and the swatch is not a spot color, a warning will be generated: "A swatch by this name already exists but is not defined as a Spot Color". |

If you change the White Underprint ink, all White Underprint objects on Dynamic Marks in the open document will be changed as well.

The White Underprint ink definition is saved in the Mark Set. If you load a Mark Set containing a different White Underprint ink definition as in the open document, you can choose if you
want to keep your White Underprint ink, or if you want to load the White Underprint ink
definition from the Mark Set.

### 6.4.4 Changing the Symbol of a Standard Mark

You can change the Symbol used for a Standard Mark in the Dynamic Mark Properties, by
clicking the **Set Symbol** button, and selecting the desired Symbol from the list.

To change or add Symbols,

1. In the Dynamic Marks palette, select **Open Symbol Library** from the fly-out menu
   The file DynamicMarks_CS6.ai (CS6) or DynamicMarks_AI18.ai (CC2014 and
   CC2015) will be opened

2. Open the Illustrator Symbol Library by choosing **Window > Symbols** and use the Illustrator
tools to add, edit, remove, duplicate, ... the symbols defined in the file.

3. Save and close the DynamicMarks file

The new and modified symbols will now be available when clicking **Set Symbol** in the Dynamic
Mark Properties.

### 6.5 Mark Sets

When no mark set is loaded, you get the option to load a mark set, or to create a new set.

From the Fly-out menu of the Dynamic Marks palette, you can

- Load a Mark Set
- Save the current Mark Set
- Delete the current Mark Set
- Manage Mark Sets

### 6.5.1 Load Mark Set

To load a Mark Set:

1. In the Fly-out menu of the Dynamic Marks palette, select **Load Mark Set**
The Load dialog will show the Esko Default Mark Sets, and Mark Sets saved at the location defined in the Dynamic Mark Preferences. See *Esko Mark Sets* on page 262 and *Dynamic Marks Preferences* on page 262.

**Note:** Since Mark Sets are regular .ai documents, the list will show all Adobe Illustrator files at the defined location. When loading an Illustrator file that doesn't contain a Mark Set, nothing will happen.

2. Select a Mark Set from the list, and click **Load**.

**Note:** If the Mark Set contains a mark with the same name as a mark already in the Dynamic Marks palette, an error message will be given, and the Mark Set will not be loaded.

The marks from the loaded Mark Set are **added** in the Dynamic Marks palette. If you want to replace the current marks with the ones from the loaded Mark Set, you need to select all marks and delete them first.

If you load marks with dependencies, the mark will be attached to the object (e.g. PowerLayout Grid or Named Art) with the same name as in the Mark Set file. If no such object exists, you will get an error message and the mark will be attached to the Trim Box.

### 6.5.2 Save Mark Set

To save a Mark Set:

1. In the Fly-out menu of the Dynamic Marks palette, select **Save Mark Set**
The Save dialog will show the Mark Sets already saved at the location defined in the Dynamic Mark Preferences. See Dynamic Marks Preferences on page 262.

2. Enter a name for the Mark Set and click Save. If a Mark Set with this name already exists, you will get the option to overwrite it.

**Note:**
You can only save a Mark set if the Illustrator file is saved. If not, you will be prompted to do so before saving the Mark Set.

Mark Sets are saved as simple .ai documents, containing only the objects needed for the Mark Set.

**Note:** All Marks in a set need to have a unique name. If not, an error message is shown, and the Mark Set is not saved.

### 6.5.3 Delete Mark Set

To delete a Mark Set, select **Delete Mark Set** in the Fly-out menu of the Dynamic Marks palette.

The Mark Set, including all Dynamic Marks will be removed from the file.

**Note:** This does not remove a saved (and loaded) Mark Set from disk. To do so, select **Manage Mark Sets** from the Fly-out menu. See Manage Mark Sets on page 260.

### 6.5.4 Manage Mark Sets

To manage your Mark Sets:

1. In the Fly-out menu of the Dynamic Marks palette, select **Manage Mark Sets**
The Manage Dynamic Mark Set dialog will show the Mark Sets saved at the location defined in the Dynamic Mark Preferences. See *Dynamic Marks Preferences* on page 262.

**Note:** Since Mark Sets are regular .ai documents, the list will show all Adobe Illustrator files at the defined location.

2. Select a Mark Set from the list, and

   - Click Rename, enter a new name for the Mark Set, and click Rename to change the name of the Mark Set
   - Click Delete to remove the Mark Set from the list. The actual Illustrator file will be deleted. This can not be undone.

### 6.5.5 Export Mark Sets

To use a Mark set in the Dynamic task on an Automation Engine server, you can export your Dynamic Marks set as a *Dynamic Marks Set* (.dmk).

To export your Mark Sets:

1. In the Fly-out menu of the Dynamic Marks palette, select Export Mark Set
2. Select a file name and location for the Dynamic Marks Template.
3. Move the file to your DFE server at this location: server `\bg_data_marks_v010\DynamicMarks`

Limitations:

- The server does not support different fill and stroke setting
- It is not possible to choose technical inks only or printing inks only.
- Color Patch marks are not yet supported. As a workaround, you could manually create a custom mark that looks like the Color Patch.
6.5.6 Dynamic Marks Preferences

You can open the Dynamic Marks Preferences by choosing `Illustrator > Preferences > Esko > Dynamic Marks Preferences` on Mac, or `Edit > Preferences > Esko > Dynamic Marks Preferences` on Windows.

In the Dynamic Marks Preferences, you can set the location to save and load Mark Sets.

- **Default Folder**: Mark Sets will be saved to and loaded from the default Esko location.
  - on Mac OS X: `/Users/Shared/EskoArtwork/DynamicMarks/`
  - on Windows Vista and 7: `x:\Users\Public\Documents\EskoArtwork\DynamicMarks`
  - on Windows XP: `x:\Documents and Settings\All Users\Application Data\EskoArtwork\DynamicMarks`
- **Custom Folder**: Mark Sets will be saved to and loaded from a custom folder which you can select by clicking the `Browse` button.

6.5.7 Esko Mark Sets

When installing Dynamic Marks, a number of default Mark Sets are installed as well. These sets cannot be changed, but you can load one of these sets, change it and save it under a different name.

Here is an overview of these Mark Sets:

- **1 x KAMA**
  A Custom Mark, using these settings:
• The mark is a circle of 3.2 mm diameter, and a vertical and horizontal line of 6.5 mm. All lines are 0.15 mm thick.
• Attached to the Trim Box
• The center of the mark is vertically centered, and 12 mm to the right of the left border of the trim box.
• Using Darkest color

1 x Label Row
A Grid Mark, using these settings:
• attached to PowerLayout Grid 1
• on the right side, with a reference to the outer left cell
• using a 3mm offset in horizontal direction, 0mm in vertical direction
• repeat Every 1-up.
• symbol 10 x 5 mm in Registration color

1 x Sheet
A Custom Mark, using these settings:
• The mark is a rectangle of 10 by 5 mm.
• Attached to the Media Box
• A 3 mm horizontal offset to the upper right part of the Media Box
• using Registration color

2x Label Row
Two Grid Marks, using these settings:
• attached to PowerLayout Grid 1
• Right mark is on the right side, Left mark is on the left side, both with a reference to the outer left cell
• Right mark is aligned to the right bottom corner, Left mark to the upper left corner
• using a 3mm offset in horizontal direction, 0mm in vertical direction
• repeat Every 1-up.
• symbol 5 x 5 mm in Registration color

Mark Set 1 (Esko)
A set for maximum 6 inks in the document, units: mm
• 1 Registration Mark placed on every side
• a Text Mark with the name of the document
• a Text Mark with the date
• a Gradation Strip on the left, with 1 rectangle per ink, colored in 100%
• a Gradation Strip on the right, with a 40%, 80% and 100% rectangle for every ink.
• 6 Text Marks, one per ink, with the name of the ink, and colored in 100% of the ink.

Mark Set 2 (Esko)
A set for maximum 6 inks in the document, units: mm
same as Mark Set 1, but with different type of Registration Mark
Mark Set 3 (Esko)
A set for maximum 4 inks in the document, units: mm
- 12 Gallus elements on left and right side of the document

Mark Set 4 (Esko)
A set for maximum 6 inks in the document, units: mm
- Bearer Bars in vertical orientation and attached to the Trim Box
- 6 Text Marks, one per ink, with the name of the ink, placed inside the Bearer Bar, and colored with 0,2% tint to knock out the Bearer Bar in the same separation

Mark Set 5 (Esko)
A set for maximum 12 inks in the document, units: mm
- Bearer Bars in vertical orientation and attached to the Trim Box
- a Gradation Strip on the left, with one circle per ink, colored in 100%.
- a Gradation Strip on the right, with one circle per ink, colored in 50%.
- Registration Marks placed on the left and right side.
- 12 Gallus elements on left and right side of the document
- a Text Mark with the name of the document, colored in registration
- a Custom Mark setting a background for the above mentioned Text Mark
- 12 Text Marks, one per ink, with the name of the ink, and colored in 100% of the ink.
- a Custom Mark setting a background for the above mentioned Text Marks
- 12 Text Marks, one per ink, with the current Angle of the ink, and colored in 100% of the ink.
- 12 Text Marks, one per ink, with the current Ruling of the ink, and colored in 100% of the ink.
- a Text Mark with the date and time
- a Text Mark with the name of the author, based on the XMP info

6.6 Dynamic Marks Layer

When adding a Dynamic Mark for the first time to a document, a layer named "Dynamic Marks" will be created. Standard Marks are created in the Dynamic Marks layer, Custom Marks are moved to the Dynamic Marks layer. If you rename the Dynamic Marks Layer, all Dynamic Marks created later will still be created in or moved to this layer already containing dynamic marks.

Loading a Mark Set
If you load a Mark Set, the Dynamic Marks in the set will be placed in the same layer as saved in the set. This means you can have two different layers containing Dynamic Marks at that point. Newly created marks will then be placed in one of those layers.

Locking or hiding the Dynamic Marks Layer
If the Dynamic Marks layer is locked, you will not be able to add any mark. A message will be shown in the message palette. However, all indirect operations are possible, for example changes in the Ink Manager will change the gradation strip, even if the Dynamic Marks Layer is locked.
If the Dynamic Marks layer is invisible, marks will be created/moved in the Dynamic Marks layer, and will immediately turn invisible.

### 6.7 Dynamic Panels in Dynamic Marks

When opening a document containing a **Dynamic Panel**, you will see those Dynamic Panels in the Dynamic Marks palette.

By selecting a Dynamic Info Panel and choosing **Convert Panels to Dynamic Marks** from the fly-out menu, you can convert the selected Dynamic Panel into one or more Dynamic Marks.

- Every text item in the Dynamic Panel is converted to a separate Dynamic Text Mark, using the same variables.
- If possible, other panel items with the same color attribute will be grouped and combined in one single mark.
- The inks used in the Dynamic Panel are replaced by the corresponding Dynamic Marks color:
  - A Dynamic Panel ink will become Dynamic color with mode "Only Printing Inks"
  - A Dynamic Panel Technical ink becomes Dynamic color with mode "Only Technical Inks"
  - Darkest ink becomes Darkest color
  - An object using Registration swatch becomes Registration color
  - Other inks (not Dynamic) become a static color.
- The position of converted panels will always be defined relative to the top left corner of the trim box
- Panel items that can’t be converted into a Dynamic Mark (e.g. a linked image) will remain as a panel item, while other items are converted. A message will be shown.
6.8 Tips and tricks

I open a new document, create an object to be used as a mark, and as soon as I use "Add Selected Art as Mark", the color of the object changes or disappears. Why?

If you have a document with e.g. only one rectangle, colored with 100% cyan in your document, the Ink Manager will only contain one ink (Cyan).

When you create a custom mark, the default color attribute is "Dynamic". At this moment, the color definition of the mark becomes "100% of the first ink in the ink manager". Because Ink Manager doesn't read inks from marks with color attribute "Registration", "Darkest" or "Dynamic", and because there are no other objects in the document, the inks list in the Ink Manager will be empty, and so will the custom mark be.

As soon as another ink is used in the document, this ink will be the first ink in Ink Manager, and will be used by the Custom Mark.

In the same way, if the original document would contain e.g. one object in cyan and one in magenta (and nothing else), creating a Custom Mark from the cyan object would make magenta the first ink in the ink manager, so the mark would change from cyan to magenta.

Can I start from an existing standard mark to create my own mark symbols?

Yes, you can, as long as you remember to expand the mark / symbol first (i.e. making it a regular object instead of a symbol).

What if I delete a symbol in the DynamicMarks(_CS6).ai file?

If you delete a symbol in the DynamicMarks.ai file, the symbol will obviously no longer be available in the Set Symbol list. If you delete the default symbol for a Standard Mark, creating the corresponding Standard Mark will result in an error message. To fix this, you have to create these symbols again manually.

Existing marks will NOT be affected, since the symbol is internally copied in the file when creating the mark, or when setting a different symbol. This also means that you can open a file with marks using custom symbols (saved in your local DynamicMarks.ai file) on another computer without losing the marks.
7. Dynamic Tables

7.1 Copyright Notice

© Copyright 2018 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2015. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/+).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

 Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

 JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.

 The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

 Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.

 Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.


 Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered trademarks of Global Vision Inc.

 Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights Reserved.

 All other product names are trademarks or registered trademarks of their respective owners.

 Correspondence regarding this publication should be forwarded to:

 Esko Software BVBA
 Kortrijksesteenweg 1095
 B – 9051 Gent
 info.eur@esko.com

### 7.1.1 Third party license information

This product includes Botan.

Copyright (C) 1999–2009 Jack Lloyd
2001 Peter J Jones
2004–2007 Justin Karneges
2005 Matthew Gregan
2005–2006 Matt Johnston
2006 Luca Piccarreta
2007 Yves Jerschow
2007–2008 FlexSecure GmbH
2007–2008 Technische Universität Darmstadt
2007–2008 Falko Strenzke
2007–2008 Martin Doering
2007 Manuel Hartl
2007 Christoph Ludwig
2007 Patrick Sona

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
notice, this list of conditions, and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S) OR CONTRIBUTOR(S) BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes ICC Profiles.

Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
ColourKit Profiler Suite (www.colourprofiling.com)

This product includes ICC Profiles.

Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org

This product includes ICC Profiles.

Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org

This product includes ICC Profiles.

Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and
SWOP(R) are all registered trademarks of IDEAlliance(C).

This product includes curl.

Copyright (c) 1996 - 2015, Daniel Stenberg, <daniel@haxx.se>.
All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose
with or without fee is hereby granted, provided that the above copyright
notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not
be used in advertising or otherwise to promote the sale, use or other dealings
in this Software without prior written authorization of the copyright holder.

This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and
its documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of
Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, 
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR 
ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, 
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, 
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF 
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE 
OF THIS SOFTWARE.

------------------------------------------------------------------------
This product includes FCollada.

Copyright 2006 Feeling Software. All rights reserved.

Copyright 2005-2006 Feeling Software and 
Copyright 2005-2006 Autodesk Media Entertainment.

Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy 
of this software and associated documentation files (the "Software"), to deal 
in the Software without restriction, including without limitation the rights 
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 
copies of the Software, and to permit persons to whom the Software is fur-
nished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in 
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER 
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, 
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN 
THE SOFTWARE.

------------------------------------------------------------------------
This product includes FreeType.

Portions of this software are copyright (C) 2014 The FreeType 
Project (www.freetype.org) licensed under the Freetype License. 
All rights reserved.

------------------------------------------------------------------------
This product includes gSOAP.

EXHIBIT B.

Part of the software embedded in this product is gSOAP software. 
Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen, Genivia 
inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
 DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY 
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------------------
This product includes ICU.

Copyright (c) 1995-2014 International Business Machines Corporation and others 
All rights reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal in the
Software without restriction, including without limitation the rights to use,
copy, modify, merge, publish, distribute, and/or sell copies of the Software, and
to permit persons to whom the Software is furnished to do so, provided that the
above copyright notice(s) and this permission notice appear in all copies of the
Software and that both the above copyright notice(s) and this permission notice
appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes ilmbase.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm
Entertainment Company Ltd. Portions contributed and copyright held by
others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with
the distribution.

* Neither the name of Industrial Light & Magic nor the names of
any other contributors to this software may be used to endorse or
promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes iODBC.

Copyright (C) 1995-2006, OpenLink Software Inc and Ke Jin.
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright notice,
   this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
   notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
3. Neither the name of OpenLink Software Inc. nor the names of its
   contributors may be used to endorse or promote products derived from
   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL OPENLINK OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes IP*Works!.
Copyright (c) 2013 /n software inc. - All rights reserved.
DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES; SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSH.
Copyright (c) 2013 /n software inc. - All rights reserved.
DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.
LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE.
/N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSL.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE.
/N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes JBIG2Lib.

Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.

This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
All Rights Reserved.

This software is based in part on the work of the Independent JPEG Group.

This product includes Little CMS.
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

------------------------------------------------------------
This product includes leptonica.
- Copyright (C) 2001-2016 Leptonica. All rights reserved.
- Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
  1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
  2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes libpng.
Copyright (c) 2000-2002 Glenn Randers-Pehrson

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all warranties, expressed or implied, including, without limitation, the warranties of merchantability and of fitness for any purpose. The Contributing Authors and Group 42, Inc. assume no liability for direct, indirect, incidental, special, exemplary, or consequential damages, which may result from the use of the PNG Reference Library, even if advised of the possibility of such damage. There is no warranty against interference with your enjoyment of the library or against infringement. There is no warranty that our efforts or the library will fulfill any of your particular purposes or needs. This library is provided with all faults, and the entire risk of satisfactory quality, performance, accuracy, and effort is with the user.

------------------------------------------------------------
This product includes libxml2.
Copyright (C) 1998-2012 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

------------------------------------------------------------
This product includes openexr.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes OpenJPEG.

Copyright (c) 2002-2012, Communications and Remote Sensing Laboratory, Universite catholique de Louvain (UCL), Belgium
Copyright (c) 2002-2012, Professor Benoit Macq
Copyright (c) 2003-2012, Antonio Descampe
Copyright (c) 2003-2009, Francois-Olivier Devaux
Copyright (c) 2005, Herve Drolon, FreeImage Team
Copyright (c) 2002-2003, Yannick Verschueren
Copyright (c) 2001-2003, David Janssens
Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
Copyright (c) 2012, CS Systemes d'Information, France
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This product includes OpenSSL.

Copyright (c) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the copyright
   notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the copyright
   notice, this list of conditions and the following disclaimer in
   the documentation and/or other materials provided with the
   distribution.
3. All other copies of this software, with or without
   modification, are permitted provided that the following
   acknowledgment is included:
   "This product includes software developed by the OpenSSL
   Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
   endorse or promote products derived from this software without
   prior written permission. For written permission, please contact
   openssl-core@openssl.org.
5. Products derived from this software may not be called "OpenSSL"
   nor may "OpenSSL" appear in their names without prior written
   permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following
   acknowledgment:
   "This product includes software developed by the OpenSSL Project
   for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
3. All other materials mentioning features or use of this software
must display the following acknowledgement:
"This product includes cryptographic software written by
Eric Young (eay@cryptsoft.com)"
The word 'cryptographic' can be left out if the routines from the library
being used are not cryptographic related ;-).
4. If you include any Windows specific code (or a derivative thereof) from
the apps directory (application code) you must include an acknowledgement:
"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

------------------------------------------------------------
This product and use of this product is under license from Markzware
under U.S. Patent No. 5,963,641.
------------------------------------------------------------
This product includes Qt.
The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).
------------------------------------------------------------
The Qt Toolkit is Copyright (C) 2014 Digia Plc and/or its subsidiary(-ies).
------------------------------------------------------------
This product includes QtMigration.
Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:
* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in
the documentation and/or other materials provided with the
distribution.
* Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
of its contributors may be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------
This product includes tesseract.
Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0
This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and
its documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of
Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
OF THIS SOFTWARE.

This product includes XercesC.

NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this
case for the Apache Xerces distribution.

This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).

Portions of this software were originally based on the following:

This product includes XMP Toolkit.

Copyright (c) 1999 - 2010, Adobe Systems Incorporated
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the following
conditions are met:

* Redistributions of source code must retain the above copyright notice,
  this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice,
  this list of conditions and the following disclaimer in the documentation
  and/or other materials provided with the distribution.
* Neither the name of Adobe Systems Incorporated, nor the names of its
  contributors may be used to endorse or promote products derived from this
  software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes zlib.

Copyright (C) 1995-2004 Jean-loup Gailly and Mark Adler
7.2 Introduction to Dynamic Tables

Dynamic Tables is a DeskPack plug-in for Adobe® Illustrator®. It lets you quickly and easily create tables in your artwork. At the time of this writing, its main use is to create the types of Nutrition Facts labels required on packaged food in the United States of America. Shown below is an example of an Illustrator document containing a standard full Nutrition Facts table and the Dynamic Tables palette to its left.

This document assumes you already have Dynamic Tables installed, licensed, and ready to run.

7.3 Adding a table to a document

To add a table to an Illustrator document, do the following:

1. Create or open an Illustrator document.
2. If the Dynamic Tables palette is not already open, open it by clicking **Window > EskoArtwork > Dynamic Tables**.
3. In the Dynamic Tables palette, click the **Type**: drop-down list box and select the desired table category.
4. Still in the Dynamic Tables palette, click the **Standard** drop-down list box and select the type of table to add. The available table types can be found here: *Table Types* on page 281. You may have custom tables available depending on your system configuration.

5. Scroll through the entries in the **Styles** pane of the Dynamic Tables palette and set them as desired. Pay particular attention to the fonts. Any fonts defined in the table that are not available on your system are marked with a question mark. On the Macintosh, click an unavailable font and replace it with one from the font chooser; on the PC, click the name of the missing font and type the name of the font to use in its place, or choose a similar replacement from the drop-down list.

6. Still in the Dynamic Tables palette, scroll through the entries in the **Content** pane and set them accordingly by clicking the value and entering the desired value. You must enter a value in fields marked with an asterisk. To enter a lot of information, select a content item, click the palette's menu button and click **Edit Content**, which brings up a dialog box into which you can either type text or paste in content as desired.

![Edit Content](image)

7. Once you have entered all the required information in the **Content** pane, click **Create** to create the table.

8. Dynamic Tables creates the table and inserts it into the Illustrator document. The table remains selected for you to position as desired using the placement tools. To use the table with Dynamic Content, leave it selected and use the tools on the Dynamic Content palette as described in Chapter 2 of the *Dynamic Content User Guide*. 

---

280
Note:

Instead of using the **Standard** drop-down list box, you can also use the **Select Table Standard** dialog box by clicking the button to the right of the drop-down list box. The dialog box shows a preview of the selected table. Select the desired table and click **OK**. Only the latest versions of the tables are listed.

### 7.3.1 Table Types

These are the table types currently available:

<table>
<thead>
<tr>
<th>Category</th>
<th>Data link standard</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GS1</td>
<td>(GS1)</td>
<td>(GS1) 1.x Standard Format, (GS1) 2.x Narrow Standard, (GS1) 3.x Bilingual Standard, (GS1) 4.x Bilingual horizontal, (GS1) 5.x Simplified Standard Format, (GS1) 6.x Bilingual Simplified Standard Format, (GS1) 7.x Bilingual Simplified Horizontal Format, (GS1) 20.x</td>
</tr>
</tbody>
</table>
### Dynamic Content Advanced

<table>
<thead>
<tr>
<th>Category</th>
<th>Data link standard</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Standard Format for Children Under 2, (GS1) 22.x Bilingual Standard for Children Under 2, (GS1) 24.x Simplified Standard Format for Children Under 2</td>
</tr>
<tr>
<td>FDA Nutrition Facts Tabular</td>
<td>GS1</td>
<td>(GS1) U.S. Tabular Standard, (GS1) U.S. Tabular Reduced</td>
</tr>
<tr>
<td>FDA Nutrition Facts Linear</td>
<td>GS1</td>
<td>(GS1) U.S. Linear</td>
</tr>
<tr>
<td>Tables 2016*</td>
<td></td>
<td>(GS1) U.S. Linear</td>
</tr>
</tbody>
</table>

*: The table layouts for the new FDA standard, introduced in 2016. The layouts are still under development.

### 7.4 Adding and removing table content

To add more content to the table or remove content from the table, do the following:

1. Open the illustrator document if it is not already open and select the desired table.
2. If the Dynamic Tables palette is not already open, open it by clicking **Window > EskoArtwork > Dynamic Tables**.
3. Click the plus-minus button in the Dynamic Tables palette to open the **Add Content** dialog box.
4. In the Add Content dialog box, information already displayed in the table is shown in the Current Data pane on the right, while data that is available but not shown in the table is in the More Data pane on the left.

5. To move an item between panes, select it and then click the arrows in the direction to move the item(s). To select more than one item at once, hold down CTRL on the PC or Command on the Macintosh while selecting items.

6. When you are done adding or removing content, click OK to return to Illustrator.

7.5 Changing existing table content

To change content in the table after it has been created, do the following:

1. Open the Illustrator document if it is not open already and select the table.
2. If the Dynamic Tables palette is not already open, open it by clicking Window > EskoArtwork > Dynamic Tables.
3. Select the table.
4. Double-click a field in either the Styles or Content pane of the Dynamic Tables palette.
5. Change the value in the field as desired.
6. Continue changing values as desired.
7. Click Apply when done to make the changes and return to Illustrator.

7.6 Saving a table

When you are done changing the content of a table, either by adding or removing content or changing styles, you can save the table definition for use later. Note that none of the values used in the table are saved, just the style and content definitions. To save the table, do the following:
1. In an open Illustrator document, add a table using the Dynamic Tables palette
2. Customize the table as desired by adding/removing content and setting values for the entries in the Styles and Content panes.
3. Click the Dynamic Tables palette's menu button and click Save <table name>.
4. A progress bar appears as Dynamic Tables saves the table.
5. Click the Dynamic Tables palette's menu button and click Update Table Standards.
6. The changes you made are now effective for subsequent uses of the table.

Dynamic Tables always uses the most recent version of a table. The version number is shown when the table is selected in the Select Table Standard dialog box.

Tables supplied by Dynamic Tables are marked as confirmed in the Select Table Standard dialog box. Tables that you modify are marked as unconfirmed.

7.7 Table Recognition and Extraction

Using the Extract function, you can create a Dynamic Table based on the text extracted from the selection. You can use this to create a Dynamic Table from a nutrition table created in other applications, an expanded Dynamic Table, or a manually created nutrition table. By using OCR first (e.g. using Adobe Acrobat functions) you can even use this to convert a scanned nutrition table.

1. Select the text you want to use.
   Only live text will be recognised and used. Vectorized text is ignored. You can use e.g. Text Recognition for Adobe Illustrator to convert vectorized text to live text.
2. In the Dynamic Table dialog, click the Extract button.
   A separate Select Table Standard for Extracted Nutrients palette will open.
3. Select the **Type** and **Standard** to use for the extracted Dynamic Table.

4. If needed, set the **Link extracted nutrients to Dynamic Content** option.

   When enabled, the values for the resulting Dynamic Table can't be edited in the Dynamic Table palette, but will be in the **Dynamic Content** palette. If you also enable the **Save extracted nutrients to XML file**, an XML file will be written containing the parameters. You will be prompted to set the name and location for the XML file, which will immediately be linked in the Dynamic Content palette.

   **Note:** These options are only available if you have Dynamic Content installed and licensed.

5. Click the **OK** button to perform the extraction.

   - A Dynamic Table of the selected Type and Standard will be created next to the selected text, which makes it easy to compare them.

   - If the Extraction recognises a nutrient or parameter name (such as “Saturated Fat” or "Sat. Fat"), the corresponding value is used.

   **Note:** What text is recognised as nutrient or parameter name is set in the **Contents/Resources/TableRecognition/NutrientPatterns.xml** file, which can be found by expanding the **Adobe Illustrator [xxx]/Esko/DynamicTables.plugin** bundle. You could edit that xml file, e.g. to add extra nutrients, or to make sure the extraction recognises a specific abbreviation.
If the Extraction doesn't find a value for a mandatory nutrient defined in the selected Type and Standard, the default value is used (mostly zero) and a message is shown.

**Note:** The Font size and style of the original text is not taken into account, however the font size can be used by the extraction to make the distinction between nutrients and footnote parts, since the footnotes have smaller font size.

**Note:** Bilingual tables are supported, as long as the english name for the nutrient is first, and a slash (/) is used as separator.

### 7.8 Advanced topics

The topics in this section are meant for those users with advanced knowledge of XML programming.

#### 7.8.1 Adding a custom table definition

It is possible to add custom table definitions to Dynamic Tables. A table is described by an XML file (created by someone highly skilled in XML such as a member of the EskoArtwork System Integration team of consultants) in the format described in the Table Layout Reference topic of this guide.

To add the custom table definition to Dynamic Tables, do the following:

1. Start Illustrator.
2. In Illustrator, click **Edit > Preferences > EskoArtwork > Dynamic Table Preferences**.
3. In the **Dynamic Tables Preferences** dialog box, either enter the path to the folder containing the XML file for the new table in the **Additional Table Style Folder** field, or browse for it and click **OK**. It will take a moment for Illustrator to read the XML file in that folder.
4. Create or open a document and open the Dynamic Tables palette if it is not already open.
5. Click the palette's menu button and click **Update Table Standards**.
6. The new table is now available from the **Standard**: drop-down list box or the **Select Table Standard** dialog box.

7.8.2 Table layout reference

This is a brief overview of the XML schema of the table layout format for creating customized tables using the Dynamic Tables plug-in for Adobe Illustrator.

**Custom table layouts**

Additional customized table layouts can be made available in Dynamic Tables by setting up a folder where your additional tables standards are stored. To setup this folder, in Illustrator click **Edit > Preferences > EskoArtwork > Dynamic Tables Preferences**. A dialog box will appear that allows you to define the **Additional Table Standards Folder**.

When you store new or modified XML files in this folder, use **Update Table Standards** on the fly-out menu of the Dynamic Tables palette to synchronize the list of tables in Dynamic Tables with the updated layout files on disk. This function is very useful when you are developing a custom table and want to see the result of your changes in Illustrator. When you apply this function, any table object that is present in the current Illustrator document will also be updated.

The basic structure of a table layout description is as follows:

```
<table_layout>
  <table_style>
    ...
  </table_style>
  <options>
    ...
  </options>
  <links>
    ...
  </links>
  <table | rows | columns | text | multiline_text | delimiter>
  ----!element that defines the structure and layout of the table ---->
  ...
</table_layout>
```

The “**table style**” element defines the general information about the table layout.

```
<table_style monochrome="1" formatversion="1.0"
  <type>Nutrition Facts Tables</type>
  <name>Four column based nutrition table</name>
  <description>Table with 4 columns.</description>
  <creator>www.esko.com</creator>
  <preview>four_column_nt.png</preview>
  <copyright>Esko nv</copyright>
  <version>1.0.0</version>
  <signature></signature>
</table_style>
```
The following two elements must be present in every table layout file:

- `<type>`: Specifies the category of tables that this table layout belongs to. Examples are "Nutrition Facts Tables", "Example Tables", "Pet Feeding Tables".
- `<name>`: Specifies the name of the table layout standard within the given category. Example: "US Tabular Layout".

Other elements of the table header are optional:

- `<creator>`: Author of the table layout file.
- `<description>`: A short description of the table layout. For example its intended use.
- `<version>`: 3 digit version number x.y.z of the table layout. When storing layouts with the same `<type>` and `<name>` in the custom folder that holds the XML files, only the layout with the highest version number will be loaded and used by Dynamic Tables.
- `<preview>`: An optional preview image for the table layout in .png format. This image will be displayed in Dynamic Tables when selecting the layout. The optimal size for this image is 460 pixels in horizontal or vertical direction and less than 460 pixels in the other direction. If used, the preview images must be stored in the same folder as the table layout XML file.
- `<signature>`: Unique identifier of the table layout file (only used for tables created by EskoArtwork).

The "options" element defines the substitutable elements.

The "options" element defines options of the table that will be offered to the user of the table layout in the Dynamic Tables palette. Options can be used to make parts of a table appear conditionally (see also `<if>` and `<ifnot>`) or can be used in combination with the `<subst>` element in the table layout file to allow the user to input text that should be substituted in a specific area of the table.

```xml
<options>
  <uigroup name="name">
    <option name="Title" type="string" id="title" default_value="Simple Table" />
  </uigroup>
  <uigroup name="second name">
    <option name="Background Color" type="color" id="background color" default_value="PANTONE 583 C"/>
  </uigroup>
</options>
```

If desired, options can be grouped using the `<uigroup>` tag to make them appear in a logical/ordered way in the Styles pane of the Dynamic Tables palette.

Each option element can have the following XML attributes:

- **name** - the GUI name - shown in the Dynamic Tables palette
- **id** - id of the option
- **type** - can be one of the following strings:
  - string
  - number (no units | points | inches | millimeters | centimeters | picas)
  - bool (true | false): Will appear as a checkmark in the user interface.
  - font
  - font_size (no units | points | inches | millimeters | centimeters | picas)
  - color: Can be used to allow the user of the layout to specify custom colors for parts of the table.
  - enum: When used in combination with the `allowed_values` attribute, this type allows you to offer the user a fixed list of choices for the option.
- **default_value** - default value of the option (true or false for options of type bool)
Dynamic Content Advanced

- `allowed_values` - values separated by comma, such as “first, second, third”
  
The comma character can be escaped by \; to have \ appear in a value, you have to type \".

- `link_id` - id of link

- `attribute`

- `attribute_value`

- `group`

- `order`

Advanced: `link_id`, `attribute` and `attribute_value` are optional attributes that can be used to link an option of type "bool" or "enum" to a specific attribute in a content XML file. These attributes are only of use in combination with the Dynamic Content plug-in and allow you to control the value of certain options automatically via attributes in the content XML that is dynamically linked to the table.

When group and order are defined, the same count of links with the same group name has to be defined. Then when using the option:

```xml
<subst group="vitamins" order="2"/>
```

the engine will look for the order of the corresponding link and substitute the value of the appropriate option.

**element_value**: the element_value is used when the option value is stored as an element value and not as its attribute (GS1 specific). element_value and attribute/attribute_value shouldn't be used together in a single option.

The links element defines the content of the table

Each link that has a `name` attribute will appear in the Content pane of Dynamic Tables where it can be modified manually be the user. When the `path` attribute is specified, the table can also be linked dynamically to content in XML format using the Dynamic Content plug-in.

```xml
<links>
  <link name="Statement" path="Body Statement" id="statement" mandatory="true"/>
  <link name="Ingredient 1 Name" path="Body/Ingredients/Ingredient1/Name" id="ingredient1_name" mandatory="true"/>
  <link name="Ingredient 1 PDV" path="Body/Ingredients/Ingredient1/PDV" id="ingredient1_pdv" mandatory="true"/>
</links>
```

Each link option can have the following attributes:

- `name` - the GUI name of the link

- `path` - the xpath of the link. This is a path in the content XML starting from the root node to which the table will be linked but not including the root node itself.
  
  If certain elements might be using a namespace, it's advised to use *: prefix in the path, e.g.
  ```xml
  path="artworkContentCopyElement[copyElementTypeCode=SERVINGS_PER_KEYW
and instanceSequence=1]/textContent/*:html/body".
  ```
  When using this prefix, this path will work for both elements with and without a namespace.

- `id` - the unique ID of the link

- `mandatory` - true if the link must be specified for the table. Mandatory links will always appear in the Content pane of the Dynamic Tables palette. When false is specified for
this attribute, the user is free to add the associated content item or not using the + and -
buttons at the bottom left of the Dynamic Tables palette. The default value for this attribute
is false.

• **showbydefault** - for voluntary links (mandatory attribute set to false), this attribute will
cause the link to appear in the Content pane of the Dynamic Tables palette by default. The
default value for this attribute is false.

• **group** - the name of the group - in some cases this name should correspond to the group
name of a set of corresponding options.

**Note:**
When the **name** attribute of a link is not defined, the link will not be shown in in the Dynamic
Tables palette and will only be taken into account when using Dynamic Content.

The links can be referred to using the `<link>` element in the following way:

```xml
<link link_id="name"/>    <link group="group_name" order="3"/>  -- the third existing
link with the "group name" is taken into account
```

The table engine will then substitute the appropriate text in which the `<link>` tag occurs with
the content derived via the link.

**Elements that define the layout (geometry) of the table**

Elements that can be used as top geometry elements are: table, rows, columns, flow_container,
text, multiline_text, delimiter.

Container elements: table, columns, rows, column, row, flow_container

Elements that define single line text or text areas within the table: text, multiline_text, delimiter,
span

**Optional attributes that can be used on each of these elements**

The following attributes only have an effect on the element to which they are assigned and are
not inherited by child elements of that element:

• **space** (float) - width of space next to element

• **space_top** (float) - width of space next to element

• **space_bottom** (float)

• **space_left** (float)

• **space_right** (float)

• **width** (float) - width of the element

• **height** (float) - height of the element

• **border** (float) - the width of the around the element (by default 0.0)

• **round** (float) - for a border with rounded corners, this attribute specifies the radius of
corners

• **only_if** (xpath) - the element is taken into account only if the xpath exists in the XML.
The values of the attributes below are inherited by child elements of the element to which the attribute is assigned:

- **font** (string)
- **font_size** (int)
- **delimiter_height** (float)
- **text_space** (float)
- **text_space_top** (float)
- **text_space_bottom** (float)
- **text_space_right** (float)
- **text_space_left** (float)
- **multiline_text_space** (float)
- **multiline_text_space_top** (float)
- **multiline_text_space_bottom** (float)
- **multiline_text_space_right** (float)
- **multiline_text_space_left** (float)
- **delimiter_space** (float)
- **delimiter_space_top** (float)
- **delimiter_space_bottom** (float)
- **delimiter_space_left** (float)
- **delimiter_space_right** (float)
- **bullet_style** (square | circle)
- **bullet_size** (float)

Elements that define the layout of the table definition:

- **<table>** (Defines the table with rows and columns. The table will be row-oriented or column-oriented depending on if it contains **<column>** or **<row>**.
  can contain: **<column>** | **<row>**
  attributes:
  - **space_among_columns** (float)
  - **space_among_rows** (float)
  example:

  ```xml
  <table space_among_columns="2.0">
  <column>
  ```
• `<columns>`
  can contain: table, columns, rows, flow_container, text, multiline_text, delimiter
  attributes:
  • `same_height` (default “yes”, can be “no”): Specify if each column would have the same height. By default each column has the same height. It is needed when you want to make the border of each column.

• `<rows>`
  can contain: table, columns, rows, flow_container, text, multiline_text, delimiter

• `<rows_split into="panel_id">`
  This panel defines rows that will overflow into another panel that is referred to by the panel_id that is specified via the split_into attribute. The rows will be divided in panels so that rows_split and rows_overflow will have the same height.

• `<rows_overflow id="panel_id"/>`
  Can only be used together with `<rows_split>` and defines a panel in which rows from another panel can overflow into.

• `<flow_container>`
  Flow containers are used to horizontally align different elements. Elements can be put to the left, to the right, or to the middle according to the `align` attribute.
  can contain: table, columns, rows, flow_container, text, multiline_text, delimiter
  child attributes:
  `align` (right | left): When no attribute is specified, the child's element is in the middle.
  Example:

  ```xml
  <flow_container>
    <text align="left">left</text>
    <text>middle</text>
    <text align="right">right</text>
  </flow_container>
  ```

• `<column>`
  can contain: table, columns, rows, flow_container, text, multiline_text, delimiter
  attributes:
  • `overlap` (int): Specify how many columns it overlaps in the table.

• `<row>`
  can contain: table, columns, rows, flow_container, text, multiline_text, delimiter
  attributes:
  • `overlap` (int): Specify how many rows it overlaps in the table.

• `<text>`
  can contain #TEST, link, subst, span, bullet, ss, unbreakable
Example:

```html
<text font="Helvetica" font_size="8">hello</text>
```

- `<multiline_text>`
  the same definition as text, can be defined over more lines depending on the height attribute.
  can contain: #TEXT, link, subst, span, bullet
  attributes:
  - line_gap (float): specify the spaces between lines
  - text_alignment (left | right | center | full_last_line_left | full_last_line_right | full_last_line_center | full_last_line_full)
  - allow_hyphenation (true | false)
- `<span>`
  Spans can be used within text or multiline_text elements when you want to define a different style somewhere within the text. It has the same definition as a text element.
  can contain: #TEXT, link, subst, span, bullet
- `<ss>`
  Subscripts the bracketed text.
- `<unbreakable>`
  Prevents the hyphenation or splitting of the bracketed text.
- `<delimiter>`
  A horizontal separator (line) with height specified by the height attribute.
- `<link>`
  The value (text) of the link will be substituted. Can be used only inside `<text>` and `<multiline_text>` elements.
  attributes:
  - link_id: Reference to the link as it appears in the <links> section at the top of the table layout file.
  example:

```html
<text>hello</text>
```

- `<subst>` (The value of the substitution will be used instead of the element. Can be used only inside `<text>` or `<multiline_text>` elements.)
  attributes:
  - option_id (string)
  example:

```html
<text>used font: <subst option_id="font_name"/></text>
```
• `<bullet>` (The text inside will be marked with a bullet. For the `<multiline_text>` element, the text inside will always be unbreakable.)

attributes:
• `style` (square | circle)
• `size` (size of the radius of bullet in points)

element:

```html
<text>Hello<bullet style=circle" size="5">world. </bullet></text>
```

### If and ifnot elements

Elements can be wrapped into `<if>` & `<ifnot>` elements. In that case, the wrapped elements are taken into account only if specified with the `<if>` or `<ifnot>` element is met (is "true"). `<ifnot>` is the inverse of `<if>` The part of the layout bracketed by `<ifnot>` will be processed when the condition specified via the attributes of the element is not met.

Attributes:

• `option_id`
• `option_value`
• `link_id`
• `attribute`
• `attribute_value`

- `element_value`: the element_value is used when the option value is stored as an element value and not as its attribute (GS1 specific). element_value and attribute/attribute_value shouldn't be used together in a single option.

The specified attributes are always taken into account.

Example:

```html
<if option_id="..." option_value="..." link_id="..." attribute="..." attribute_value="...">
<text>Hello World</text>
</if>
```

Show “Hello World” only if the option with ID first_option has the value “true”. For options of type “bool” which are displayed in the user interface as a checkmark, the option_value attribute may be omitted in the corresponding `<if>` element. In this case the condition will be considered true if the checkmark is on.

```html
<if link_id="somelinkID">
<text>Hello World</text>
</if>
```

Show “Hello World” only if the link with ID “somelinkID” is present. Links that are declared as “mandatory” are always considered to be present so the `<if>` for such links will always be true.
8. CHILI Plug-in

8.1 Introduction

8.1.1 About CHILI Publisher and CHILI plug-in

CHILI Publisher is a concept, developed by the CHILI publish bvba company. It offers its users the possibility to edit their graphical artwork online.

The original idea of this concept involves these steps:

1. The graphical studio can create the Artwork template using a standard graphical editor.
2. The studio then sends the artwork in a specific format to the web-based CHILI Server.
3. The brand owners can check and edit the designs online.
4. The brand owners or their partners can directly generate the printable file.

The CHILI Server can be implemented to brand owners’ CMS as an integral part. It can be widely customized to fit every possible need and constrain of the brand owner.

Until now only Adobe InDesign could be used to create the Artwork templates.

The CHILI plug-in adds an export capability of the design from Adobe Illustrator to CHILI Publisher.

However, CHILI plug-in goes beyond just exporting the templates for on-line editing: in combination with Dynamic Content and Dynamic Art it offers a complete round-trip of the Artwork template and the Copy content.

8.1.2 The general concept

1. The Graphical Studio creates the graphical concept.

   The Studio at this point doesn't have the actual text content for the artwork at that moment. They use Dynamic Art to transform the dummy text objects into Dynamic Art placeholders. The placeholders can be tagged with proper contextual information such as the Copy element type and language variant code. In case there are multiple instances of the same Copy element type, an instance ID (to make each element unique) is needed.

2. The Studio exports the artwork to the CHILI Package

   The CHILI Package is the export format for the CHILI Publisher. This CHILI Package is then uploaded the file to the Brand owner’s CHILI Server, an integral part of the Brand owner’s CMS (e.g. ESKO WebCenter).

3. The Brand owner checks the file using the CHILI Editor
The Brand owner sees the Artwork template with the dummy text instead of the Artwork copy.

Besides the artwork, the editor provides a list of variables used in the Artwork template. 
The Variables are originally the Dynamic Art placeholders and their names as defined in the first step. This way, the brand owner knows exactly what to fill where.

4. The brand owner fills in the Variables, and the Artwork template immediately displays the text content changes.

This gives the brand owner an approximation of the final look.

5. When the Brand owner finishes the editing, the file is saved on the CHILI Server once again.

6. The Studio downloads the CHILI Package from the CHILI Server and imports the Package to the original Artwork template file using the CHILI plug-in. The plug-in loads the text content into the Dynamic Content, and the Dynamic Art placeholders are automatically filled by the new text content.

8.1.3 The CHILI Package

The CHILI Package is the format used to send jobs from Adobe Illustrator (using the CHILI Plug-in) to the CHILI Server and Editor, and vice versa.

The CHILI Package contains

- the XML file(s) in a specific format, describing the exported artwork
- the resources – fonts and images.

In the current version of the CHILI plug-in, artwork objects other than text objects are rasterized to PNG files.

The fonts used in text objects can be exported as well. Since the CHILI Server stores the font files in its repository, you can save some time by exporting and uploading new minor versions of the same artwork without (resending) the font files.

**Note:** Not all font types are supported by the CHILI Server (see also Known Limitations on page 306). Text using unsupported fonts cannot be displayed correctly by the CHILI Editor. When exporting an artwork using unsupported font you will get a warning. You can however still generate the package and open it in Editor.

The Package, downloaded from the Server, uses the same format and includes all changes made on the Server. The XML data content contain the styling tags, describing the styling made by the CHILI Editor. Those tags can be optionally used by the Style mapping feature of Dynamic Content.

**Note:** The XML data use the GS1 XML standard format. This implies the plug-in can only cooperate with Dynamic Content version 12.1 or higher.

8.2 Bar codes

In the Preferences for the CHILI plug-in you can define how to handle bar codes:
• You can export any supported bar code created by the Dynamic Barcodes plug-in, allowing its value to be edited in CHILI Publisher, but without getting a live preview there
• You can export EAN 13 bar codes, allowing its value to be edited in CHILI Publisher, and you will get a live preview of the result
• You can export bar codes as static images.

**Check digit and valid input**

While entering the bar code data value in the CHILI Editor, the input is not checked for the correct check digit. This means a user can enter an invalid value in the variable field, and will get no warning from the server. The bar code is created with the correct check digit due to the internal self-checking ability of the barcode module on the Server.

Entering invalid data creates an inconsistency between the barcode variable value and the visual barcode interpretation in the CHILI Editor. The CHILI Package downloaded from the Server and loaded to the CHILI Plugin will contain this invalid value. Because of this, the barcode won't be updated, so it's strongly recommended to check the barcode values while entering them in the CHILI Editor.

### 8.2.1 Export bar codes as images linked with CHILI variables

When using this way of exporting bar codes, the bar code is exported as an image, coupled with a CHILI variable.

The variable can then be edited on the server, but the image remains unchanged, and only works as a placeholder.

The changed variable goes back with the downloaded CHILI package, and can be applied to the artwork by the Dynamic Bar Codes plug-in when linking the XML.

### 8.2.2 Export bar codes dynamically

If your job contains an EAN 13 barcode, this barcode can be displayed and edited by the CHILI Editor with a live preview. Other barcode types are currently not supported. Setting up the environment for the live preview needs setting up both the station and the CHILI server.

**Bar code definitions**

To work with bar codes, the following conditions must be met:

1. the bar code type should be defined in advance on the CHILI Server.
2. the corresponding bar code definition should be in the `barcodes.xml` file in the plug-in
3. the bar code in the graphic design should match the bar code definition.

**On the server:**

The **bar code definition** on the server contains the barcode type, but also the barcode parameters as height, all four directions of the quiet zone (box) and the human readable text position.
Because of this, each variation of the barcode has to be pre-defined on the server. For example, “EAN 13, No text, 25.93 mm height, no box” has to be one definition, “EAN 13, Text below, 10 mm height, 1-1-1-1mm box” another one.

Each bar code definition has its own unique internal ID which is used for identification. In a CHILI Package, only the ID is included, and the barcode type and its technical parameters are not transferred along. The whole process relies on the pre-defined barcode set.

On the server in the Barcode Types section, there is an Info tab, where the Object XML part contains necessary information. Here is a sample of the definition tag:

```xml
<item name="EAN 13, 25.93mm, Below" id="d4ef11b4-1ca1-49e9-ad99-4febfa4d34c0" relativePath="" type="ean13" bottomQuietZone="0 mm" topQuietZone="0 mm" height="25.93 mm" textLocation="belowembedded" leftQuietZone="0 mm" rightQuietZone="0 mm"/>
```

This snippet can be copied and pasted to the barcodes.xml file

**The plug-in:**

On the plug-in's side, the bar code definition should be in the configuration XML file "barcodes.xml", located within the plug-in's bundle package `<Ai app folder>/Esko/CHILIPlugin.plugin`. This file should contain bar code definitions matching those defined on the server.

**In the graphic design:**

If a bar code in the artwork matches (both bar code type and parameters) with one of those in “barcodes.xml”, the ID stored there will be included in the package, and that barcode will be displayed by the CHILI Editor.

**Note:** If the barcodes.xml file contains more than one identical definition (so the same bar code type and parameters, but with different ID, for example coming from another server or server environment), the ID of the first one of them will be used while generating the package.

**Bar code parameters**

The barcode parameters Type, Human readable text, Height and Box (quiet zone) are pre-defined on the server side and have to match the parameters set by the Dynamic Barcodes plug-in, see Bar code definitions on page 297. When setting a bar code in Adobe Illustrator, these are the things you have to keep in mind:

**Magnification**

When checking if a bar code matches one of the bar code definitions, the height before applying the Magnification factor is used.

For example:

1. The CHILI Server contains a bar code definition for a default EAN 13 barcode with a height of 25.93 mm
2. The graphic design contains a default EAN 13 bar code with a height of 25.93 mm that matches all other parameters as well
3. The graphic design also contains a copy of this bar code, but with magnification factor changed to 80%. The height is changed automatically by the Dynamic Barcodes plug-in to 20,744 mm.

Both barcodes, despite having a different height, will match the same definition on the server.
**Note:** As the CHILI editor doesn't understand the Magnification parameter, both barcodes will be displayed in the same size at 100% magnification.

**Background**

The CHILI Editor can't manage bar codes without a background, i.e. with Box parameter in Dynamic Barcodes set to off. In that case the barcode will be generated as if Box is set to 0 on both sides.

### 8.3 Export to CHILI

1. Set up the placeholders for CHILI. See *Preparing the Artwork template for CHILI export* on page 299
2. Export the file to CHILI. You have different options:
   - Preflight and Export to CHILI from the CHILI Preflight Messages palette. See *Preflight and Export to CHILI* on page 300
   - *Export to CHILI using WebCenter Connector* on page 301
   - *Update the CHILI package on WebCenter using WebCenter Connector* on page 301

#### 8.3.1 Preparing the Artwork template for CHILI export

Before you can start preparing the artwork for export to CHILI, you need to ensure that the CHILI options are enabled in the Dynamic Art Preferences: Illustrator > Preferences > Esko > Dynamic Art Preferences >.

1. Select the text object(s) you want to be editable by CHILI
2. In the **Dynamic Art** palette, add these objects as new Dynamic Art
3. In the Dynamic Art palette, double-click the objects to open the Dynamic Art Options palette

  **Note:** You can change the order of the items while in Show Dynamic Arts view. In CHILI editor the text placeholders will be presented in the same order.

4. In the CHILI Publisher settings, you can redefine the CHILI variable type
   - **Default:** the default setting from the Preferences will be used
   - **Single Line:** the variable entry in CHILI is limited to one single line. Using the Maximum number of characters you can even limit the entry to a certain number of characters, e.g. to limit the size of a headline.
   - **Multiline:** the variable entry in CHILI allows multiple lines. Using the Maximum number of characters you can limit the entry to a certain number of characters.
   - **Formatted text:** this variable will keep the source formatting when displayed in CHILI. You can set if you want to allow changing the font, underlinement, strikethrough and superscript or subscript. The formatting changes done in CHILI will be transferred back using the **Style Mapping** feature of Dynamic Content.
   - **List:** the possible entries for the variable will be limited to the ones listed in "List Values".
Note: The CHILI variables are connected with the XML attributes set on the left side of the Dynamic Art Options palette. Changing the XML attributes might change the CHILI variable type.

During the Artwork template preparation, you can also tag an image placeholder for CHILI. The options available are:

- For CHILI Variable Type the only available option at the moment is Default
- The Allow user to edit the placeholder on the server option defines if the image will be exported to CHILI package with a locked or an unlocked attribute. If the checkbox is in the undetermined state (-), the behavior will be defined by the CHILI server workspace and the settings of the Restrict Editing of the Live Art option in the advanced Export Preferences. Exporting image objects in an unlocked state can be helpful when you need to set up the advanced templates in CHILI Publisher.

8.3.2 Preflight and Export to CHILI

Using the CHILI Preflight Messages palette, you can check the artwork template for any CHILI related issues before exporting it:

- incompatibility between text features used in the document, and the CHILI editor capabilities,
- graphical constructions that can't be displayed correctly by CHILI editor,
- inconsistent settings of CHILI options set in the Dynamic Art Options,
- font issues,
- ...

You can also export directly from within the palette.

1. To open the CHILI Preflight Messages palette, choose Window > Esko > Dynamic Art > CHILI Preflight Messages, or select CHILI Preflight Messages in the fly-out menu of the Dynamic Art palette.

2. Click CHILI Preflight Check to check the artwork template. The palette will show all issues found during the checks.

3. You can export to CHILI directly from within the palette:
   a) Click the Export Options button to set the Export to CHILI options. See Export to CHILI options on page 302
b) Using the buttons, choose between exporting to a local file (left) or to WebCenter Connector (right).

c) Click CHILI Export...

When exporting a CHILI package, the CHILI variables are organised in logical groups. The groups are deducted from the GS1 Copy Element categories. In CHILI this will allow additional controls:

- The drop down will always contain the item "All" as the first item in the list, and selected by default. If selected, all variables are displayed.
- The drop down will contain items representing the groups containing the exported variables. Empty groups are not shown.
- Text placeholders with no link to the CET file will be listed in the group "Unassigned"
- The list can also contain the groups "Barcodes" and "Images", where the placeholders of those types will be listed.

By selecting a group from the list in CHILI, a user can limit the variable list to the variables of the selected group. It avoids having very long list of variables displayed in the CHILI Variables panel.

### 8.3.3 Export to CHILI using WebCenter Connector

The WebCenter Connector plug-in allows to export and upload the Artwork template to Esko WebCenter in a single step. If WebCenter is running the CHILI Publisher back-end, it's also possible to edit the text content directly in the WebCenter environment.

To upload the Artwork template to WebCenter:

1. Select **File > WebCenter > Export > CHILI Package...** or **Window > Esko > Dynamic Art > Export as CHILI Package to WebCenter**
2. Review and set the Export to CHILI options and Layer Options. See [Export to CHILI options](#) on page 302 and **Layer Options** on page 303
3. If necessary, log into WebCenter
4. Select the Project you want to upload the document to, and click **Export**

For further information on the WebCenter Connector, we refer to the WebCenter Connector documentation

### 8.3.4 Export to CHILI Package

To export the Artwork template to the CHILI package file:

1. Select **File > Export**
2. Set the **Format** to **CHILI Publisher package (chp)**
3. Select the output folder, and click **Export**
4. Review and set the Export to CHILI options and Layer Options. See [Export to CHILI options](#) on page 302 and **Layer Options** on page 303
5. Click **OK**
The resulting CHILI package file can then manually be uploaded to WebCenter or to any other CHILI server.

8.3.5 Export to CHILI options

Font embedding

The Package holds information about fonts, used by the text objects. The Embed Used Font Families option includes not only the actually used font types, but the whole font families. This allows the CHILI Editor to use for example the "Semibold" variant of the font that was originally only used in the "Bold" variant. Embed Used Font Faces Only stores only the really used font faces in the package. You can also select Do Not Embed.

Note: If the Package doesn't contain the used fonts, and the fonts are not available on the server, either because they have never been uploaded before, or because they are stored in a different asset folder (see below), CHILI won't load the package.

Text Rasterization

If a static text object (i.e. what will not be exported as a CHILI variable) within the artwork uses styling not supported by CHILI Publisher, it's possible to choose how to export it. Rasterize if Having Unsupported Style will keep the objects with supported styling as texts and the rest is rasterized to keep the appearance. Always Rasterize rasterizes all text objects, and Do Not Rasterize keeps all text objects as a text, even though it might result in a different appearance when displayed by CHILI Publisher.

Rasterization Resolution

The export operation generates images from static art. The images representing these objects, will be exported using the resolution set here. The image quality has an effect on the appearance of the artwork displayed on CHILI Publisher.

Note: The settings on the CHILI Server may override this option.

Optimization

Optimization can reduce the number of static objects in the exported package. It can be necessary in case the CHILI server is unable to render the amount of images in the package. In that case you can select one or more optimization method and repeat the upload. The impact of the used optimization method on the output is described by each option:

1. Omit hidden layers: if this option is selected, all objects in hidden layers are not included in the CHILI package. Objects from layers set for CHILI output as Optional will be included anyway, even though the layer is hidden.

   This option has no effect on the visual appearance of the output. You can use this option when the exported artwork is planned to be a template for future use in CHILI in Admin mode.

2. Merge objects with different blend modes: if this option is not selected, static objects with different blending modes are always exported as separate images. With this option selected, the difference is ignored and all static art is joint to a single image.

   The joint image has no blending mode applied, so the visual appearance is affected and any live artwork overlaid by this image won't be visible.
3. **Merge objects from different fixed layers**: if this option is not selected, static objects in different layers are rasterized to separate images. With this option selected, the layer structure is ignored, and rasterized static arts are joined to a single image, despite their presence in various layers. If the layer is set for CHILI output as Optional, static objects from that layer are ignored by this option.

   This option has no effect on the visual appearance of the output. You can use this option when the exported artwork is planned to be a template for future use in CHILI in Admin mode.

4. **Merge objects below/above the live artwork**: if this option is selected, the static art is joined to a single image even though it's mixed in hierarchy with dynamic text.

   This optimization is allowed only for objects not overlapping the live artwork, so this option has no effect on the visual appearance of the output.

### Default Variable Type

Defines the CHILI variable type, which will be used if the CHILI variable type in the Dynamic Art Options dialog is set to Default.

- **Unformatted Text**: the CHILI Editor cannot modify the formatting of the variable.
- **Formatted Text**: the CHILI Editor can modify the formatting of the variable.
- **Formatted Text if Having Unsupported Style**: the plug-in will automatically decide whether the text objects is uniform (one text style for the complete object) or uses various formatting (e.g. different font, size, in the same text object). In this case, it will not be possible to format uniform objects in the CHILI Editor.

### Review Variables for Export

Clicking this button opens a list of CHILI variables used in the artwork. You can review the variable names and types there and also issues detected during the export related to CHILI variables. You can save the variable list to the structured text file, so the variable names can be used to set up the WebCenter environment later.

### 8.3.6 Layer Options

The Layer Options can be opened from within the Export to CHILI options dialog, or by choosing **Window > Esko > Dynamic Art > CHILI Layer Options**...
For every Layer in your Illustrator job, you can define the **Display Name** and the **Visibility**.

The **Display Name** is the name that will be used for the layer in the CHILI Editor. By default the name of the Illustrator layer is used.

The **Visibility** can be set to

- **Fixed** - the layer is always visible
- **Optional** - the user can make the layer invisible by checking the checkbox in CHILI user interface
- You can make one or more groups. Each group will be represented by the drop-down menu, so only one of the layers can be visible in CHILI

The layer visibility, set in CHILI, will be applied on the actual document as soon as the CHILI document is loaded back to the Dynamic Content plug-in. The update of a CHILI document may automatically change the layer's visibility in Illustrator, according to the actual state set in CHILI.

### 8.3.7 Variables Review
In CHILI, Dynamic Art placeholders are represented by CHILI Variables. To review the list of actually defined CHILI Variables you can use the Variables Review dialog.

This dialog contains a table showing the internal CHILI Variable name, the Display name how it will be presented on CHILI, the Variable type and the number of references to the Variable in the artwork.

By selecting a specific variable, the Related Messages panel below will show any error messages related to that variable, which occurred during the last CHILI Preflight run or the CHILI export.

Use the Save to File... button to save the list of CHILI Variables to an external file in CSV format. This file can be used in Esko WebCenter while setting up the environment, since the CHILI Variables can be connected to WebCenter Attributes.

### 8.4 Link a CHILI document

#### 8.4.1 Link the CHILI document from WebCenter Connector

Variables in an artwork template, uploaded on WebCenter, can be edited in CHILI editor.

To get the edited data back from WebCenter, you can link the CHILI document to the Dynamic Content plug-in similar to linking standard XML files. To get the CHILI document to Dynamic Content:

1. In the Dynamic Content fly-out menu, select Add XML from WebCenter.... If you already have a file linked, you can use Re-link XML from WebCenter to replace it.
2. In the WebCenter Connector, browse for the project, and select the CHILI Package you want to link.

3. Click **Open**

The Dynamic Content plugin will show the selected file. If there are matching elements in the loaded document and the Artwork template, you will have the option to proceed with Auto link.

The CHILI Document now behaves as any other linked XML. See the Dynamic Content documentation for more information.

**Note:** An XML file loaded from WebCenter can be relinked to any other XML file from WebCenter or stored locally.

---

### 8.4.2 Link the XML from a CHILI package

Variables in an artwork template, uploaded on WebCenter or CHILI, can be edited in CHILI editor.

You can manually download the CHILI Document, and store it as a .chp file. You can link this file to the Dynamic Content plug-in similar to linking standard XML files. To get the CHILI document (.chp) to Dynamic Content:

1. Select **Window > Esko > Dynamic Content > Dynamic Content** to open the Dynamic Content palette

2. In the fly-out menu of the Dynamic Content palette, select **Add CHILI document...**. If no XML file is currently selected, you can also click **Add CHILI document** in the middle of the (empty) palette.

3. Browse for the CHILI Package you want to link.

4. Click **Open**

The Dynamic Content plugin will show the selected file. If there are matching elements in the loaded document and the Artwork template, you will have the option to proceed with Auto link.

The CHILI Document now behaves as any other linked XML. See the Dynamic Content documentation for more information.

---

### 8.5 Known Limitations

Although CHILI Editor can display very well various artworks, there are still some limitations and incompatibilities. CHILI plug-in analyzes the artwork while export and raises warnings when necessary.

According to the concept, non-supporting of following features doesn't prevent (in most cases) exporting the artwork and doesn't harm the artwork itself. It makes a visual difference in the appearance of text objects in the CHILI Editor only. The CHILI Package will be used just for transport new data content to the original artwork via Dynamic Content.

Limitations in CHILI Publisher version 4.4:
• **Only TTF and OTF fonts are supported.** CHILI does not support Mac data-fork font files (.dfont), TrueType Collections and PostScript fonts. However, CHILI Publisher plug-in converts collections to regular font files if possible.

• CHILI supports Lab color space but **spot colors must be defined using CMYK**

• Character scaling; it also affects text object's transformations except rotation. Support for the **uniform horizontal scaling of the whole text box** is currently implemented

• **Vertical text** is not supported natively, but is simulated by the CHILI Plugin

• **Per-character stroke and blend mode** is not supported in the Flash rendering engine on server's side. However, support for uniform per-character features is under development on the plug-in's side. It means that if the text box uses the same features' set on all characters, the export procedure could manage to modify the object's parameters to correctly visualize these features in the Editor.

• **Gradient fills** on frames is supported, but not individual characters

• **OpenType features:** Digit styles (lining/old-style, proportional/tabular) are unofficially supported; other features (ligatures, fractions, ordinals) are not.

• **Strike-through:** Illustrator positions strikethrough at the half of the x-height, while CHILI uses the middle of the em-box.

• **Overprint** attribute is not supported by the CHILI Editor; CHILI plugin simulates it by the Multiply blend mode.

• **Barcodes** have to be defined in advance on the server, and the barcodes created for a certain server are not recognized by another. If the package contains two barcodes, the color change of one of them in the CHILI editor applies also on the second one. See also Bar codes on page 296

• Only one **Tab stop leader type** per paragraph can be displayed by CHILI.

CHILI Editor doesn't support following Illustrator's features (CHILI Publisher version 4.4):

• Small caps
• Automatic hyphenation
• Pattern fills
• Multiple fills
• Color Burn blend mode
• Color Dodge blend mode
• Soft Light blend mode
• Exclusion blend mode
• Hue blend mode
• Saturation blend mode
• Color blend mode
• Luminosity blend mode
• Difference blend mode
• Overlay blend mode
• Hard Light blend mode
• Lighten blend mode
• Screen blend mode

Know issues on the CHILI Server side related to the CHILI plugin:

• Text variables: bad alignment of the last paragraph line: If a paragraph is aligned to block (with the last line to be aligned to the left), the last line will be stretched over the full frame width
• Formatted text variables: bad propagation of the text’s formatting into the frame. Incorrect implementation of the inheritance of styles in nested tags.
• Inability to specify the background color of the editor fields for formatted variables - the white text is not legible on the white background

8.6 Preferences

The Preferences can be opened by selecting Illustrator > Preferences > Esko > CHILI Plug-in Preferences (Mac) or Edit > Preferences > Esko > CHILI Plug-in Preferences (Windows).

8.6.1 General Preferences

The General preferences configure the level of user awareness of events happening during the export to the CHILI Package.

You can enable or disable logging to the CHILI Preflight Panel dialog, or make the output verbose, i.e. write every message generated by the export.

By default, warnings are listed in the CHILI Preflight Panel, and exporting continues. However, if you enable Stop on Warnings, exporting will stop.

Further logging you can find in the Diagnostic console.

If the Show warning when multiple text objects link to the same copy instance option is enabled, the preflight checks will generate a warning when the artwork contains two or more tagged objects with the same copy element type, instance ID and locale ID, regardless their actual content and formatting.

By enabling the option to automatically link the uploaded CHILI package to Dynamic Content, you can speed up the workflow.
By clicking the **Reset Hidden Dialogs** button, all messages in the CHILI Publish plug-in where the option "Don't show this again" has been selected, will be switched on again.

### 8.6.2 File Export Preferences

The settings you make in the Preferences are used as defaults during further processing.

**Font embedding**

The Package holds information about fonts, used by the text objects. The **Embed Used Font Families** option includes not only the actually used font types, but the whole font families. This allows the CHILI Editor to use for example the "Semibold" variant of the font that was originally only used in the "Bold" variant. **Embed Used Font Faces Only** stores only the really used font faces in the package. You can also select **Do Not Embed**.

**Note:** If the Package doesn't contain the used fonts, and the fonts are not available on the server, either because they have never been uploaded before, or because they are stored in a different asset folder (see below), CHILI won't load the package.

**Text Rasterization**

If a static text object (i.e. what will not be exported as a CHILI variable) within the artwork uses styling not supported by CHILI Publisher, it's possible to choose how to export it. **Rasterize if Having Unsupported Style** will keep the objects with supported styling as texts and the rest is rasterized to keep the appearance. **Always Rasterize** rasterizes all text objects, and **Do Not Rasterize** keeps all text objects as a text, even though it might result in a different appearance when displayed by CHILI Publisher.

**Rasterization Resolution**

The export operation generates images from static art. The images representing these objects, will be exported using the resolution set here. The image quality has an effect on the appearance of the artwork displayed on CHILI Publisher.
Note: The settings on the CHILI Server may override this option.

Optimization

Optimization can reduce the number of static objects in the exported package. It can be necessary in case the CHILI server is unable to render the amount of images in the package. In that case you can select one or more optimization method and repeat the upload. The impact of the used optimization method on the output is described by each option:

1. **Omit hidden layers**: if this option is selected, all objects in hidden layers are not included in the CHILI package. Objects from layers set for CHILI output as Optional will be included anyway, even though the layer is hidden.

   This option has no effect on the visual appearance of the output. You can use this option when the exported artwork is planned to be a template for future use in CHILI in Admin mode.

2. **Merge objects with different blend modes**: if this option is not selected, static objects with different blending modes are always exported as separate images. With this option selected, the difference is ignored and all static art is joint to a single image.

   The joint image has no blending mode applied, so the visual appearance is affected and any live artwork overlaid by this image won't be visible.

3. **Merge objects from different fixed layers**: if this option is not selected, static objects in different layers are rasterized to separate images. With this option selected, the layer structure is ignored, and rasterized static arts are joined to a single image, despite their presence in various layers. If the layer is set for CHILI output as Optional, static objects from that layer are ignored by this option.

   This option has no effect on the visual appearance of the output. You can use this option when the exported artwork is planned to be a template for future use in CHILI in Admin mode.

4. **Merge objects below/above the live artwork**: if this option is selected, the static art is joined to a single image even though it's mixed in hierarchy with dynamic text.

   This optimization is allowed only for objects not overlapping the live artwork, so this option has no effect on the visual appearance of the output.

Default Variable Type

Defines the CHILI variable type, which will be used if the CHILI variable type in the Dynamic Art Options dialog is set to Default.

- **Unformatted Text**: the CHILI Editor cannot modify the formatting of the variable.

- **Formatted Text**: the CHILI Editor can modify the formatting of the variable.

- **Formatted Text if Having Unsupported Style**: the plug-in will automatically decide whether the text objects is uniform (one text style for the complete object) or uses various formatting (e.g. different font, size, in the same text object). In this case, it will not be possible to format uniform objects in the CHILI Editor.

Let the variables follow layers' visibility
If enabled, the variable fields on CHILI editor will be hidden if their layer is currently not visible. If the layer is optionally visible on CHILI as defined in the Layer options, the variables will be hidden or shown immediately as the controls are changed in CHILI.

8.6.3 Advanced Preferences

The settings you make in the Preferences are used as defaults during further processing.

Restrict Editing of Live Art
This option can be used in special cases when it's handy to export all non-rasterized text objects with an unlocked status in terms of CHILI. It allows to directly manipulate the objects in the CHILI admin mode when creating customized CHILI templates.

- **Lock Position and Contents** (default) - all objects are exported as locked.
- **Lock Content** - all objects are exported so they can be moved around, but it doesn't allow editing the content.
- **Lock Position** - all objects are exported so they allow editing of their content, but it doesn't allow changing the position.
- **Do Not Restrict** - all objects are exported as unlocked, so an administrator can edit their content and move them.

Restrict Editing of Static Art
This option can be used in special cases when it's handy to export all rasterized objects with an unlocked status in terms of CHILI. It allows to directly manipulate the objects in the CHILI admin mode when creating customized CHILI templates.

- **Lock Position and Contents** (default) - all objects are exported as locked.
- **Lock Content** - all objects are exported so they can be moved around, but it doesn't allow editing the content.
- **Lock Position** - all objects are exported so they allow editing of their content, but it doesn't allow changing the position.
• **Do Not Restrict** - all objects are exported as unlocked, so an administrator can edit their content and move them.

**Export Barcode Placeholders**
Barcodes can be exported in various ways:

• **As Static Art** - all Dynamic Barcodes will be exported as static images.

• **As Static Art With Variables** - all Dynamic Barcodes will be exported as images followed by the CHILI variable

• **As Live Barcodes (EAN only)** - EAN 13 barcodes can be exported to be fully dynamic on CHILI Publisher. For details of the settings see *Export bar codes dynamically* on page 297

**Export Image Placeholders**
Image placeholders can be exported in various ways:

• **As Static Art** - all image placeholders will be exported as static images.

• **As Static Art With Variables** - all image placeholders will be exported as images followed by the CHILI variable

• **As Live Art without Variables** - All image placeholders will be exported as separate resources, but not followed by the CHILI variable

**Include all document swatches**
This option adds information about all Swatches present in the document to the Package. This information can be used on the CHILI Server side.

**Include all document text styles**
This option adds information about all named text styles present in the document to the Package. This information can be used on the CHILI Server side.

**Default Assets Location**
You can define the name for the resource folder on the CHILI server. The Package holds this information and CHILI server takes exported Static Art images from the Package and stores them into that folder. If the folders don't exist yet, they are created first. The default value is “AICHILIPlugin”.

**Default Fonts Location**
You can define the name for the font resource folder on the CHILI server. The Package holds this information and CHILI server takes the bundled font files from the Package and puts them to that folder. If the folders don't exist yet, they are created first. The default value is “AICHILIPlugin”

**8.6.4 Webcenter Connection Preferences**
The WebCenter Connection Preferences are only available if you have the WebCenter Connector installed.
Automatically link the uploaded document to Dynamic Content

When the document is exported to CHILI package and uploaded to WebCenter using the WebCenter Connector, according to this option the package on WebCenter can be also immediately loaded back to Dynamic Content. Uniquely identified placeholders will then be linked automatically with the package variables.

Automatically check for new document version every

Sets the timer for automatic status checking of CHILI packages in Dynamic Content, linked from WebCenter.

Download Linked Document As

The package data can be obtained from the CHILI server as a Document XML Only or as a Full CHILI Package. As Dynamic Content uses only the data portion of the CHILI package, using full CHILI package serves mainly for debug reasons.